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Chapter 1

Introduction

This manual provides information about using the iCysTM Research Imaging 
Cytometer and the iCysTM Cytometric Analysis Software. The iCys Research Imaging 
Cytometer is an instrument which performs rapid biochemical measurements and 
genetic analysis of cellular and tissue specimens. The iCys Cytometric Analysis 
Software allows you to configure the instrument, scan or view a plate, slide or other 
carrier, and analyze the resulting data.

This manual will familiarize you with the basic components and operations of the 
entire iCys system.

Included in this chapter:

❑ Manual Organization, page 1-2

❑ System Overview, page 1-3

❑ iCys Intended Use, page 1-4

❑ Technical Support, page 1-4 
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Manual Organization
Chapter 1, “Introduction”
Introduces you to the iCys hardware and software, and provides technical support 
information related to the iCys system.

Chapter 2, “iCys™ Research Imaging Cytometer Hardware Reference”
Provides information on the hardware components, safety requirements, system 
maintenance, and functional specifications for the iCys system.

Chapter 3, “iCys™ Cytometric Analysis Software Application Overview”
Provides detailed information about setting up and generating an iCys run.

Chapter 4, “Generating Analytical Data”
Provides detailed information about the analysis parameters for an iCys run. 

Appendix A, “Installing iCys™ Research Imaging Cytometer”
Provides hardware installation information.

Appendix B, “Using the iNovator Toolkit”
Provides information about using the optional iNovator Toolkit to create macros that 
extend the capabilities of iCys.

Appendix C, “Administrator Tasks”
Provides information about performing iCys administrative tasks.

Appendix D, “Glossary”
Contains a glossary of terms used within iCys.
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System Overview
The iCysTM Research Imaging Cytometer is a microscope-based instrument that uses 
lasers and photomultiplier tube detectors to measure constituents and other properties 
of cells based on multicolor fluorescence detection. The iCys instrument scans 
microplates, slides, and other carriers, analyzing and recording data about each 
scanned sample.

Figure 1-1 illustrates the laser and data path of the iCys Research Imaging Cytometer. 
The iCys instrument, its components, and basic operation are described in detail in 
Chapter 2, “iCys™ Research Imaging Cytometer Hardware Reference.”

Figure 1-1: iCys Laser and Data Path

iCys Hardware
The iCys Research Imaging Cytometer consists of the following major hardware 
components:

❑ The optics/electronics unit creates the laser scanning beam. It contains the 
fluorescence sensors and controls laser light shutters, the motorized stage, and 
other functions.

❑ The microscope unit is an Olympus IX-71 microscope with a motorized stage, 
brightfield lamp, and a forward scatter detector. Optionally available are the 
AutoFocus mechanism, EpiFluorescence assembly, and color camera.

Scanning mirror

Scan lens

Dichroic mirrors and 
optical filters

Photomultipliers
(PMTs)

AutoFocus/
Relay optics

Brightfield
assembly

Camera

Scatter
assembly

Eyepieces

Objectives

Focus knob
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❑ The computer runs on the Windows XP® operating system. It controls iCys 
operations, stores, and analyzes data using iCys software.

iCys Software
The iCys software includes:

❑ The iCys Cytometric Analysis Software is used to configure the iCys instrument 
and set up the desired parameters for viewing and analysis.

❑ The optional iNovator Toolkit allows you to generate more complex analyses 
during an iCys run. For more information, see Appendix B, “Using the iNovator 
Toolkit.”

❑ Optional iBrowser Analysis Software allows you to analyze and display saved 
scan data from an iCys run. For information about iBrowser, see the iBrowser 
User’s Guide.

iCys Intended Use
The iCysTM Research Imaging Cytometer is an instrument which performs rapid 
biochemical measurements and genetic analysis of cellular specimens and tissue 
specimens in microplates, slides, and other carriers. iCys visually displays samples 
under analysis without destroying them.

iCys is intended for research use only. iCys is not for use in diagnostic procedures.

iCys is manufactured by CompuCyte Corporation, 12 Emily Street, Cambridge, MA 
02139-4507.

Technical Support
CompuCyte technical support is available from 8 A.M. to 5 P.M. (EST). You may 
contact us the following ways:

Toll Free: 1-800-840-1303 (prompt 2)

Outside US & Canada: 617-492-1300 (prompt 2)

Fax: 617-577-4501

E-mail: techsupport@compucyte.com

mailto:techsupport@compucyte.com


Chapter 2

iCys™ Research Imaging Cytometer
Hardware Reference

This chapter describes the iCys™ Research Imaging Cytometer hardware, along with 
maintenance, and safety issues.

Included in this chapter:

❑ About iCys, page 2-2

❑ Optics/Electronics Unit, page 2-4

❑ Argon Ion Laser Support Elements, page 2-6

❑ The Desktop Computer, page 2-7

❑ Microscope Unit, page 2-8

❑ The Delivery and Collection Optics, page 2-12

❑ iCys Hardware Setup, page 2-13

❑ iCys Specimen Carriers, page 2-17

❑ iCys Safety Requirements, page 2-24

❑ General Maintenance Information, page 2-30

❑ Functional Specifications, page 2-31

❑ Performance Specifications, page 2-33   
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About iCys 
The  iCysTM Research Imaging Cytometer has the following major hardware 
components:

❑ The optics/electronics unit creates the laser scanning beam. It contains the 
fluorescence sensors and controls the laser shutters, and other functions. This unit 
is described in greater detail in “Optics/Electronics Unit” on page 2-4.

❑ The microscope unit consists of an Olympus IX-71 microscope with a motorized 
stage, eyepieces, a CCD camera, brightfield source, optional EpiFluorescent 
mercury burner, and a forward scatter detector.This unit is described in greater 
detail in “Microscope Unit” on page 2-8.

❑ The Remote Control unit provides fine X and Y control, and if your iCys system 
uses the optional AutoFocus feature, coarse and fine AutoFocus control.

❑ The desktop computer runs on the Windows XP® operating system. It controls 
iCys hardware and software operations, collects scan data, and stores and analyzes 
the data.

Figure 2-1 shows some of the hardware components for the iCys system.

Figure 2-1: iCys Selected Hardware Components

Optics/electronics Automated stage Monitor

MonitorCamera and
focus monitors,

Microscope, brightfield source,
EpiFluorescence, camera,
and automated stage

Optics/Electronics

Remote Control unit
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Not shown in the figure are the desktop computer, the argon ion laser cooling fan, and 
power supplies for the argon laser, brightfield lamp, and optional EpiFluorescent 
mercury burner.

Note: For information about installing iCys, see Appendix A, “Installing iCys™ 
Research Imaging Cytometer.”
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Optics/Electronics Unit
The optics/electronics unit includes the following components:

❑ One to three lasers—Argon ion (488nm) is always included, you can optionally 
add HeNe (633 nm), and Violet diode (405nm)

❑ Laser beam steering optics

❑ Galvanometer—Creates the laser scanning beam

❑ Scan lens—Introduces the scanning laser beam into the microscope

❑ Electronics and power supplies—Controls various functions of the instrument 
such as the motorized microscope stage, the galvanometer scanner, and the laser 
shutters

❑ Fluorescent light collection optics—Collects light from the specimen and 
transmits it through a series of optical filters to the photomultiplier tubes

Power Entry Panel
The power entry panel is on the left side of the optics/electronics unit, as shown in 
Figure 2-2.

Figure 2-2: iCys Power Entry Panel

The instrument is connected to power mains through the special Hubble connector as 
shown above. The master power switch switches all power to the unit and must be in 
the “On” position for the unit to function. The breaker should be left in the “On” 
position unless the instrument is being serviced. The argon ion laser power supply is 

POWER ONLY
FOR LASER

Power entry panel

LASER
POWER

MAIN
POWER

1

0
Main

Main power switch

Argon ion

Hubble

Master power switch

Side cooling
vent

connector

power

1

0
laser power
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connected to the outlet shown and switched on by the illuminated laser AC switch 
above the outlet. Power for the rest of the system, including the accessory outlets on 
the right of the optics/electronics unit, is controlled by the second illuminated main 
AC power switch.

PMT/Filter Access
Figure 2-3 is a close-up photo of the opened PMT/filter access door.

Figure 2-3: PMT and Filter Access

To gain access to the filter and PMT assemblies you must open the door on the front 
panel using a 5/32” Allen wrench, which is supplied. To replace the filter cubes, turn 
the knob clockwise until the cube is loose.

The PMT assemblies process the light selected by each filter and are located directly 
to the right of the associated filter cube.

Note: Do not replace the PMT assemblies or move the filters, unless under the 
advisement of service personnel.

Accessory Outlets
There are two accessory outlets located on the right side of the optics/electronics unit. 
The accessory outlets are controlled by the main power switch.

Optical filter cubes (4)

PMT (photomultiplier)
assemblies (maximum is 4)

Access door

Ground wire not
shown for clarity
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Argon Ion Laser Support Elements
The argon ion laser support elements consist of the following:

❑ Argon ion laser cooling fan

❑ External power supply

Argon ion laser cooling fan
The laser cooling fan is attached through an air hose either at the rear or the side of the 
optics/electronics unit as shown in Figure 2-4. Power for the fan is supplied by a cable 
through the cable port on the left-side panel.

Figure 2-4: Argon Ion Laser Cooling Fan Attachments

External power supply
The supply is connected to the optics/electronics unit via three cables, as shown in 
Figure 2-5:

❑ One cable is for AC power

❑ A second (large) cable is used to send power from the laser power supply to the 
laser

❑ A third (smaller) cable carries signals from the electronics to the laser power 
supply for controlling and monitoring the laser power and current

Air hose attachment

Argon ion laser cooling fan

Argon ion laser power supply
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Figure 2-5: Argon Laser External Power Supply

Note: Do not place the laser external power supply or the external fan on the 
same table as the optics/electronics unit.

The Desktop Computer
The imaging cytometer is controlled, and data is obtained and analyzed using the iCys 
software. iCys operates on the supplied computer, which runs the Microsoft Windows 
XP operating system. Two proprietary circuit boards installed in the computer convert 
analog signals from the cytometer into digitized data, and write it to system RAM for 
processing and storage. The computer is equipped with a monitor, mouse, and 
keyboard. In addition to the iCys software and circuit boards, the computer also 
contains an EPIX frame grabber card, and is supplied with EPIX XCAP-Lite image 
viewing and analysis software.

External power supply
for Argon laser.



iCys™ Research Imaging Cytometer Hardware Reference Microscope Unit

2-8 iCys Research Imaging Cytometer User Guide Revision B

Microscope Unit
The microscope unit consists of the following:

❑ A standard Olympus IX-71 microscope.

❑ WH10X eyepieces.

❑ An adapted motorized stage – the manual stage positioning controls, located in 
front of the microscope, allow for coarse or fine operator control of the motorized 
stage positioning.

❑ A brightfield illumination column and lamp housing and TH4-100 power supply 
for brightfield lamp.

❑ An optional EpiFluorescence (Reflected fluorescence) system, including a power 
supply for the 100W mercury burner.

❑ Sony CCD Video Camera.

❑ A forward scatter detector located above the microscope stage.

❑ The scanning laser beam is directed into the microscope through a side port on the 
microscope. This beam is directed to the microscope objective and focused on the 
sample located on the microscope stage. Fluorescent light, collected by the 
microscope objective, emerges through this port and is relayed to the 
photomultiplier tubes located in the optics/electronics unit.

❑ Other optional microscope accessories may also be included.

The Microscope
The microscope supplied with iCys is an Olympus IX-71 which comes with an 
Olympus objective turret containing 10X, 20X, and 40X Universal Plan Semi-
Apochromatic objectives. It also contains a crosshair alignment tool.

Note: Do not remove, replace, or add objectives to the microscope unit.

iCys can be purchased with or without the AutoFocus feature. The microscope 
functions are directly affected by the presence of AutoFocus, as follows:

❑ If your iCys system does not have the AutoFocus feature, you will need to 
manually move the objective lens into the correct positions as discussed in “Using 
the Microscope without AutoFocus” on page 2-8. 

❑ If your system does have AutoFocus, see “Objective Lens Automated Movement” 
on page 2-9.

Using the Microscope without AutoFocus
If your iCys system does not have the optional AutoFocus feature, then you will need 
to manually focus the microscope on the specimen in the area to be used during the 
run before starting a Test Scan or Scan & Save run. 

You can manually focus by either:
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❑ Turning on the brightfield source and viewing the specimen area directly through 
the eyepiece.

❑ Using the CCD camera with either the stand alone monitor or the computer 
monitor.

➣ In either case, to manually focus the microscope:

1. Lower the objective lens turret to the full downward position.

2. In the Scan Area Setup window, described in “Setting up a Microplate Scan” on 
page 3-17 and “Setting up a Freeform Carrier Scan” on page 3-22, select Move 
stage to active well ( ), then click on the region of interest to move the stage 
into position.

3. Select Instrument ⇒ Brightfield, and switch the microscope Light Path Selector 
lever to Observation ( ).

4. If necessary, adjust the brightfield lamp power. 

5. From the microscope, rotate the coarse or fine focus knob until the specimen 
appears to be in focus on the eyepieces, the camera monitor or the computer 
monitor

6. Adjust the focus by the system offset for the objective lens used in the run.

7. The system is now ready to scan the well or scan area.

Objective Lens Automated Movement
When scanning, the microscope automatically moves the objective lens into position 
for scanning. When not scanning, there are three possible locations for the objective 
lens:

❑ Objective Home—The home base for the lens. The lens is entirely retracted. The 
objective moves to the home position when the objective lens is explicitly 
returned home. After the objective lens is homed, it is driven to the Clear Position.

❑ Clear position—The lens is retracted enough to be clear of any carriers, but is not 
retracted to the Home position. The objective moves to Clear when a Scan & Save 
run is completed, is manually stopped, or when the stage is moved to the Load 
position.

❑ Retraction offset—A carrier-specific retraction that allows the stage to move 
without bumping into the objective. The objective moves to the retraction offset 
when:

❍ A Test Scan completes or is stopped.

❍ The stage is moved using the Move to Active Well command between wells 
or rooms in the Scan Area Setup window.

❍ You view events in the Field Image window as described in “Locating and 
Viewing Events in the Field Image Window” on page 4-45.
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Brightfield Lamp
The brightfield illumination column and lamp allow you to view your samples directly 
from the microscope stage. Brightfield is only useful when using direct observation.

Figure 2-6: Brightfield Illumination Assembly

When using the brightfield lamp, you also need the TH4-100 power supply that 
powers the lamp.

For information about using the brightfield lamp, see “Observing Samples with the 
Brightfield Source” on page 2-14.

For detailed information about the IX71 microscope and brightfield illumination, see 
the Olympus Instructions: IX71/IX51 Inverted Research Microscope/Inverted Basic 
Microscope.

Forward Scatter Detector
The Forward Scatter detector allows you to generate scatter images in iCys. You can 
use scatter detection to show relief details in an otherwise flat image. iCys provides 
two types of scatter imaging: Light Loss and Shaded Relief. Scatter detection is only 
available when the Scatter channel is selected in the Instrument Setup window.

For information about using the Scatter detector, see “Selecting the Forward Scatter 
Method” on page 3-48”.

Brightfield
LampBrightfield

Filter Housing
Brightfield
Power Source

Light Intensity
Control Knob

Brightfield
Shutter

Power Switch
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Figure 2-7: Forward Scatter Assembly

EpiFluorescence System

Note: The iCys EpiFluorescence system is an optional feature of the Olympus 
IX71 microscope that allows you to view samples directly using reflected 
fluorescent light to highlight particular features. 

For information about using the EpiFluorescent system, see “Observing Samples 
using EpiFluorescence” on page 2-15.

For information about using the EpiFluorescent system hardware, see “Optional 
EpiFluorescence Illumination Assembly” on page 2-31.

For detailed information about the EpiFluorescence system, see the Olympus 
Instructions: Manual/Motorized Reflected Fluorescence System.

EpiFluorescent 
mirror cassette
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The Delivery and Collection Optics
Figure 2-8 illustrates the delivery and collection optics for the iCys system:

Figure 2-8: iCys Delivery and Collection Optics

Delivery Optics 
The beams from all lasers are directed concentrically to the main beam splitter 
through laser beam steering elements. The mirror reflects the laser beams upward to 
the scanning mirror, which is driven by a galvanometer, creating a beam sweeping 
across the scan lens. The scan lens creates a scan line which is reflected at 90 degrees 
by a fully reflective mirror. Light reflected from the mirror passes through a pair of 
relay lenses, is reflected off a 90 degree full reflective mirror towards the microscope, 
and is then directed upwards through the objective lens to illuminate the specimen.

Collection Optics
The same optical configuration collects fluorescent light from the specimen, directing 
emitted light up to the main beam splitter. Fluorescent light passes through the main 
beam splitter to the dichroic mirrors, optical filters, and photomultiplier tubes.

Scanning mirror

Scan lens

Dichroic mirrors and 
optical filters

Photomultipliers
(PMTs)

Autofocus/
Relay optics

Brightfield
assembly

Camera

Scatter
assembly

Eyepieces

Objectives

Focus knob



Revision B iCys Research Imaging Cytometer User Guide  2-13

May 6, 2005 iCys™ Research Imaging Cytometer Hardware Reference

iCys Hardware Setup
iCys allows you to observe or scan samples using a number of different methods. The 
setup requirements for each method are described in this section.

This section contains the following information:

❑ Scanning Samples with iCys, page 2-14

❑ Observing Samples With the Video Camera, page 2-16

❑ Observing Samples with the Brightfield Source, page 2-14

❑ Observing Samples using EpiFluorescence, page 2-15

iCys Microscope Components
iCys uses an Olympus IX71 microscope with a number of options for different 
scanning and viewing methods.This section shows the components you need to use to 
set up the iCys hardware for the different methods of scanning and observation. 

Figure 2-9: iCys Microscope Selected Components

Brightfield
condenser turret 

Mode selector knob

Magnification selector

Light path selector knob
(in scan position)

Light intensity control

Brightfield source
knobON/OFF button

Color camera

Scatter detector Brightfield lamp

Focus knob 
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Scanning Samples with iCys
➣ To scan samples with iCys, you need to make sure that the microscope is set as follows:

1. Set the light path selector lever to side port ( ). 

Note: When set to observation ( ), scanning will not take place.

2. Set the magnification selector knob to 1X magnification (the pushed in position).

3. If your system has the optional EpiFluorescence feature, set the EpiFluorescence 
cassette to position 1.

4. Set the condenser filter turret to position 5.

Note: Position 5 of the condenser filter turret is used for brightfield and Forward 
Scatter and must be empty.

5. Make sure the condenser is rotated in the down position (not rotated upwards).

6. After the hardware setup is complete, you can use the iCys application to set up 
and scan as described in Chapter 3, “iCys™ Cytometric Analysis Software 
Application Overview.” 

Observing Samples with the Brightfield Source
➣ To observe samples using the brightfield source:

1. Set the light path selector lever to observation ( ). 

2. Turn on the following:

❍ The TH4-100 Power Supply (shown in Figure 2-6, “Brightfield Illumination 
Assembly,” on page 2-10).

❍ The brightfield ON/OFF switch (shown in Figure 2-9, “iCys Microscope 
Selected Components,” on page 2-13).

You may want to set the Light Control Intensity knob on the TH4-100 to “Max” 
and use the Light Intensity Control knob on the main instrument to control the 
brightfield illumination.

3. Select Brightfield from the iCys Instrument menu to open the brightfield shutter. 
For more information, see “Instrument Menu” on page 3-6.

4. If your system has the optional EpiFluoresence feature, set the EpiFluorescence 
cassette to position 1.

5. For viewing, if the camera is on (as described in “Observing Samples With the 
Video Camera” on page 2-16) you can select the viewing mode by sliding the 
Light Path Selector knob as shown in Figure 2-10:
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Figure 2-10: Light Path Selector Knob

6. Focus the sample using the microscope focus knob or, if available, the rocker 
switch and the fine focus knob on the Remote Control unit.

7. After the hardware setup is complete, you can use the iCys application to view the 
samples on the microscope stage.

Observing Samples using EpiFluorescence
➣ If your iCys system includes the optional EpiFluorescence feature, you can use it to 
observe samples as follows:

1. Set the light path selector lever to observation ( ). 

2. If necessary, deselect Brightfield from the iCys Instrument menu.

3. Turn on the Power Supply Unit for the mercury burner.

4. Set the EpiFluorescence cassette to the desired filter position. The following 
filters are supplied with iCys:

5. Make sure the shutter on the EpiFluorescence cassette is open:

Eyepieces only

Camera only

Eyepieces and Camera
(80% binoculars, 20% Camera)

Table 2-1: EpiFluorescence Filters

Turret 
Position

Filter Name Filter Short 
Name

Excitation 
Light Color

Emission Color

2 U-MNU2 NU Violet Blue

3 UMWIBA2 WIBA Blue Green

4 U-MWIG2 WIG Green Red

Shutter in Open
Position
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6. For viewing, if the camera is on (as described in “Observing Samples With the 
Video Camera” on page 2-16) you can select the viewing mode by sliding the 
Light Path Selector knob as shown in Figure 2-10, “Light Path Selector Knob,” on 
page 2-15.

7. Focus the sample using the microscope focus knob or, if available, the rocker 
switch and the fine focus knob on the Remote Control unit.

8. After the hardware setup is complete, you can use the iCys application to view the 
samples on the microscope stage.

Note: When using EpiFluorescence, you may cause photobleaching in the 
exposed samples. Photobleaching is caused by exposing fluorophores to 
light which, over time, destroys the fluorophores irreversibly and results 
in loss of fluorescence. The degree of photobleaching increases with the 
time and intensity of light exposure. 

When using the EpiFluoresence feature prior to scanning, minimize 
sample exposure and when possible scan in areas that have not been 
exposed to EpiFluorescence illumination.

For detailed information about the EpiFluorescence system, see the Olympus 
Instructions: Manual/Motorized Reflected Fluorescence System.

 Observing Samples With the Video Camera
iCys comes with a 3CCD camera module, EPIX PIXCI® Imaging Board, and XCAP-
Lite image viewing software. You can use the camera while observing to magnify and 
save images from the computer monitor.

➣ To use the video camera:

1. Turn on the color camera monitor.

2. From your PC, click on XCAP for Windows to open the EPIX XCAP-Lite 
application.

3. When iCys scans a sample or is moved from one event to another, the visual 
output is displayed on the camera monitor, if on, and on your PC, if XCAP-Lite is 
open. 

From XCAP-Lite, you can capture and save screenshots of desired images. See the 
online help for XCAP-Lite for more information.
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iCys Specimen Carriers
The first step in running a scan is to load your specimens. After the specimens are 
loaded, you can set up scan parameters as described in Chapter 3, “iCys™ Cytometric 
Analysis Software Application Overview.” 

iCys provides a number of options for specimen carriers:

❑ Microtiter plates (also referred to as “microplates” or “plates”) with 6, 12, 24, 48, 
96 or 384 wells. 

❑ Single standard slide.

❑ Four slide carriers.

❑ 3-petri dish holder. 

❑ Chamber slide.

❑ Clatch slide—a type of chamber slide used for immunophenotyping studies.

Additionally, you can define custom carriers for iCys, as described in Appendix C, 
“Administrator Tasks.”

About Specimen Carriers
All specimen carriers fit onto the plate holder on the iCys stage. iCys accepts the 
following types of carriers:

❑ Microtiter plates. In general, microplates contain cellular or DNA samples. 
CompuCyte recommends the following types of microplates:

❍ 96-well, plastic (such as Whatman cat# 7716-2380)

❍ 96-well, glass, skirtless (such as Whatman cat# 7716-2370)

❍ 96-well, glass, skirted (such as Whatman cat# 7716-2375)

❍ 48-well, tissue culture-treated (such as BD Falcon #353078)

❍ 24-well, tissue culture-treated (such as BD Falcon #353047)

❍ 12-well, tissue culture-treated (such as BD Falcon #353043)

❍ 6-well, tissue culture-treated (such as BD Falcon #353046)

❍ 384-well, optical quality plastic (such as Whatman #7706-2103)

❍ 384-well, optical quality plastic (such as Greiner #781096)
❑ Standard slide carriers and “4-slide carriers.” Slides are used for both tissue and 

cellular samples.
Slide carriers can be ordered from Compucyte.

❑ Petri dish carriers. Petri dish carriers can hold up to three 35mm x 10mm culture 
dishes (such as Corning #430165). 
Petri dish carriers can be ordered from Compucyte.

❑ Chamber slide carriers. Chamber slide carriers are designed to hold the Lab-Tek II 
2-chamber slides (Nalge Nunc #155379).
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Chamber slide carriers can be ordered from CompuCyte.

❑ Clatch slide carriers.

❑ 4-slide carriers.

Loading Specimen Carriers
This section describes loading the various types of specimen carriers supported by 
iCys.

Note: If your iCys system does not use the optional AutoFocus feature, make 
sure that the objective turret is in the full downward position before 
loading a carrier (that is, selecting Load or Instrument ⇒ Load Plate) onto 
the microscope stage.

Loading a Microtiter Plate
➣ To load a microplate on the microscope stage.

1. Invoke the load operation by doing either of the following:

❍ Select Load from the taskbar

❍ Select Instrument ⇒ Load Carrier from the menu bar

The Load operation causes the stage to go to the load position and the plate release 
bar to be retracted.

2. Place the plate onto the stage. The beveled corners should be to your left and the 
column and row labels readable from your point of view.

Note: If your iCys system uses the optional AutoFocus feature, make sure that 
microplate wells to be scanned are at least 1/3 full to allow AutoFocus to 
correctly focus.

Do not touch the bottom of the plate. Any contamination can adversely 
affect your data.
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Figure 2-11: Microscope Stage with 96-Well Plate

Loading Other Carrier Types

Loading Slide Carriers
iCys supports the use of two types of slide carriers:

❑ A standard slide carrier, which holds a single slide. The standard slide carrier is 
shipped as part of the standard iCys installation.

❑ A “4-slide carrier” which holds four slides and can be ordered from CompuCyte.

Figure 2-12: Sample 4-Slide Carrier Layout

 

Note: Slides within a 4-slide carrier are loaded upside down. Therefore, they are 
numbered from right to left.

Loading a Standard Slide
Use the provided slide holder to analyze specimens on a microscope slide. The 
standard slide holder fits into the same space on a stage as a microtiter plate. 

Microplate
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Figure 2-13: Standard Slide Carrier

➣ To load a standard slide tray:

1. Holding the slide release bar to the left, insert the slide into the slide holder, 
coverslip down.

2. Slowly release the slide release bar. Ensure that the slide is secure.

3. Invoke the load operation; click Load on the taskbar or select Instrument ⇒ 
Load Plate from the menu bar.

4. Place the slide holder on the stage with the slide release lever at the lower left. 
Ensure that the slide holder is secure.

Note: Do not touch the coverslip. Any contamination can adversely affect your 
data.

Loading a 4-Slide Carrier
You can order 4-slide carriers from CompuCyte. These carriers allow you to scan 
multiple samples with less human intervention. The 4-slide carrier fits into the same 
space on a stage as a microtiter plate. 

Figure 2-14: 4-Slide Carrier

Slide release bar
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➣ To load a 4-slide carrier:

1. Snap the slides into their respective slide holders on the underside of the carriers, 
coverslip down.

Note: Since 4-slide carriers are loaded upside down, they are numbered from 
right to left.

2. Ensure that the slides are secure.

Tip: For slide carriers, make sure that the slides themselves are loaded into the 
tray with the cover side on the bottom (that is, upside down). Also, make 
sure that each slide is loaded into its holder correctly. The slides must be 
loaded flush with the mounting surface on the bottom of the carrier.

3. Invoke the load operation; click Load on the taskbar or select Instrument ⇒ 
Load Plate from the menu bar.

4. Place the slide holder on the stage with the bevel at the lower left. Ensure that the 
slide holder is secure.

Note: Do not touch the coverslip. Any contamination can adversely affect your 
data.

Loading a 3-Petri Dish Holder
You can order 3-petri dish holders from CompuCyte. These holders allow you to scan 
multiple samples with less human intervention. The 3-petri dish holder fits into the 
same space on a stage as a microtiter plate. 

Note: If your iCys system does not use the optional AutoFocus feature, make 
sure that you only scan one petri dish at a time. Between petri dishes in 
the same carrier, you must lower the objective turret before moving the 
stage.
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Figure 2-15: 3-Petri Dish Holder

➣ To load a 3-petri dish holder:

1. Place the petri dishes into their holders. Petri dishes can be scanned with or 
without their covers. When using Forward Scatter, you will obtain better images 
scanning without covers.

2. Move the cleats to lock the petri dish into place.

3. Invoke the load operation; click Load on the taskbar or select Instrument ⇒ 
Load Plate from the menu bar.

4. Place the petri dish holder on the stage with the single petri dish holder facing the 
rear of the instrument.

5. Ensure that the holder is secure.

Loading a Chamber Slide
You can order a chamber slide holder from CompuCyte. The chamber slide holder 
allows you to use a 2-chamber Lab-Tek II slide with iCys.

Figure 2-16: Chamber Slide Carrier

Empty holder

Open dish

Dish w/cover
and cleats locked

w/cleats open

Chamber slide

Post
Key tab
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➣ To load a chamber slide in the chamber slide holder:

1. Hold the chamber slide by the long sides.

2. Pull the spring-loaded post back (towards left), and carefully place the slide into 
holder, with the key tab engaged into the matching opening on the holder.

3. Position the slide firmly against the 2 rear stops and fully to the right, towards the 
key tab cutout. Slowly release the post. 

4. Make sure that the slide is flat against the rear stop and lies flat on the bottom of 
the holder.

5. Chamber slides can be scanned with or without their covers. When using Forward 
Scatter, you will obtain better images scanning without covers.
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iCys Safety Requirements
iCys has been designed for safe and reliable use for laser cytometry of microplates, 
slides, and other carriers. The iiCys Research Imaging Cytometer’s optics/electronics 
unit contains up to three Class 3b lasers inside and is itself a Class 3R laser product.

Warning: If the iCys system is used in a manner not specified by CompuCyte 
Corporation, the protection provided by the equipment may be impaired.

All lasers are intense sources of coherent light and may cause injury if used 
improperly. In addition, high voltages are present inside the iCys Research Imaging 
Cytometer. Neither are accessible to the operator, unless the door and/or covers are 
opened and the lasers are energized. Be aware of these potential dangers and take the 
proper precautions.

Note: All service functions must be performed by a trained authorized service 
person.

 Laser Safety Labels
The iCys system comes equipped with the following safety labels:

❑ Identification and Laser Certification Label

❑ Classification label

❑ Access Panel labels

Identification and Laser Certification Label
Figure 2-17 shows the location of the identification labels.
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Figure 2-17: iCys Labels

.

Classification Label
The classification label is located on the left side of the main instrument by the 
Identification and Laser Certification labels.

CompuCyte Corporation
12 Emily Street
Cambridge, Massachusetts 02139

MADE IN U.S.A.

VOLTAGE / CURRENT:
FREQUENCY:

120/230 VAC / 16/10 A
50/60 HZ

MODEL NO:

DATE OF MANUFACTURE:

CAUTION
RISK OF ELECTRICAL SHOCK. DO NOT REMOVE  COVERS.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

COMPLIES WITH 21 CFR 1040.1D 1040.11 EXCEPT
FOR DEVIATIONS PURSUANT TO LASER NOTICE NO. 50.
DATED JULY 26, 2001

iCys

CompuCyte Corporation

SERIAL NO.CompuCyte Corporation

SERIAL NO.
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Access Panel Labels
The access panel label is for the main instrument housing lasers. This label is located 
in three places:

❑ Inside access panel

❑ PCB mounting panel

❑ Rear cover

Aperture Labels
This symbol indicates the location of the system laser aperture (the objective lens). 
The label is located on the right face of the black housing directly below the objective 
lens turret.

Safety Symbols
The iCys system comes equipped with the following safety symbols:

❑ Protective earth 5019

❑ On (power) 5007

❑ Off (power) 5008

❑ Pinch Point (hand in rollers) 8011H-ISO

Protective earth 5019

Caution - Class 3B laser
radiation when open

Avoid direct eye exposure

 

   Laser Aperture  

 

 

Protective earth 
This symbol indicates the location of the protective earth 
ground for the main instrument.

It is located on the inside left wall of the main instrument 
enclosure.
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On (power) 5007

Off (power) 5008

Pinch Point (hand in rollers) 8011H-ISO

Safety Feature: Key Locked Door
The front door panel can only be opened with a special hex key. Other panels require 
tools to open and should be accessed only by authorized service personnel.

Safe Operating Guidelines

Warning: Use of controls or adjustments or performance of procedures other than 
those specified herein may result in hazardous radiation exposure.

 

 

On (power) 
This symbol indicates the ON position of the main power 
switches and the laser power switch. 

It is located near or on these switches on the left side of the 
main instrument housing.

 

 

Off (power) 
This symbol indicates the OFF position of the main power 
switches and the laser power switch. 

It is located near or on these switches on the left side of the 
main instrument housing.

 

Pinch Point
This symbol indicates possible pinch points between the 
stage and the instrument cover to the left of the stage and 
between various components of the stage.

It is located on the instrument cover directly to the left of 
the stage.
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Laser Safety
The following safety recommendations apply:

❑ Do not attempt to service the laser system.

❑ For all service functions call a trained CompuCyte authorized service person.

❑ Do not remove the internal safety shields

Warning: Viewing the laser output with certain optical instruments (for example, 
eye loupes, magnifiers, and microscopes) within a distance of 100 mm 
may pose an eye hazard.

Laser Aperture at Objective Lens
Laser light is emitted from the objective lens that is currently selected for use by 
rotating the objective lens turret. 

Warning: Do not remove objective lenses or objective lens port caps. 

Figure 2-18: iCys Laser Aperture

Electrical Safety
The following safety recommendations apply:

❑ Keep all panels and covers in place when operating the system to prevent the 
chance of electrical shock.

❑ Refer all servicing of high voltage or line voltage to an authorized CompuCyte 
service representative.

❑ The CompuCyte iCys Research Imaging Cytometer requires surge protected 
mains or other external surge protection to meet the surge requirements of 
EN61326. Surge protection capable of eliminating surges up to 2kV line to 
ground, and 1kV line to line is required.

Laser Aperture
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❑ CompuCyte highly recommends the use of a surge protector for the computer and 
all peripheral devices, such as your monitor and printer.

Mechanical Safety
The following safety recommendations apply:

❑ Do not place your fingers between the moving stage and the iCys housing

❑ Do not place fingers in specimen area within the stage

Laboratory Safety
The following safety recommendations apply:

❑ Follow established safety procedures for handling specimens.

❑ Avoid direct contact of skin and mucous membranes with dyes and other 
chemicals that may cause injury.
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General Maintenance Information

iCys Maintenance
The general maintenance for the components of the iCys are listed below:

❑ Microscope

❑ Computer

❑ Optics and Electronics Unit 

Microscope
Clean the lenses by blowing air across the lens surface using a filtered air source and/
or wiping lightly with gauze. Avoid abrasives or solvents as they can permanently 
damage the finish. Do not disassemble any part of the microscope.

Computer
When your computer has gathered too much dust turn it off and disconnect all power 
cords. You can then wipe it with a damp piece of cloth. To clean the monitor screen, 
spray window cleaner on a soft cloth and gently wipe the screen.

Do not unplug the power cord while the system is on. After you have switched the 
power off, wait ten seconds before switching the power on again.

CompuCyte highly recommends the use of a surge protector for the computer and all 
peripheral devices, such as your monitor and printer.

Note: Any additions and deletions to hardware or software must be done with 
prior approval of CompuCyte Corporation.

Optics and Electronics Unit
The optics and electronics unit contains no user-serviceable parts.

Do not block the output of the laser cooling fan.
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Functional Specifications
The following specifications apply to the iCys system.

Microscope
Table 2-2 describes the specifications for the microscope used with iCys.

Motorized stage
The range and resolution of the motorized stage is:

❑ Travel range:

❍ X axis = 119.3mm

❍ Y axis 116.3mm

❑ Resolution—0.5 microns

Table 2-2: iCys Microscope Specifications:

Olympus IX-71 microscope 
base

Objectives ❑ 10x magnification — 0.3 N.A.
❑ 20x magnification — 0.5 N.A.
❑ 40x magnification — 0.75 N.A

Crosshair alignment

Eye Viewing WH10x eyepieces, F/22

Video Viewing Sony CCD Video Camera, with EPIX frame 
grabber card

Brightfield Illumination 
Assembly 

❑ 100W precentered Halogen bulb
❑ Brightfield power source, TH4-100
❑ NA 0.55, 27mm Working Distance 

condenser with 5 position manual turret
❑ Illumination Column allows 30 degree 

tilting

Optional EpiFluorescence 
Illumination Assembly

❑ 100W Mercury Burner

❑ Mercury Burner power source

❑ Filter Slider with three filter pockets

❑ WIG, WIBA, and NV filter cubes installed 
in Fluorescence Mirror Unit Cassette
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Lasers

Embedded lasers
Table 2-3 describes the embedded lasers available for use with iCys. iCys comes with 
the Argon laser; the HeNe and Violet lasers are available as additional features.

All lasers are operated in constant wave mode (CW), that is, not pulsed. 

Measurements +/-5% tolerance

Output drift:

❑ 405nm +/-2.5%

❑ 488nm +/-1%

❑ 633nm +/-2.5%

Measurements at objective
Table 2-4 describes the microscope measurements at the objective.

Forward Scatter Detector
Scatter detection is described in detail in “Selecting the Forward Scatter Method” on 
page 3-48.

❑ Light loss detection

❑ Shaded relief detection

Table 2-3: iCys Lasers

Wavelength (nm) Rated output 
(mW)

Beam diver-
gence (mRad)

Argon ion 488 20 0.95

Helium Neon 633 5 1.0

Violet diode 405 60 0.2 x 0.4 
(elliptical)

Table 2-4: Microscope Measurements at Objective

10x 20x 40x

Power 
(mW)

Beam
Divergence
(mRad)

Power 
(mW)

Beam
Divergence
(mRad)

Power 
(mW)

Beam
Divergence
(mRad)

Argon ion
(20mW setting)

3.50 75 3.40 142 3.09 309

Helium Neon 1.13 99.0 1.09 122 0.92 207

Violet diode 0.80 74 0.80 144 0.74 283
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Performance Specifications

Precision
Commercially available fluorescent beads are scanned on a microscope slide with the 
argon ion laser and measured in the red fluorescence. For 2500 beads, the CV of the 
red value is less than 3%, calculated by Full Width Half Max (FWHM).

Linearity
Commercially available fluorescent beads are scanned with the argon ion laser. 
Clusters for singlets and doublets are defined and measured for mean red value. The 
ratio of mean red value of doublets to singlets is in the range of 1.9 to 2.1.

Relocation Precision
Relocation of cells is within ± 6 microns on carriers which have not been removed 
from the stage. This has been verified by running commercially available fluorescent 
beads which are 6 microns in diameter. 
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Chapter 3

iCys™ Cytometric Analysis Software
Application Overview

This chapter discusses how to use the iCys™ Cytometric Analysis Software to set up 
an experiment, scan, and save data.The iCys software is designed to facilitate 
automated data acquisition and analysis. Once you have set up the instrument for a 
particular type of experiment, you can save parameters such as instrument settings, the 
type of data you want to acquire and display, and the statistics to be collected in a 
Workspace file. Whenever you run a similar experiment these variables can easily be 
recalled and updated as needed.

For information about setting analysis parameters for iCys, see Chapter 4, 
“Generating Analytical Data.”

Included in this chapter:

❑ iCys Software Overview, 3-2

❑ Menu Bar Overview, 3-3

❑ iCys Status Bar, 3-8

❑ iCys Task Bar, 3-10

❑ Data Structure, 3-86

❑ Specialized Features, 3-90
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iCys Software Overview

When the iCys Software is launched, it opens the startup screen pictured below.

The pulldown menus in the menu bar allow you to set the parameters for acquisition 
and analysis of data.

The task bar is designed to lead you sequentially through the workflow involved in 
setting up the instrument for an experiment. The task bar contains many of the features 
found in the pulldown menus. 

The status bar provides information about the current status of the iCys system.

Each of these features is discussed in detail in this chapter.

menu bar
task bar

status bar
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Menu Bar Overview
This section describes the menu options available from the iCys menu bar.

❑ File Menu, page 3-3

❑ Setup Menu, page 3-5

❑ View Menu, page 3-5

❑ Instrument Menu, page 3-6

❑ Window Menu, page 3-7

❑ Help Menu, page 3-7

File Menu
The options in the File menu allow you to open, close, save, and print files and 
Workspaces.

When you select any option from this menu that opens a Workspace, the Save 
Workspace, or Save Workspace As window displays, allowing you to save the 
previous Workspace, as discussed in “Saving Workspaces” on page 3-87.

For more information about Workspaces, see “Workspaces and Workspace Files” on 
page 3-86.

The File menu options are as follows:

❑ New Run—Allows you to set up a new Run. You can specify a workspace to use. 
For more information on Run files, see page 3-10. The New Run command is also 
available from the Setup section of the task bar.

❑ Open Run—Opens a Run and its Workspace. If a previous Run is open, that Run 
and its associated Workspace are closed. Additional information on iCys file types 
can be found in “Data Structure” on page 3-86.
Depending on certain file parameters and other information, you can use the Run 
file to either:

❍ Reanalyze raw data or

❍ Analyze event data.
The Open Run command is also available from the Setup section of the task bar, 
(see page 3-15.)

❑ Close—Closes the currently open Run file.
When you close a Run, the Workspace is also closed. You will be prompted to 
save any changes you have made to the Workspace. For additional information 
about Run files, see “Data Structure” on page 3-86.

❑ Open Workspace—Opens an existing Workspace, closing the current 
Workspace. You are prompted to save changes to the current Workspace.

❑ Save Workspace—Saves the current Workspace in the WorkFiles folder. You 
cannot overwrite the template workspaces provided with iCys or a workspace 
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associated with a run. To save changes to these read-only Workspaces you must 
use the Save Workspace As command.

❑ Save Workspace As—Saves the current Workspace under another name.

❑ Open Image—Allows you to open an image file (that is, a file in *.BMP, *.FLF, 
*.JPG, or *.TIF format) using the standard Microsoft Windows Open dialog. The 
image is opened as a window in the iCys Workspace. Once opened, you can 
manipulate the image in the same way you do in other iCys image windows.

❑ Import Protocol—Imports the data acquisition protocol settings from an existing 
workspace. For information about protocols, see “Workspaces and Workspace 
Files” on page 3-86).

❑ Export Events—Saves an Event file under another name or as a text file. 

❑ Merge Runs—Allows you to merge the data from two similar runs.

Use the Merge Run feature to create a virtual run that contains specific data from 
two or more existing runs. For more information on merging runs see “Merging 
Runs” on page 3-91.

❑ Preview Report—Generates a snapshot of the current iCys window including the 
Scan View window, histograms, scattergrams, and gallery views. For example:

Note: iCys currently only provides reports in a single page format.

❑ Print Report—Sends the report to the default printer. If you have Adobe Acrobat 
installed you can also generate a PDF file using the Adobe PDF printer driver. (A 
copy of Adobe Acrobat is included with the iBrowser.)

❑ Save Report—Allows you to save the report as a JPEG (.JPG), TIFF (.TIF), or 
bitmap (.BMP) file in a location you specify.
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Note: For all reports, iCys only includes those windows that are entirely inside 
the Workspace display area.

❑ Exit—Exits iCys. You will be prompted to save the current Workspace.

Setup Menu
❑ Carrier Type—This allows you to specify the type of carrier you will be using 

for the current run. Additional information on carrier types is found “iCys 
Specimen Carriers” on page 2-17.

❑ Carrier—Displays a graphic of the carrier and opens the Scan Area Setup 
window for this run. Additional information on Scan Area Setup is found 
in“Defining the Scan Area for Wells” on page 3-20 and “Defining the Scan Area 
for Freeform Carriers” on page 3-26.

❑ Protocol—Opens the Protocol Setup window. This window allows you to specify 
the details of how you want data collected and processed for the current run. This 
feature is covered in detail in “Setup Section” on page 3-10.

❑ Statistics—Opens the Setup Statistics window, from which you can define the 
Run Statistics for this run, as described in “Statistics” on page 3-60.

❑ Protocol Summary—Displays a textual description of the current protocol 
window. Buttons allow you to save the summary to disk, or to copy it to the 
clipboard, from which it can be pasted into other applications.

❑ New Tab—New Tab allows you to create new pages to better organize the 
display of your data. To create an element on a page, activate the page by 
selecting its Tab, then create the element.You can create and populate as many 
pages as you wish. To view a particular page, select its tab from the top of the iCys 
window.

❑ Rename Tab—Renames the selected Tab.

❑ Delete Tab—Deletes the selected Tab.

Tip: Right-clicking on an existing tab allows you to create a new tab, rename 
the current tab, or delete the current tab.

❑ Show Administration Menu—Displays an Enter Password dialog. When you 
enter the correct password, the Administration menu is added to the menu bar. See 
Appendix A, “Installing iCys™ Research Imaging Cytometer,” for information 
about the Administration menu.
If the Administration menu is displayed, you can hide it by deselecting Show 
Administration Menu from the Setup menu. 

View Menu
The options on the View menu allow you to configure the following iCys features:
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❑ New Scattergram—Creates a new two-parameter scattergram. For information 
about scattergrams, see “Creating and Changing Scattergrams” on page 4-22..

❑ New Histogram—Creates a new one-parameter histogram. For information about 
histograms, see “Creating and Changing Histograms” on page 4-38.

❑ New Gallery—Creates a new gallery of images from a specified region. For 
information about galleries, see “Defining and Creating Galleries” on page 4-20.

❑ Region Statistics—Displays detailed statistics about each defined region. For 
more information, see “Displaying Region Statistics” on page 4-18.

❑ Run Statistics—Displays detailed statistics about each scan area. For more 
information, see “Displaying Run Statistics” on page 4-16.

❑ Field Image—Opens the Scan Field Image window (formerly Scan Data display), 
which allows you to control and monitor the scanning of your specimen. When no 
other active document is open, this window is titled Scan Field Image.

❑ Well Image—Opens the Well Image window. A Well image is a mosaic of all 
scan fields for a given scan area.

❑ Region Image—Opens an image of the scan fields contained in a specified 
region. (This feature is available only with the iNovator toolkit.)

❑ Refresh—Repaints all of the open windows on the iCys Workspace. This can be 
useful when you are adjusting various iCys parameters. If Auto Refresh is 
checked, Refresh is not available. 

❑ Auto Refresh—Automatically repaints open windows in the iCys Workspace 
when adjustments are made to iCys parameters.

Image Menu
This feature is available only with the iNovator toolkit.

Instrument Menu
❑ Home Stage—Moves the microscope stage to its home position.

❑ Home Objective—Moves the microscope objective to its home position.

❑ Load Carrier—Moves the microscope stage to the appropriate position for 
loading a carrier. 

❑ Brightfield—Clears the path from the brightfield lamp to the condenser, allowing 
the brightfield source to illuminate the sample.

Note: When Brightfield is selected, the Scatter sensor is moved out of the way, 
and is unavailable.

❑ Oscilloscope—Opens the Oscilloscope window. This allows you to view a 
representation of the scan outputs. The oscilloscope feature is described in detail 
in “Using the Oscilloscope Feature” on page 3-90.
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Window Menu
❑ This menu lists the histogram and scattergram plots in the current workspace. 

Selecting a plot will bring it to the front of the window. If the plot is on a Tab that 
is not active, selecting that plot will activate the appropriate Tab.

Help Menu
❑ iCys User Guide—This opens the iCys User Guide in PDF format.

Note: Adobe® Acrobat Reader® is required to read PDF files. If your system 
does not have a recent version of Acrobat Reader (version 4 or later), you 
can download it at no cost from the Adobe website.

❑ CompuCyte.com—If your computer is connected to the internet, this will point 
your browser to the CompuCyte website.

❑ About iCys—This displays information about the version of iCys you are 
running, including the software revision, serial number, and hardware 
configuration.

http://www.adobe.com/products/acrobat/readermain.html
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iCys Status Bar

The iCys status bar, at the bottom of the iCys window, displays the following 
information:

❑ Action—The current action, if any, being performed. These may include:

❍ Ready

❍ Test

❍ Scan & Save Data

❍ If a run is paused, the action field will be followed by the word Paused.

❑ WS—The name of the currently open Workspace.

❑ Run—The Run number and name of the Run being saved.

❑ Scan Progress—The first section of Scan Progress shows the field being scanned, 
in the format xx of yyy where:

❍ xx— Number of fields scanned.

❍ yyy—The total number of fields in this scan.
The second part of Scan Progress in brackets reports:

❍ If a microtiter plate is being used, the information in brackets indicates the 
identity of the well being scanned and the field being scanned in that well, in 
the format [XY, FZ], where XY indicate the well being scanned, and FZ 
indicate the field.

❍ If a freeform carrier such as a slide is being used, the bracketed information 
indicates the room number of the slide and the field number being scanned. 
For information on freeform carriers see page 2-12 of this manual.

❑ Active—Indicates the currently active scan area whose data are displayed in the 
graphs and image windows.

❑ Scan—For repetitive scans only, described in “Setting Up a Repetitive Scan” on 
page 3-32, displays a scan count in the format x of yy where:

❍ x— the number of scans performed. Except in the case of repetitive scanning, 
this number will be 1.

❍ yy—the total number of scans requested.

Action WS Run XYZActive Disk space

Laser powerScan progress Processing scan images



Revision B iCys Research Imaging Cytometer User Guide  3-9

May 6, 2005 iCys™ Cytometric Analysis Software Application Overview

❑ Disk space—The amount of disk space currently available on your iCys PC. If 
there is insufficient disk space, it could slow down or even stop iCys. Be sure to 
offload your data on a regular basis.

❑ Processing Scan Images—An hourglass appears while scanning is in progress.

❑ XYZ—When a scan is running, displays the current location of the carrier on the 
microscope bed.

❑ Laser Power—The laser power in mW.
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iCys Task Bar
The iCys task bar is designed to guide you through the tasks 
necessary to set up an experiment and collect data.

Tip: The task bar can be docked on either side of the screen. 
To change its docking location, right-click anywhere on 
the task bar and choose the appropriate option.

The task bar consists of three main sections: the Setup area, the 
View area, and the Scan area. Each of these will be described in the 
following section.

Setup Section
Using the Setup section of the task bar you can:

❑ Select a Protocol Template

❑ Create a new Workspace Protocol

❑ Select a previously defined Workspace Protocol

❑ Select a Saved Run for viewing or re-analysis

The tools in Setup allow you to define the settings specific to your 
analysis. In Setup you may define an analysis protocol or select a 
pre-defined protocol template. 

Within the protocol you may:

❍ Select lasers and PMT detectors for the experiment

❍ Select primary and secondary channels

❍ Enable phantom contouring

❍ Define or select virtual channels

❍ Set up repetitive scans

❍ Select the general instrument settings (such as carrier type, 
etc.)

New Run
iCys allows you to choose among several run templates. These 
templates are provided with iCys and are designed to address some 
of the more common types of experiments. You may use these 
templates as they are, or alter them to suit your needs.



Revision B iCys Research Imaging Cytometer User Guide  3-11

May 6, 2005 iCys™ Cytometric Analysis Software Application Overview

Highlighting a template displays any comments that were saved with it in the 
Annotation field.

If a workspace is already open when you choose New Run, you will be given the 
option of saving changes to it before it is closed.

Using the tabs you can choose from the templates provided with iCys, previously 
saved workspaces, or recently accessed workspaces. You can also browse for 
workfiles stored elsewhere.

iCys Templates
The following templates are included with the basic iCys software.

[1] Empty

The Empty template contains a 96 well plate carrier diagram and a blank protocol 
sheet. The Empty template can be used as a starting point in developing your own 
customized workspace.

[2] One Primary

The One Primary template has two tabs, Protocol and Data. The Data tab is an 
empty window provided for the display of histograms, scattergrams, etc.
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The Protocol tab contains a 96 well plate diagram, a Field Image window, and the 
protocol pictured below.

The protocol is designed to analyze data using a single contour, and includes a 
Phantom contour module.

[3] One Primary, One Sub

Like the One Primary, the One Primary, One Sub template has two tabs; a blank 
Data tab, and a Protocol tab containing a 96 well plate diagram, a blank Field 
Image window, and the following protocol.
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This protocol analyzes data using two contours. These are combined in the 
Association module. As with the Primary Contour protocol, this protocol provides 
a Phantom contour module.
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[4] One Primary, Two Sub

This template provides the same features as the previous two, but with the 
following protocol.

This protocol analyzes for a primary contour as well as two sub-contours, 
including an Association among the three. It also provides a Phantom contour 
module.

Note: Templates cannot be overwritten. If you wish to make changes to them, 
you must use the Save as option to create a new file.

Workfiles
Use this button to select a workfile from the Workfiles folder. Saved workfiles are 
stored in this folder.

Recent
This button brings up a list of recently used workfiles.

Browse
Use this button to select a workfile not located in the Workfiles folder.
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Open Run
Allows you to open a previously saved run, including workspace and data files. If a 
run is currently open, you will be prompted to save any changes.

On this page you can choose from runs saved in the DataCyte folder, custom runs, and 
recent runs. When a run is highlighted, information about that run is displayed in the 
Run field on the upper right of the window.

❑ DataCyte—This button points the system to the default data storage folder 
(DataCyte) on the iCys PC. Runs are stored here by default

❑ Custom—This button allows you to point the system to a specific alternate data 
location. 

➣ To select the customized data location:

1.  Click the Custom button.

2.  Click the Change button in the Custom Location section. 

3. Browse to an appropriate location and click OK. For example if you have moved 
runs from the iCys PC to a location on a remote server you might browse to a 
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folder named RemoteServer\iCysData to find the runs you want to reanalyze or 
the workspaces you want to use. Browse to the folder containing the run folder, 
not to the run folder itself.

❑ Recent—This button brings up a list of recently analyzed runs.

❑ Browse—Use to select a run stored in a location different from DataCyte or 
Custom folders.

❑ Workspace—In the Workspace area in the lower part of the window you can 
choose to analyze a run using:

❍ The current (open) workspace

❍ The workspace that was saved with the run you are opening

❍ A different workspace that you may select

Note: In analyzing a run with a workspace other than the one saved with the run, 
you must ensure that the workspace and run are compatible.

❑ Analysis Mode—In the Analysis Mode area at the lower right of the window you 
can choose to analyze event data, or to analyze image data.

Load
Positions the stage for loading a carrier. See Chapter 2 of this manual for details on 
loading carriers.

❑ Loading Specimen Carriers—iCys supports two types of specimen carriers;

❍ Microtiter plates (also referred to as “microplates” or “plates”) with 6, 12, 24, 
48, 96, or 384 wells.
For information about setting up microplate carriers, see page 3-17.

❍ Freeform carriers, which encompasses all other carriers, including:

✧ Single standard slide.

✧ Four slide carriers.

✧ 3 petri dish carriers. 

✧ 2-chamber slides.

✧ Clatch slides.
These carriers are considered “freeform” because the samples are not 
confined to a specific area as they are with microtiter plates. An important 
step in scanning samples on freeform carriers is defining the location of the 
samples before you begin.

Note: For information about setting up freeform carriers, see “Setting up a 
Freeform Carrier Scan” on page 3-22.
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Note: For detailed information about the specimen carriers, see “About 
Specimen Carriers” on page 2-17.

Carrier
Clicking on this button opens a graphic of the carrier type currently selected. The 
menu at the top of the page allows you to perform such tasks as selecting scan areas, 
moving the iCys stage, and selecting a different carrier type. These are discussed 
below.

Setting up a Microplate Scan
For any microtiter plate, the Microplate Scan Area Setup window displays a graphic 
of the type of carrier in use (selected using the Select Carrier Type button in the 
Carrier window). For example, for a 96-well plate a window similar to the following 
displays:

 

From this window, referred to as the Scan Area Setup window, you can:

❑ Select wells for scanning

❑ Select Active wells for data display or rescan

❑ Define the scan area for a well

❑ Display expression levels for wells

The following table summarizes the Setup window functions.
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Table 3-1: Microplate Scan Area Setup Window

Option Icon Meaning

Select All Wells Used in conjunction with Add to Scan Area and Remove from Scan 
Area, selects or clears all the wells in the plate. 

Select Active 
Well

Select the wells you want to be active. Active wells can be used 
after a scan is complete to select specific wells for which to view 
data analyses or to rescan.
For information about using Select Active well, see “Activating 
Wells or Scan Areas” on page 3-27.

Add to Scan 
Area 

Designate the wells for scanning. Use with the Select all wells 
button to set up scanning for all the wells in the plate. Add entire 
rows and columns by clicking this button and then clicking on the 
row number or column letter.

Remove from 
Scan Area

Remove wells from scanning. Use with the Select all wells button 
to remove all the wells in the plate from the scan. Remove entire 
rows and columns by clicking this button and then clicking on the 
row number or column letter.

Define Scan 
Area

The scan area is the area of the well that is going to be scanned and 
analyzed. Defining the scan area is described in “Defining the Scan 
Area for Wells” on page 3-20.

Move stage to Moves the stage to center the objective on the selected well.

Toggle shading 
mode

For expression level display—If Show Legend is selected, you can 
toggle between the following expression level legends: 

    

For information about the expression level display, see “Showing 
Expression Levels” on page 3-20.

Show legend For expression level display—The Show Legend button displays 
one of the two color map displays shown above. 

If the expression level display has not yet been used for this run, 
Show legend turns on the display.

For information about the expression level display, see “Showing 
Expression Levels” on page 3-20.
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Choosing the Wells to Scan

➣ To select all the wells in the plate:

1. Click the Add to Scan Area icon ( )

2. Click the Select All Wells icon ( ). All wells are now selected.

All the wells will appear as black circles.

➣ To select individuals wells:

1. Click the Add to Scan Area icon ( ). 

2. Click on the individual wells that you want to scan. 

✧ The wells you select will appear as black circles. 

✧ The wells that are not selected appear as white circles.

➣ To select rows or columns of wells:

1. Click the Add to Scan Area icon ( ). 

2. Click on a row letter or column number. 

✧ The entire row or column you selected will appear as black circles. 

✧ The wells that are not selected appear as white circles.

➣ To clear wells:

1. Click on the Remove from Scan Area icon ( ).

2. To remove individual wells, click on the wells you do not want to scan.

3. To remove a column or row of cells, click on the row letter or column 
number.

4. To remove all wells (and start over), click on the Select All Wells icon.

Select Carrier 
Type

Allows you to change the type of carrier.

Pull down menu For expression level display—Select the run statistic for which you 
want to show the expression level in the well map. The run statistic 
dropdown displays all of the available run statistics for this scan. 
This menu is only displayed when Show legend has been chosen

Table 3-1: Microplate Scan Area Setup Window (Continued)

Option Icon Meaning
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Defining the Scan Area for Wells

➣ To define the scan area:

1.  Click the Define Scan Area icon. The Well Scan Area dialog displays:

2. Select whether you want the scan area to be a rectangle or a circle. 

✧ If rectangular, you need to set the Scan field count, which defines the 
number of scan fields in the scan area and the size of each scan area in 
microns.

✧ If circular, you first need to select Circle from the Well Scan Area dialog, 
and then define the Radius of each scan area in microns.

3. Click OK. When you perform either a Test Scan or Scan & Save, iCys will 
generate the scan areas you set.

Showing Expression Levels

When scanning microplates, you can show the expression levels for a specific run 
statistic.You can use this information to help determine if your samples are 
generating sufficient data. 
Use the Toggle shading mode icon, Show legend icon, and the run statistic 
dropdown to display expression levels in the well map during a scan.
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➣ To display the expression level for a run statistic:

1. Begin a Test Scan or Scan & Save run.

2. Click the Show legend ( ) icon. The color legend displays to the right of 
the well map:

3. Select a run statistic from the run statistic dropdown box. For any wells that 
have been scanned, the well color will change to show the expression level for 
that feature. For example:
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4. To change the expression level for a run statistic, click the Toggle shading 
mode ( ) icon. The eight-level color scale will be replaced by a three level 
scale, as shown below.

5.

Note: You can set the minimum (Min) and maximum (Max) boundaries for the 
expression display for each run statistic in the Run Statistics menu. If 
used, these boundaries are reflected in the temperature-style scale.

6. After the expression display is set up, you can:

✧ Switch between to the two expression level displays using the Toggle 
shading mode icon

✧ Select a different run statistic from the run statistic drop down

7. To turn off the expression display, select None from the run statistic dropdown 
and click Show legend again. 

Setting up a Freeform Carrier Scan
The Scan Area dialog box for freeform carriers, described in “Loading Specimen 
Carriers” on page 3-16, is analogous to the Scan Area dialog box for plates. It allows 
you to set the scan areas and other parameters for all non-plate carriers. The Scan Area 
Setup window allows you to:

❑ Define the location and size of scan areas

❑ Select scan areas for scanning, data display or data storage (the “active” scan area)
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Note: If your system does not have the optional AutoFocus feature, do not 
select scan areas in multiple petri dishes. When scanning a petri dish 
carrier without AutoFocus, you must move the objective turret to the full 
downward position when moving between petri dishes (or the objective 
may hit the side of a petri dish).

The Scan Area Setup window for freeform (that is, non-microplate) carriers displays a 
picture of the carrier. 

For example, if the carrier is a standard, single slide, a window similar to the 
following displays when you click the Carrier button:

Note: To make changes to the Scan Area Setup window, you will need to click 
the Lock icon to unlock the editing area.

For a 4 slide carrier, petri dish, or other freeform carrier, a window that shows the 
outline of the selected carrier displays when you click the Carrier button from the task 
bar. For example, the Scan Area Setup window for a 3 petri dish holder appears 
below. 
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For more information about the available specimen carriers, see “About Specimen 
Carriers” on page 2-17.

Table 3-2 describes the options in the Freeform Scan Area Setup window.

Table 3-2: Freeform Scan Area Setup Window

Option Icon Meaning

Select Active Well Select the scan areas you want to be active. Active scan areas can 
be used after a scan is complete to select specific scan areas for 
which to view data analyses or to rescan.
For information about using Select Active well, see “Activating 
Wells or Scan Areas” on page 3-27. 

Lock Wells from 
Editing , 

Locks or unlocks the editing area. There are three lock states:

Locked—In this mode, you cannot create or change scan areas. 
Only the Zoom In, Zoom Out, Grid, Label, Select Active Well, 
Select All, and Select Scan Areas are available. The Scan Area 
Setup window is in this state when:
❑ You first open the window in the Workspace.
❑ Whenever a Raw file is open.
❑ The Run is open for reanalyzing raw data
❑  At the end of a scan.

Note: To unlock the editing area, click the Lock Wells 
button. If appropriate, the Unlock icon will display and 
the editing icons will be available.

Unlocked —This mode is available only when you are setting up a 
live scan. When the icon is unlocked, all editing functions are 
available (such as Create, Delete, and Edit scan area).
Disabled—In this mode, the lock button is entirely disabled 
(grayed out). All scan area functions except Zoom In, Zoom Out, 
Label, and Grid are disabled. The lock button is disabled when:
❑ You are performing a Test Scan or Scan & Save operation
❑ When you open a Run for rescan 

Create Rectangle Define a rectangular scan area using the mouse. 
The mouse pointer changes from an arrow to a cross hair. 
Note that you cannot change direction when creating a rectangle.

Create Ellipse Define a circular or elliptical scan area using the mouse. The 
mouse pointer changes from an arrow to a cross hair.
Note that you cannot change direction when creating an ellipse.
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Create Polygon Define a polygonal scan area using the mouse. The mouse pointer 
changes from an arrow to a cross hair.
To finish the polygon, right-click the mouse. A line will be drawn 
from the last point to the first point in the polygon.

Create Region using 
Stage Keypad

Allows you to generate a region using the microscope stage 
keypad.

Import from File Allows you to import the scan area setup from an event (*.EVT), 
Raw (*.RAW.XML), or Workspace (*.WS.XML) file. This allows 
you to use the same scan areas on a set of similar carriers.
See “Importing Scan Areas from an Existing File” on page 3-28 for 
more information.

Import from XY 
Scattergram

Select regions from an XY scattergram to define a scan area. 
Before importing the scan area, you can individually define gating 
regions in an XY scattergram. Import the regions as described in 
“Importing Scan Areas From an XY Scattergram” on page 3-28.

Select All If Select Active Well is selected, click Select All to enable all scan 
areas on the carrier. 

Select Scan Areas Allows you to select a group of scan areas.

Enable Scan Areas Allows you to pick specific scan areas to scan. 
Use in conjunction with Select All to designate all scan areas on 
the slide to be scanned.

Disable Scan Areas Removes a scan area from those to be scanned. When you disable a 
scan area, the area is greyed out. When you click Select All to 
display the scanned data, explicitly disabled scan areas are not 
selected.

Copy Scan Areas Creates an exact copy of a selected scan area.

Delete Scan Areas Deletes any selected scan areas.

Fit Changes the size of the display to match the actual size of the 
carrier. Holding the carrier up to the full-size image on the monitor 
enables you to more accurately select appropriate scan areas.

Zoom In Zoom in on the image.You can zoom from 25% to 400%.

Zoom Out Zoom out on the image. You can zoom from 25% to 400%.

Table 3-2: Freeform Scan Area Setup Window

Option Icon Meaning
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Right Click on Carrier Window

Fit, Zoom (25% to 400%), Grid and Label can be selected by right-clicking on the 
Carrier window. Label generates and displays a label for each scan area.

Defining the Scan Area for Freeform Carriers

When defining the scan area for freeform carriers, keep in mind the following:

❍ Scan areas can be selected individually by clicking on them with the mouse. 

❍ When changing to a different specimen carrier all currently defined scan areas 
are deleted. To save these scan areas, save your Workspace before switching 
carrier types.

Grid

If you want to lay out scan areas in a precise pattern, Grid displays 
a grid over the scannable area, as shown:

Note that when the carrier window is reduced in size the menu bar 
adjusts to accommodate the change.

Move Stage to Active 
Well

Moves the stage to center the objective on the position of 
subsequent mouse click.

Select Carrier Type Allows you to specify the carrier type for the scan.

Status Bar MP—This field displays the X and Y mouse position relative to the 
top right corner of the carrier. Moving the mouse cursor will 
change the display.

SP—This field displays the X and Y stage position relative to the 
top right corner of the carrier (black square).

%—Displays the carrier display magnification

Table 3-2: Freeform Scan Area Setup Window

Option Icon Meaning

Grid Scale 
Fine      1mm
Coarse  5mm
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Activating Wells or Scan Areas

The Select Active Well button allows you to choose specific wells or scan areas 
for data analysis or rescanning. This allows you to rescan a subset of the wells or 
scan areas on a carrier.
For example, if you have a 4 slide carrier, you may want to rescan some of the 
scan areas. Following is a sample of what the Scan Area Setup window might 
look like:

➣ To activate wells (or scan areas):

❍ Click Select Active Well

✧ To activate an individual well, click on it with the mouse. 

✧ To activate multiple wells, hold the Ctrl key and click on the individual 
wells you want to select.

❑ If your system does not have the optional AutoFocus feature, do not select scan 
areas in multiple petri dishes. When scanning a petri dish carrier without 
AutoFocus, you must move the objective turret to the full downward position 
when moving between petri dishes (or the objective may hit the side of a petri 
dish).
Select Active Well can be used in two ways, as follows:

❍ Data Analysis—When you have specific wells activated, the currently open 
scattergrams and histograms in the Workspace reflect the data only from 
those wells.

❍ Rescanning—To rescan activated wells, select Scan Only Active Wells ( ) 
from the Scan section of the task bar before starting a scan. When you rescan 
the carrier only those wells you selected are scanned. 
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Note: When you rescan virtual data, iCys generates a new Raw file of the same 
name, but with a new Run ID. The new Raw file contains the new data 
created by the rescan as well as any unchanged data from previous scans. 
For more information, see Table 3-5, “Field Image Window Icons,” on 
page 3-68.

Importing Scan Areas from an Existing File

➣ To import scan areas from a file:

1. Click the Import from File icon ( ). 

2. The Open window displays.

3. Browse to and select the Event, Raw, or Workspace file from which you want 
to import the scan areas. Keep in mind that you probably want the carrier 
types to be identical.

4. The scan areas from the selected file are imported. Any existing scan areas are 
deleted.

 Importing Scan Areas From an XY Scattergram

1. Click on the Import Regions From XY Scattergram icon ( ). 

2. The Import ScanArea dialog box displays. Select the regions you want to 
import and click OK. Existing scan areas are not affected.

3. If the coordinates of the scattergram are not within the boundaries of the 
defined slide, the scan area cannot be imported. If this occurs you may need to 
“normalize” the XY scattergram. To do so, right-click the mouse while the 
cursor is over the graph. Select Normalize XY from the menu. The graph axes 
are readjusted to lie within the boundaries of the slide.

Selecting Scan Areas

After you have defined the scan areas in a freeform carrier, you can choose to 
enable all scan areas in the carrier or to enable specific scan areas. 

❍ Enabling a scan area makes it available for scanning
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❍ Disabling a scan area makes it unavailable for scanning. 
Enabling and disabling scan areas can be a useful technique when you need to 
rescan a subset of the scan areas in a run.

➣ To enable all scan areas:

1. Click the Enable Scan Areas icon ( )

2. Click the Select All icon ( ). All scan areas are now selected for scanning.

The selected scan areas will be outlined in black and have handles. For 
example:

 

➣ To enable individual scan areas:

1. Click the Enable Scan Areas icon ( ). 

2. Click on the individual scan areas that you want to include. 

✧ The enabled scan areas will be outlined in black and have handles. 

✧ The scan areas that are not selected do not have handles.

3. To select multiple scan areas, hold down the Ctrl key while clicking on the 
scan areas you want.

➣ To pick a group of scan areas:

1. Click on the Select Scan Areas icon ( ).

2. Then, hold down the left mouse button to draw a box around all the scan areas 
you want to include in the scan. All scan areas within the box will become 
enabled.

➣ To remove (disable) scan areas from scanning:

1. Click the Disable Scan Areas icon ( ).

2. From here, you can:

✧ Click the Select All icon to disable all scan areas

✧ Click individual scan areas (hold down the Ctrl key to disable multiple 
scan areas)

✧ Click the Select Scan Areas icon and draw a box around the scan areas 
you want to disable.
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3. Disabled scan areas are greyed out. You can re-select them as described 
above. 

Protocol
Displays the protocol page, an example of which is seen below.

The protocol page is where you select or create a protocol specifying which data you 
wish to collect, and how you want to process the data. You may use an existing 
protocol as is, modify an existing protocol, or create a new protocol.

Protocol Menu Bar
The icons of the protocol menu are summarized in the following table.
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Option Icon Meaning
Tool Box The Tool Box provides access to the modules you will 

use to create a protocol. For additional information see 
“Creating a New Protocol” on page 3-35.

Repetitive Scan Optical sectioning scans are only available if your site 
has the AutoFocus feature. For information on this 
feature see “Setting Up a Repetitive Scan” on page 3-
32.

Channel Label Displays the channel label menu.

Channel labels can be changed by selecting the Edit 
button from this menu.

Focus and 
Performance

Displays the Focus and Performance menu. This allows 
you to select focusing and scan path parameters. For 
additional information on this feature, see “Focus and 
Performance” on page 3-33.

Apply Applies protocol changes to open image windows on 
the iCys Workspace. This can be useful when you are 
adjusting protocol parameters. 
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Setting Up a Repetitive Scan

Use the Repetitive button on the Protocol window to set up repetitive scans.

About Repetitive Scans

A repetitive scan is the process of scanning the same well or scan area multiple 
times. This allows you to see the change in a single sample over a period of time 
(which can be especially useful for live samples).

Generating Repetitive Scans

➣ To generate a repetitive scan:

❍ Click on the repetitive Scan icon ( }from the protocol menu. The 
Repetitive Scan menu appears.

❍ Check the Enable Repetitive Scan box. The other menu options become 
available.

❍ Enter the number of times you want to scan the selected area.

❍ In the Initial Wait field, enter the number of seconds to wait before beginning 
the scan. This allows you to, for example, specify the time to wait to allow a 
drug reaction to occur.

View Image When image modules such as Channel or Threshold 
are selected, displays the Module Image window. The 
Module Image window shows the image processed by 
the selected module and changes when selecting a 
different module. It is useful for viewing the changes 
applied by each modules.

Initialize After all parameters have been defined, loads all values 
into the protocol.

Option Icon Meaning
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❍ In the Scan Cycle Time field, enter the minimum number of seconds between 
subsequent scan start times. If the scan finishes before the cycle time has 
elapsed, iCys will wait until the next cycle to start scanning again. This allows 
you to, for example, record snapshots at specific intervals of time.

Focus and Performance

Clicking the Focus and Performance icon ( ) opens the following menu.

The Focus and Performance menu functions are described below.

Focus

Allows you to select whether you want to focus the microscope manually or allow 
iCys to AutoFocus for each scan area:

❍ AutoFocus—If your system uses the optional AutoFocus feature, a 

✧ Focus Method—Specify the preferred focus method. 

✧ Bottom then Top—For thicker plastic-bottomed plates (greater than 
400µ) especially; iCysiCys will focus first on the plate bottom, then 
translate up by the bottom thickness to the plate top and refocus.

✧ Bottom Only—For glass-bottomed or thinner plastic-bottomed (less 
than 400µ) plates, iCys focuses directly on the bottom then moves up 
by the bottom thickness plus other offsets to bring the sample into 
focus.

If the carrier type supports only one focus method, the supported method 
will be selected and the unsupported method will be grayed out and 
unavailable.
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✧ Focus Offset—If your system uses AutoFocus and AutoFocus is checked 
you may shift the sample position where iCys will focus by adjusting the 
X and Y offsets. The default AutoFocus location depends on the type of 
carrier, as follow:

✧ For microplates—The default AutoFocus location is at the center of 
a scan area (or well). 

✧ For other carriers—The default AutoFocus location is at the start of 
the first scan field.

You can use the X and Y offsets to shift the AutoFocus location by a 
specified number of microns. The X and Y axes should be set 
independently.

✧ # Wells to skip—Number of wells between refocusing. iCys will 
automatically refocus after skipping the designated number of wells. This 
feature is grayed out when a freeform carrier type is selected.

If Manual Focus is checked, the following menu option will appear.

After manually focusing the instrument, click the Save Z button to save the focus 
setting.

Performance

The performance menu is shown below.

❍ The pull-down Scan path menu allows you to choose the method of scanning 
selected scan areas or wells. The options are Left to right, Right to left, and 
Serpentine (alternating left to right and right to left). Serpentine processing is 
the fastest of the three options.

❍ Checking the Keep shutter open box keeps the shutter open between scans.

Note: The “Keep shutter open” option may not be desirable for sensitive dyes 
and samples, as photo bleaching may occur.



Revision B iCys Research Imaging Cytometer User Guide  3-35

May 6, 2005 iCys™ Cytometric Analysis Software Application Overview

Creating a New Protocol

The following section will walk you through the steps involved in creating a new 
protocol.

Opening the Protocol window

1. Click on New Run in the Task Panel; unless you have made changes to the 
workspace you wish to save, click No in the Save Workspace dialog box.

2. Select Empty as a Workspace to use. Click OK.
This will open a blank protocol page.

3. Click on the Tool Box icon in the upper left corner of the window. The 
protocol tools will appear in the left hand portion of the window.

Tool Box Icon

Expanded headings Contracted headings
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4. Click on the “-” symbol next to each of the headings to contract it. Clicking on 
the “+” symbol next to the headings will expand them and display all the 
options under that heading.

Tip: Right-clicking on the left hand portion of the page will allow you to 
expand or contract all headings at once.

Adding Modules

To add a module to the protocol, click on the module in the tool box menu, then 
click on the center portion of the window. The module you have selected will 
appear.
A dialog box for that module will appear in the right-hand pane of the window. 
Each type of module will have a different type of dialog box. Protocol modules 
are described below.

Deleting Modules

To delete a module, right-click on the module, and select “Delete Module.”

Disabling / Enabling Modules

To disable a module right-click on the module, and select “Disable Module.”

Note: Selecting “Disable Module” will also disable any modules connected 
through the output node of the disabled module. To enable a disabled 
module, right-click on the module and select “Enable Module.” This will 
also enable any modules connected through the output node of that 
module.

Select All

Selects all modules in the center portion of the Protocol window. Right-clicking 
again on any of the modules allows one to “Delete Modules” (deletes all 
modules).

Copy

Not implemented

Print

Not implemented

Protocol Modules
iCys contains several types of modules. These are used as building blocks for 
protocols. These modules are described below.
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Scan Modules

The Scan modules allow you to specify such parameters as lasers, channels, and 
instrument settings.

Detectors

The Detectors module allows you to select which lasers and detectors you wish to 
use, establish settings for these, and create virtual channels.
When you add a detector module, or click on an existing one, a dialog box appears 
on the right portion of the window. There are three tabs on the Detectors window: 
Channel, Virtual Channel, and Scatter.

❍ Channel Tab—When the Channel tab is selected, the following menu 
appears.

❍ Laser Power—In this field you can enter the (488 nm) laser power you wish 
to use. For additional information on setting laser power, see “Adjusting Laser 
Power, PMT Gains, and PMT Offsets” on page 3-82.

Note: When you change a protocol value, the background of the text box 
changes to red. Press enter or select a different text box to accept the 
change. If the value entered is invalid, an exclamation point (!) appears 
next to it. Pointing to the exclamation point will display the error 
message.

❍ Color—Clicking the Color button opens the following menu.



iCys™ Cytometric Analysis Software Application Overview iCys Task Bar

3-38  iCys Research Imaging Cytometer User Guide Revision B

You can choose a CompuColor for each of the active channels by clicking on the 
channel name and selecting a color for it from the pulldown menu. Clicking the 
palette button opens a menu that allows you to create your own colors and apply 
them to a channel.

❍ PMT Settings
The Channel tab menu allows you to adjust the PMT settings. During a Test 
Scan, you must optimize the PMT voltage, gain, and offset values to scale the 
fluorescence for the specimen being scanned. Setting these values requires 
that you open the Field View window in the View menu, and evaluate the 
pixel values of the events. You can then use the Channel window to set the 

palette button

palette button
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PMT voltage and offset values so that the pixel values are consistently within 
the following ranges:

✧ Brightest pixels (events) – 12,000 to 14,000

✧ Dimmest pixels (background) – 300 to 500

Optimizing PMT settings

Monitor the pixel values in the scan field while adjusting the PMT settings and re-
scanning. Double-click on an event to create an event statistic window that shows 
values for the event.

Note: Each time you make a PMT adjustment, you need to re-scan the scan field 
to view the effects of the new settings. Re-scanning the same scan field 
can cause the fluorescence staining of the sample to fade. To avoid 
fading, re-scan the same scan field several times and if you are unable to 
optimize the PMT settings, move on to the next scan field and continue 
optimizing the settings.

Once you have optimized the PMT settings, check that the PMT settings remain 
optimized on a new scan field.
The following diagram illustrates the basic tasks involved in optimizing the PMT 
settings for most samples. Some specimens will require deviations from the 
guidelines in the flowchart.
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Adjusting PMT Channels Flowchart

For detailed instructions on setting PMT parameters, see “Adjusting Laser Power, 
PMT Gains, and PMT Offsets” on page 3-82.
For further information on performing a Test Scan see “Test Scan” on page 3-80.

Done
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Selecting the Lasers and Channels

About the iCys Lasers
iCys comes with equipped with up to three lasers:

✧ Argon Ion, which emits at 488 nanometers. 

✧ Helium-Neon (HeNe), which emits at 633nm.

✧ Violet, which emits at 405nm.
The lasers you select for a given scan will depend on the excitation characteristics 
of the fluorophores used.

Note: Although you can select any laser or laser combination for either the first 
or second pass, some laser combinations will not be compatible with the 
fluorescence emission wavelengths of the dyes you are using. The 
excitation wavelengths should not overlap the emission wavelengths in 
which you are interested for any one pass.

Selecting Data Acquisition Channels

❍ Edit—When the Edit button on the Channel tab is selected, you can specify 
the lasers and channels to be used in both the first and second passes of the 
scan by clicking the Edit button. The following menu will appear.
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Use the Channel checkboxes to select which data channels you want to use. iCys 
can acquire real data from up to five detectors, called PMT1 to PMT4, plus the 
scatter channel.
Site-specific names of each PMT are shown in the Channel dialog box. These 
names are site-dependent, but can, for example, include Blue, Green, Orange, or 
Long Red. If your site uses fewer than 4 PMTs, the unused PMTs are greyed out 
and unavailable. 
Scatter does not use a filter cube. The scatter image is generated from transmitted 
light passing through the sample and striking the scatter detector.
The wavelengths detected by each PMT depend on the filter cubes installed. The 
standard configuration for filter cubes is:

✧ PMT1 = Blue

✧ PMT2 = Green

✧ PMT3 = Orange

✧ PMT4 = Long Red

The filter cube arrangement is site-dependent. Your site may use different filter 
cubes. 
If you are using multiple lasers in two passes, each selected detector will 
constitute a separate data channel. For example, PMT4, with a Long Red cube 
installed, will detect propidium iodide during an Argon laser pass, and 
allophycocyanin (APC) during a HeNe laser pass, thus generating two channels of 
data from the same PMT. In this case, you will see both a Long Red channel and a 
Long Red 2 channel.
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The choice of data acquisition channels will be determined by the emission 
characteristics of the fluorophores, which laser is used to excite them and the filter 
cubes installed.
Check the boxes next to the lasers and channels you wish to use for each pass of 
the scan. Clicking OK enters your selections into the protocol.

Tip: This menu can also be opened by double clicking on the detector module 
box.

For details on setting voltage, gain, and offset levels, see “Adjusting Laser Power, 
PMT Gains, and PMT Offsets” on page 3-82.

❍ Set Default—Checking this box sets the oscilloscope settings to their default 
values. For information on using the oscilloscope, see “Using the 
Oscilloscope Feature” on page 3-90.

Creating Virtual Channels

iCys has up to five detectors, each of which can be used to acquire data from any 
of the three lasers. The output of these detectors comprise the “real” data 
channels. Virtual channels can be created by combining these actual data channels 
using various operators. Thus, virtual channels can be created that, for example, 
sum the Green and Orange channels, subtract the Orange channel from the Long 
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Red channel, or double the output of the Blue channel (by either adding Blue to 
Blue or multiplying Blue times 2).
Within the Virtual Channel tab, if the box to the left of the virtual channel name is 
checked, that virtual channel is selected and will be calculated during the scan. 
Highlighting a virtual channel name displays the definition for that channel in the 
properties dialog box.
If one or both of the constituent detector channels is not selected in the Instrument 
Channels tab, the virtual channel will not remain selected when the menu is 
closed.

❍ Defining a Virtual Channel

✧ Virtual Channel Tab—This tab allows you to create virtual channels by 
manipulating or combining existing channels. When this tab is chosen, 
the following menu appears.

The window in this menu displays previously defined virtual channels. 
Checking the box next to a virtual channel activates it for the experiment. 
If you do not wish to use a particular virtual channel in the current 
experiment, uncheck this box.
If you highlight a virtual channel on the list, its properties will be 
displayed in the lower part of the menu.
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✧ Creating a Virtual Channel
To create a virtual channel

1. Click the New button. The following menu will appear.

2. Enter the name for the virtual channel in the Title field.

3. Select the first channel to be used from the pulldown menu. You can 
choose from any defined channel, including previously defined 
virtual channels.
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4. Next, select an operator from the pulldown menu. The following 
operators are available:

✧ Add
Creates a virtual channel by adding the first and second channel.

✧ Subtract
Creates a virtual channel by subtracting the second channel from 
the first.

✧ Multiply
Creates a virtual channel by multiplying the first channel by the 
factor entered in the operand field.

✧ Max
Creates a virtual channel of the maximum of channel one or two.

✧ Min
Creates a virtual channel of the minimum of channel one or two.

✧ Invert
Creates a virtual channel by inverting the value of the first 
channel. No second channel is used.

✧ ShiftPeak
Shifts the pixel values to change the brightness of a image. 
ShiftPeak works by computing the histogram of the intensity of 
an image. The peak value of the histogram is usually the average 
value of the background. To shift the peak value, enter the new 
peak value into the Reference field (note that, for ShiftPeak, the 
Second Channel field changes to Reference). If the new peak 
value is higher than the original value, the entire image will be 
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brighter.

ShiftPeak is particularly valuable for use with Scatter to correct 
for background intensity changes between scan fields.

✧

5. Select the second channel (or reference or operand) for this virtual 
channel.

6. Click OK. The New Virtual Channel dialog closes and the virtual 
channel is saved.

✧ Edit—Allows you to edit the selected virtual channel.

✧ Delete—Deletes the selected virtual channel.

❍ Working With Virtual Channels

✧ Nesting Virtual Channels
Note that virtual channels can be nested by choosing a previously defined 
Virtual Channel as one channel in the definition of a new virtual channel. 
For example, you can create a Virtual Channel consisting of 
(Green+Orange) - LongRed, where Green+Orange is an existing Virtual 
Channel.

✧ Using Virtual Channel Scan Images
Virtual channel scan images may be selected for display and storage in 
any of the Image or Gallery windows, just as actual data channels are.
Below are scan field images of the same cell visualized in the Green and 
Long Red real channels, and the Green minus Long Red virtual channel.

Scatter Tab

The Scatter tab is available only if your instrument is equipped with the motorized 
scatter assembly.
Clicking the Scatter tab opens the following menu.

Green Long Red Green minus Long Red



iCys™ Cytometric Analysis Software Application Overview iCys Task Bar

3-48  iCys Research Imaging Cytometer User Guide Revision B

❍ Selecting the Forward Scatter Method
Forward Scatter allows iCys to generate images that are much different from 
fluorescence images. When Scatter is selected as a channel, you can select the 
Forward Scatter method you want to use:

✧  Light Loss—iCys centers the detector in the forward scattered beam. 
This position emphasizes the effects of sample absorption, refraction, and 
other light not picked up by the scatter detector.

✧ Shaded Relief—iCys positions the detector so the light hits the edge of 
the detector. In this position, with the offset at 0, half of the forward 
scattered light falls on the detector, while the other half misses the 
detector. When performing a Test Scan, you can adjust the Shaded Relief 
Scatter offset, described on “Setting the Shaded Relief Scatter Offset” 
below. 

✧ Setting the Shaded Relief Scatter Offset
If you select Shaded Relief Scatter, the Shaded Relief Scatter offset 
section displays the Offset slider. Changing the Scatter offset changes the 
sensor angle so that the shading is more or less prominent. Moving the 
slider to the right catches more scatter signal, making the shading less 
prominent; moving the beam to the left makes the shading more 
prominent.

✧ To set the Shaded Relief offset:
During a Test Scan, display scatter images.
Use your mouse to move the slider left or right, then rescan and check 
the image. As you move the slider, the numerical offset is shown in 
the display window. 
Continue making changes and rescanning until you are satisfied with 
the quality of the scatter images.
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When you save or exit the Workspace, the offset is saved with other 
iCys settings.

Tip: The slider can be reset to 0 by clicking the Reset button.

Field Scan

The FieldScan module allows you to set up a scan that scans, segments events, 
develops event features, and displays data on a scan field by scan field basis.
Creating or clicking on a Field Scan module opens the following menu.

❍ General Tab—Under the General tab you can specify the objective you are 
using, the X-step size in microns for the scan, and the field size. These 
selections will be reflected in the Field size and Pixel size fields.

❍ Objective—Allows you to select which microscope objective lens you will 
use for this run. When not actively scanning, the objective is moved out of the 
way of the motorized stage to prevent a carrier from being bumped by the 
objective. 

❍ X Step size—Determines the size of a single stage step in the X direction. The 
default value for X Step is 0.5µm for 20X and 40X objectives, and 1.0µm for 
the 10X objective. Select the size of the X step increment. From the X Step 
pull-down, select any value from .5µm to 20µm (in .5µm steps.)

❍ Field Size—Determines the number of X steps that iCys will take when 
scanning. You can choose a percentage (100%, 50%, or 25%) or to adjust the 
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number of X Steps to generate a square scan field. The scan field and pixel 
size are determined by the dimensions you select and are displayed in the 
Scan field dimension window below.

❍ Scan field dimension—Displays the pixel size and size of the scan field 
based on the parameters you have selected.

❍ Stop on count—Checking this box will stop the scan when the number of 
events in the designated Region reaches the designated count.
Note that when the count has been reached, the system might scan one extra 
field since events are analyzed while scanning the next field. Events from the 
extra field will be ignored when stop on count has been reached.

❍ Advanced Tab—Clicking the Advanced tab opens a menu in which you can 
specify whether or not to apply pixel correction, the Y interval in microns, 
whether or not to save field images, and, if so, in what format. You can also 
choose to save mosaic images for a Test Scan, a scan and save, or both.

❍ Scan Mode—Describes current scan (Virtual, Live, Bypass)

❍ Correct Pixels—Checking this option enables scanline correction to account 
for variations in collection efficiency along the scanline. This is performed on 
each of the images as they are acquired, and is shown in the figure below.
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❍ Y Interval—Allows you to specify a gap, in microns, to add between scan 
field rows. 
If the distance = 0, the scans are contiguous.
Scan strips (that is, scan field rows) are 384µ wide. Therefore, if you set the Y 
interval to 384, you can perform a fast scan by scanning every other row. 
For example:

In the example above, you can clearly see the scan strips in the tissue. 

❍ Field image—Choose whether or not to save a field image, and in what 
format.

✧ JPEG—If Raw files are saved in Jpeg format (.jpg extension), some 
minor differences may be seen between these files and the live data, 
however, the size of the files is greatly reduced with Jpeg files.

✧ Flat—ImagePro flat files (.flf extension) store the identical pixel values 
as are used in the live scan, however, flat files are very storage intensive. 

❍ Mosaic image—Choose whether or not to save a mosaic image, or to view a 
mosaic image during a Test Scan.

❍ Pixel size—Select the pixel size in microns for the mosaic image. A smaller 
pixel size gives better image resolution. A larger pixel size decreases storage 
space needed for the image.

❍ Sampling—Determines the property used to create the mosaic image.

✧ Single creates the image based on the first pixel in the sampling bin.

✧ Average creates the image based on the average value of the pixels in the 
sampling bin.

✧ MaxPixel creates the image based on the pixel in the sampling bin with 
the maximum value.

Uncorrected laser scan image
exhibiting roll-off

Corrected laser scan image

Y interval = 0 

Y interval = 384 

Tissue Scanned with Y = 384
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Contour Modules

The Contour section of the Menu Bar allows you to define Contour parameters, 
including channel, threshold, color, and name. Additional information on defining 
Contours can be found in “Types of Contours” on page 4-3.

Channel

Creating or clicking on a Channel module opens the following menu
.

❍ Channel—The pulldown Channel menu allows you to choose a contour 
channel from a list of active channels, including virtual channels.

❍ Scale image—Checking this box will scale the image to the aspect ratio of the 
scan.

If selected, the new image is created so that the aspect ratio is always 1 to 1.
If cleared, the new images aspect ratio is based on the X-Step and objective.
The aspect ratio must be selected when the subsequent modules include shape-
sensitive operations such as Watershed and morphological filters.

Threshold

Threshold represents the minimum amount of pixel fluorescence required to 
generate a contour for an event. 
When setting the threshold you can choose Auto, which will automatically set the 
threshold, or you can set it manually using a slider.
The threshold module will display either the word Auto or the numerical setting 
you have entered.

There are two methods you may use to manually adjust the threshold.



Revision B iCys Research Imaging Cytometer User Guide  3-53

May 6, 2005 iCys™ Cytometric Analysis Software Application Overview

Pixel survey method—From the Field image (or if you are using tools from the 
iNovator Toolkit, the Field or Well image windows) survey the pixel values at the 
edge of a number of representative events about which you want the system to 
draw contours. Set the threshold value to a rough average of these values.
Image window method—The image window allows you to interactively view the 
effects of changing the threshold setting. With the threshold module selected, 
bring up, the image window by Clicking on the View Image icon ( ) in the 
Protocol Tool Box window.

This will open up the Interactive Threshold window as shown below.

The Interactive threshold window will display a binary image of the scan field 
where pixel values above the threshold are bright and pixel values below the 
threshold are dark. In the above example, the threshold value is 5000.
Use the slide bar in Threshold module to decrease the threshold value until 
dimmer nuclei can be seen in the Interactive Threshold window. The example 
below is at a threshold value of 2500.
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 Refresh the contours to view the cellular segmentation in the Field View window.
Continue adjusting the threshold value to achieve optimal segmentation.

Contour

Allows you to generate the primary (threshold) contour for events by contouring 
the input image.
Creating or clicking on a Contour module opens the following menu.



Revision B iCys Research Imaging Cytometer User Guide  3-55

May 6, 2005 iCys™ Cytometric Analysis Software Application Overview

❍ Component name—Enter the name for the contour component here. This 
component name will carry through to other analysis windows such as 
scattergrams, histograms, and run statistics.

❍ Min area—Specifies the minimum area an event must have to be considered 
for contouring in either µm2 or mm2.

❍ Check max area—When this is checked, the Max area box appears. Here 
you can specify the maximum area an event may have and still be contoured.

❍ Follow concave contour—Checking the Follow concave contour box 
instructs the software to continue tracing a contour through a concave shape. 
Use this option only when necessary, as it is computationally intensive and 
can increase your scan and analysis time.

❍ Color—Use this to select the color displayed in the image windows for 
contoured events. When you have selected a color for the contour this will be 
reflected in the small box on the lower right of the contour module.

❍ Fill—Check this box to fill the contoured events with the selected color in the 
scan image window.

Contour
color
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Event Modules

Event

Options under the Event menu allow you to specify events, create Phantom 
events, and create Associations. 
The Event module creates events that are defined by a threshold contour. You can 
set up the integration peripheral and background contours.

Contour Tab
Selecting the Contour tab from the Event menu opens the following menu.
From the Contour tab, you can set up the integration peripheral and background 
contours.

Integration contour—Defines the boundary within which the total fluorescence 
of the event will be calculated (integrated).

Expand by—Specifies the number of pixels to generate the integration 
contour outside the threshold contour. That is, if you specify Expand by 3, the 
integration contour is drawn 3 pixels outside the threshold contour.
Color—Select the color of the peripheral contour line. If color is set to None, 
no visible contour will be drawn.
Show event id—Displays the event ID for each event in the scan image.

Background Tab
Selecting the Background tab opens the following menu.
Use Dynamic Background—If checked, the system uses two boundary lines to 
define an average background value that is subtracted from the fluorescence based 
features for each contoured event. 

Distance—Specifies the distance between the integration contour and the first 
background contour. Set the first background contour away from the 
integration contour such that it is away from the event fluorescence. 
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Width—The distance between the first and second background contour. Set 
the width such that the outer contour line includes the dimmest pixels adjacent 
to an event. 

Use pixels between—When determining the background, you usually want to use 
those pixels that represent the mean pixel value, such as 30-70%. If, however, the 
background is very bright, you might want use a lower threshold, such as 20-50%.
Color—Select the color of the background contour lines. If color is set to None, 
no visible contours will be drawn.
Corrected Channels—Allows you to select the individual channels that will use 
the background correction. 
Peripheral Tab
Selecting the Peripheral tab opens the following menu.

Peripheral contour—Defines two boundary lines that are used to determine the 
periphery of an event.

Distance—Specifies the distance between the integration contour and the first 
peripheral contour. Set the first peripheral contour such that it picks up the 
brighter peripheral pixels.
Width—Specifies the distance between the first and second peripheral 
contour. Set the width such that the outer contour line includes the dimmer 
pixels that are still within the periphery of an event.

Details on the Contour, Background, and Peripheral tabs are found in “Integration 
Contours” on page 4-7, “Background Contours” on page 4-8, and “Peripheral 
Contours” on page 4-9.

Phantom

Phantom contours are events generated by iCys from circular contours applied 
over the laser-scanned image. 
Creating or clicking on a Phantom module opens the following menu.
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Name—Allows you to change the name of the Phantom contours. This can be 
especially useful if you want to generate multiple phantoms.
Contour color—Select the color of the phantom contour line. If color is set to 
None, no visible contour will be drawn.
Pattern—Specify the type of phantom contours you want to generate:

Lattice—Creates an evenly spaced field of phantom contours. Specify the 
Radius (in microns) and Minimum distance between centers (in microns). 
Random—Generates a random pattern of contours. Specify the Radius, 
Minimum distance between centers, and the Count per field parameters. 

Radius—The size of each contour. Phantom contours are always circular.
Minimum distance between centers—If you space the phantom contours very 
closely, you will generate more data. The phantoms will overlap one another if the 
minimum distance is smaller than the phantom diameter.
Count per field—The maximum number of phantoms iCys will generate per scan 
field.
Phantom contours are discussed in detail in “Generating Phantom Contours” on 
page 4-12.

Association

An Association module allows you to associate two event components generated 
with either an Event Module or a Phantom Module. The Association module has 
two inputs. The input on the left is the primary input. The input on the right is the 
secondary input.
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The secondary input is used for an event component that will become “sub-
events” within the primary event. If the primary and sub-events overlap each 
other, iCys associates the sub-events with the primary event. 

Association 2

The Association 2 module allows you to associate two subevent components with 
a primary event component. The Association 2 module has three inputs. The input 
on the left is the primary, the other two are secondary.

For more information about sub events, see “Scattergram and Histogram Axis Tab” on 
page 4-23, “Scattergram and Histogram Event Type Tab” on page 4-26, and “Event 
Window Details” on page 4-36.

Connecting Modules

As you create modules, you will connect them to graphically create a macro that 
establishes the flow of data for your experiment. Modules have color-coded input 
and output ports. Input ports are on the top of the module, output ports on the 
bottom.

To connect two modules:

1. With your mouse, point to the output port you want to connect. The cursor 
will change to a cross hair.

primary input secondary
input

primary input secondary
inputs

Input port

Output port
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2. Click and drag to the desired input port. Remember, it must be of the same 
color as the output port.

3. When you release the mouse, a colored line will connect the two ports.

Statistics
Clicking the Statistics button opens the following window.
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This window allows you to specify the statistics reported for a run. You can elect to 
create statistics based on an entire well or any event components you have defined in 
your protocol. The tabs available will depend on what event components you have 
defined in the protocol, and the labels on the tabs will reflect the labels you entered for 
those components. 

Note: After making changes to the protocol, you must initialize the protocol 
again for the changes to be reflected in the Statistics tabs.

Well Tab
The Well tab is always available on the Setup Statistics menu. When it is selected, the 
menu displays any Well Statistics previously defined for this protocol. An example is 
shown below.
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Creating a Well Statistic
To create a new Well Statistic, click the New button. 

The following menu appears:

❑ Component—Any contour specified in the current protocol can be used as a 
component. Select the component for which you want statistics calculated.

❑ Statistic—After a component is selected the Statistic field will be populated.
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The following table summarizes the Statistic options:

Table 3-3: Statistics Options

Note: You can select more than one statistical parameter by holding down the 
Ctrl key while clicking on the parameters. This also allows you to 
deselect unwanted parameters. If you click on a parameter, holding down 
the Shift key and clicking on a second parameter selects those two 
parameters and all parameters between them.

❑ Feature—If you select any Statistic other than Count, the Feature field will be 
populated, as seen below.

Parameter Meaning

Count Number of events associated with component

Mean Arithmetic mean of the component for the well or scan area.

SD Standard deviation of the component for the well or scan area.

CV Coefficient of variation of the feature for the well or scan 
area.

Min Minimum value of the feature for the well or scan area.

Max Maximum value of the feature for the well or scan area.

Sum Sum of the feature values for the well or scan area.

FWHM The measurement of the full width at half maximum for the 
well or scan area.
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The following table summarizes the options in the feature field:

Table 3-4: Feature Options

Parameters Meaning

Area Area in square microns of each event.

Background Background fluorescence or signal nearby each event.

Circularity How close the event is to a perfect circle. The circularity is 
defined by: perimeter2/area
Therefore, the circularity of a perfect circle is 4π (12.566). 
The larger the circularity number, the less circular it is.
Note that, due to normalization, the circularity of an event 
may be less than 12.566.

Id The Id number of the event. Each event is individually tagged 
with an Id number.

Integral Integrated fluorescence per event for the selected channel.

MaxPixel Brightest pixel value per event for the selected channel.

Perimeter The perimeter of the event in microns.

Scan Pixel number, from 0 to 768, indicating the y-position of the 
scanning mirror where the event was detected.

Time Time, in seconds, at which the event was acquired.
When rescanning a Raw file, the Time parameter contains the 
Well Number of this scan area.

WellNo Well number (or scan area number) of event.

X position X position in the carrier for each event.

Y position Y position in the carrier for each event.
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❑ Channel—If you have chosen Background, Integral, or MaxPixel, the Channel 
field will be populated with the channels in this protocol. You must select which 
channel to use for analysis.

❑ Region—If you have created any regions on a scattergram or histogram display, 
you can choose to create statistics based on any of these regions. If no regions 
have been created, this field will remain blank.
Note that regions are specific to event components. That is, if a Region 2 is 
defined in a scattergram for Primary events it will be available for statistics for 
Primary events but not for other components. 

❑ Label—If the Use Default box is checked in the Label field, the Statistic will be 
automatically labeled according to the parameters selected. Unchecking the box 
allows you to enter your own label.

❑  Scale Min Max—These values determine the scale used when showing 
expression levels in the Microplate window (see “Showing Expression Levels” on 
page 3-20).

Note that the statistics are calculated only for components that are lower in the 
association hierarchy than the component (or well) tab. For example in the example 
below the component hierarchy (established using the Association2 module) is:

❍ Well

✧ Primary

✧ Sub1

✧ Sub2

Label field
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Run statistics for a Well can be calculated on Primary component events or either of 
the two Sub component events. For the selected component, Well statistics are 
calculated using all of the events of that component within each well (and within the 
specified gating region.) 

Statistics for a component event has no meaning because there is only one component 
event. Thus for the example below, the Long Red Integral value will be reported for 
each primary event, but there is no aggregate of events on which to calculate statistics.

Because the Sub1 component is lower in the association hierarchy than the primary 
component (sub-event are within primary events) statistics are valid for sub-events per 
primary events. In the example below, a mean Long Red Integral will be calculated 
for the sub1 events within each primary event.
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View Section

Field Image
Opens the Field Image window, which allows you to control and monitor the scanning 
of your specimen.

Click Field Img from the task bar to display the Field Image window, pictured 
below. This window displays an image of the current scan for the selected channel.

The Field Image window icons are described in Table 3-5, “Field Image Window 
Icons,” on page 3-68. 
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The Field Image Window Icons
Table 3-5 describes the functions of the Field Image window.

Table 3-5: Field Image Window Icons

Option Icon Meaning

Draw contours Displays any segmentation contours 
you defined including phantom 
contours 

Highlight Highlights events that are within 
colored regions. Use the scattergram 
and histogram functions to set colors 
for regions.

Zoom in Zoom in on the image. Magnification 
range is from 25% to 1600%. To 
zoom in on a specific area, hold down 
the shift key (the cursor will turn to 
magnifier) then click on the desired 
area.

Zoom out Zoom out on the image. 
Magnification range is from 25% to 
1600%. 

Display in 
microns

Selects whether the X and Y cursor 
positions are displayed in microns or 
in pixels. Cursor positions are 
reported at the bottom left of the 
window.

Adjust Focus 
Offset

Allows the user to adjust the sample 
focus. For information on setting the 
focus offset, see “Setting the User 
Focus Offset” on page 3-69.

Set Focus Offset Sets the adjusted offset for use in the 
current Workspace. Note that this 
does not save the new offset to disk. 
For more information, see “Setting 
the User Focus Offset” on page 3-69.

Show 
CompuColor

Displays an iCys-generated color for 
each channel. The colors are overlaid 
so you can see all the detectors 
together to get color coding. This is 
useful for scanning with multiple 
detectors.

Channel Drop down menu allows you to select 
which channel to view. 
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Setting the User Focus Offset
Although the iCys AutoFocus is designed to correctly focus on the specimen to 
produce sharp, focused laser scanned images, some specimens may require an offset 
from the system setting. In this case, if your system uses the optional AutoFocus 
feature, you can manually adjust the focus as described below.

Note: If your system does not have AutoFocus, then the User Focus Offset is not 
applicable. For more information, see “Using the Microscope without 
AutoFocus” on page 2-8.

Adjusting and Setting a User Focus Offset

➣ To adjust the User Offset:

1. Click on Field Img to open the Field Image window. There are two icon 
buttons that control the User Offset:

✧ Adjust Focus Offset—Enables the Focus Adjustment Knob on the 
Remote Control unit (as shown in Figure 3-1). 

Figure 3-1: Remote Control Unit — Focus Adjustment Knob

✧ Set User Offset—When your scan is properly focused, click Set User 
Offset to use the new setting for the remainder of the scan.
Prior to scanning, the Set User Offset button is unavailable and is grayed 
out.
The current value of the User Offset is shown at the bottom of the Field 
Image window.

2. Click Single Field Scan( ) to begin a scan. 

3. Using the Channel Selection in the Field Image window, select the scatter 
detector, or a fluorescence detector with fairly bright and distinct staining. 

4. Click Adjust Focus Offset ( ). The Set Focus Offset button will become 
active.

5. While the scan is paused, you can set the focus offset by rotating the focus 
adjustment knob on the Remote Control unit.Then click Refresh Current Scan 

Focus adjustment 
knob
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( ) to check the focus. Keep changing the focus and refreshing the scan 
until you are happy with the results.

The displayed value on the bottom of the Field Image window (AF Offset:) 
changes as you adjust the focus knob. 

6. When the scan image appears as desired, click the Set Focus Offset button to 
set the current value of the User Offset. 

The new User Offset is used for all scans in the current Workspace. However, 
the new value is not saved to the Workspace file until the Workspace is saved. 

Note: If the scan completes before you click the Set Focus Offset button, the 
offset returns to zero, the Set Focus Offset is deactivated, and the Adjust 
Focus Offset button is cleared. Additionally, the focus knob is disabled 
while scanning.

Saving a User Focus Offset

After the User Offset has been set, click on Save Workspace to preserve the new 
value in the Workspace File. If you exit iCys without saving the Workspace file, 
the new offset will be lost, and the next time you load that Workspace file the 
previous value will be loaded.

The Scan View Status Bar
The Status bar is at the bottom of the Scan View window. It provides the following 
information:

Table 3-6: Scan View Status Bar

Status Detail Meaning

Cursor position The XY coordinates of the cursor position either in 
microns or pixels.

Pixel value The intensity of the pixel over which the cursor is 
hovering. Values can range from 0 to 16383.

Scan number The number of the current scan.

Zoom value The magnification factor as set by the Zoom in and Zoom 
out buttons.

Grid Size Displays the Grid size in pixels

AutoFocus offset If applicable, the offset established using the Adjust focus 
offset and Set focus offset buttons.



Revision B iCys Research Imaging Cytometer User Guide  3-71

May 6, 2005 iCys™ Cytometric Analysis Software Application Overview

The Field Image Properties Menu
If you right-click on the Field Image window, the following menu displays:

The options available on this menu are:

❑ Grid—When Zoom is set to greater than 400%, overlays the scan area with a 
pixel by pixel grid:

If you Zoom out to less than 400%, the grid disappears.

Note: In the grid example above, the aspect ratio is on. Therefore, the pixels 
appear to be rectangular rather than square.

❑ Zoom—Allows you to zoom directly to the magnification of your choice between 
25% and 1600%. Like the Zoom In and Zoom Out icons. 

❑ Aspect Ratio—The same as Display in Microns. Selects whether the X and Y 
cursor positions are displayed in microns or in pixels. If Aspect Ratio is selected, 
the view is in Micron mode.

❑ Pseudo Color—Displays the Field image in color based on pixel intensity. The 
scale used to determine the color also displays:

You cannot have both the Pseudo Color and CompuColor color schemes selected 
for the same window. If one is selected and you select the other, the first color 
scheme is deselected.

Note: The pseudo color scale is set within iCys and cannot be changed.

❑ Fit Window to Image—When you generate a sub-window from the Scan View 
window (by using the Copy command), use Fit Window to Image to make the 
image fit to the size of the sub-window.
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❑ Profile—Displays the Profile View window which allows you to display the pixel 
intensity across a line on the image. For information on creating a profile view, 
see “Creating a Profile View” on page 3-76.

❑ BrightContrast—The BrightContrast function opens up the following window 
that allows you to manipulate the Brightness and Contrast of the Field Image. 
Brightness may be manipulated to bring out dim objects from a dark background. 
Contrast may be manipulated to better resolve objects that are of close brightness 
levels.

 

In the histogram in this dialogue box plots the distribution of pixels in the image. 
The horizontal axis represents expression level or pixel value and the vertical axis 
plots count of pixels at a given expression level.

Adjusting the brightness slider shifts the population of pixels along the 
horizontal axis. Thus, in the example below the red population represents the 
shifted pixels. The brightness value, 6553, represents the amount of the shift in 
expression counts (-16,383 is completely dark, 16,383 is completely white.) All   
pixels in the field image have become brighter. 



Revision B iCys Research Imaging Cytometer User Guide  3-73

May 6, 2005 iCys™ Cytometric Analysis Software Application Overview

The graph in the lower right corner represents the transfer function for the pixel 
population transformation. The horizontal axis plots the input (or starting) pixel 
values and the vertical axis plots the output (or finished) pixel values. Comparing 
the graph immediately above to the original shows a vertical transformation of the 
transfer function line corresponding to the 6553 pixel value shift.

Adjusting the contrast slider broadens or narrows the pixel, population as 
shown below

.

Here the red population can be seen to be broader that the original (black) 
population. This serves to enhance the resolution of objects with similar but 
distinctly different brightness values. The effect on the transfer function is to 
increase it's slope.

The reset button restores the image to its original state.

The binary button makes all the pixels above a certain level completely white 
and the entire pixel range below that level complete dark. The level of this 
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demarcation is the threshold value. With the binary button selected, the contrast 
slider sets the threshold level. Note that the transfer function shows infinite slope.

These adjustments only affect the field image that is displayed. Saved image data 
and calculated event features are not affected by these adjustments.

❑ Scattergram
Image Scattergrams
An image scattergram is an XY graph of all the image pixels. For example:

You can use the image scattergram to: 

❍ Select the channels you want to display. All valid channels, real or virtual, are 
available from the X and Y pulldown lists.

❍ Select regions and add color to show the actual channel expression.
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➣ To add a region:

1. Right-click on the Image Scattergram window. The Image Scattergram menu 
displays:

 

2. Select Create Rectangle.

3. Create a rectangle as described in “Defining the Scan Area for Freeform 
Carriers” on page 3-26.

4. Right-click on the Image Scattergram again and select Color Region (which 
will now be available).

5. Select a color for the region. Within the Well Image window, the color shows 
the portion of the image that has expression levels within the region on the 
Image Scattergram. 

❑ ColorCode to Scattergram—Colors the image to match the pixels that are within 
the colored regions on the image scattergram. 

❑ Copy to New Window—Displays the current image in a new, unnamed window 
in the iCys Workspace. You can add a name to the window from the Properties 
dialog, described below. However, keep in mind that this represents a snapshot. If 
you are performing a scan, the window does not change.

❑ Copy—Copies the current image to the clipboard, which allows you to paste the 
image to the application of your choice.

❑ Save As—Allows you to save a snapshot of the Scan View window as a graphics 
file in one of the following formats:

❍ JPEG (*.jpg)

❍ Bitmap (*.bmp)

❍ TIFF (*.tif)

❍ Image Pro Flat File (*.flf)

❑ Properties—Displays the properties window, which display information about 
the image and allows you to manipulate certain miscellaneous parameters.
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Creating a Profile View

The Profile View tool allows you to see the pixel intensity across a single line, or 
profile, in any image window. 

Image tab—Allows you 
to change the pixel size in 
the display. Shown below 
the X pixels represent .5 
µm and the X pixels 
represent .25 µm, the 
default setting for the 40x 
objective lens.

Grid tab—Allows you to 
change the default 
spacing and units for the 
grid.
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➣ To use the Profile View:

1. Select Profile. A blank grey window displays.

2. Holding the left button on your mouse down, draw a line across the scan area 
in any window in which the scan displays (the Scan View, Well Image, or 
Scout Image windows). A magenta line appears:

Tip: Note that as you draw the profile line, it begins with a solid box and ends 
with an open box. The solid box always represents the left-most data in 
the Profile View window, even if the line is drawn from left to right.

3. When you lift up the mouse button, the Profile View window displays the 
pixel intensity across the line in the scan area:

4. As a new scan area is generated by iCys, the Profile View will change to 
reflect the new image. The Profile View window displays the intensity and the 
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length of the profile line, in pixels. You can change the profile line by 
redrawing it at any time. However, iCys only allows you to have a single 
profile line in each window. 

While only one Profile window can be open, you can have profile lines in 
multiple image windows. When you select an active window, the Profile 
View will reflect that window. If you have a profile line in, for example, both 
the Scan View and the Well Image window, the Profile View will change to 
reflect the selected window.

When you select a new channel, the Profile View will change to reflect the 
intensity for that channel. 

5. To view the profile values for all selected channels (both real and virtual), 
select CompuColor from the scan window. A profile line is displayed for each 
channel. Keep in mind that you may need to select colors for the channels as 
described in “Color” in the “Scan Modules—Detectors” section on page 3-37. 
For example:
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6. You can copy or save the data in the Profile View window by right-clicking 
on the Profile View window. The Copy and Save As options display:

✧ Copy—Copies the current image to the clipboard, which allows you to 
paste the image to the application of your choice.

✧ Save As—Allows you to save the data in the Profile View window in one 
of the following formats:

✧ JPEG (*.jpg)—Saves the image as a graphic in .JPG format.

✧ Bitmap (*.bmp)—Saves the image as a graphic in .BMP format.

✧ Text (*.txt)—Saves the data used to generate the image as tab-
delimited text. There will be one column per color and one row for 
each pixel where the value is the pixel intensity. For example:

7. To turn off Profile View, right-click again in a scan window, and click on 
Profile. When Profile has been cleared in all scan windows, the Profile View 
window will close.

Well Image
Opens the Well Image window. A Well image is a mosaic image of all scan fields for 
a given scan area.

The Well Image window has the same features as the Field Image window (see 
Table 3-5, “Field Image Window Icons,” on page 3-68) with the following additions.
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Table 3-7: Window Icons Specific to the Well Image 

Region Image
Displays an image of the region being scanned. This feature is available only with 
iNovator Toolkit.

Refresh
Updates and redraws all images.

Scan Section
Use the Scan section of the task bar to run either a Test Scan or a full Scan & Save 
operation.

This section discusses the following topics:

❑ Test Scan, page 3-80

❑ Scan and Save, page 3-84

Test Scan
Performing a Test Scan enables you to adjust all of your iCys settings before 
executing a Scan & Save operation. Test Scan performs a scan, which allows you to 
see and adjust your PMT sensors (and other settings) but does not save any data from 
the scan.

Option Icon Meaning

Show Label Selecting Show Label overlays a grid 
that represents the boundaries of the 
constituent field images that have 
been assembled to form the well 
image.

Create Region This feature is available only with the 
iNovator Toolkit.
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Additionally the Test Scan operation allows you to analyze the data and define regions 
in scattergrams and histograms before you perform a Scan & Save.

The six buttons at the top of the Scan section of the task bar control the Test Scan 
function. These are described in the table below.

Table 3-8:

During a Test Scan the Scan Area Setup window displays the scan status of the wells 
or scan areas. However, you cannot select any of the icons from the toolbar. 
Additionally, the following options are disabled from the task bar:

❑ New Run

❑ Open Run

❑ Load

❑ Statistics

❑ Refresh

Start/Pause/Resume
, 

Use this button to:
❑ Start a Test Scan
❑ Pause a scan that has been started
❑ Resume a scan that has been 

paused.

Single Field or 
Next Scan

Acquires first field and pauses, or 
advances to and scans the next scan 
field.

Next well Advances to and scans the next well

Rescan Rescans current field

Previous field Returns to and scans previous field

Scan Only Active 
Wells

If selected, iCys scans only those scan 
areas selected in the Carrier window. 
For more information about the 
Carrier window, see “Setting up a 
Microplate Scan” on page 3-17 and 
“Setting up a Freeform Carrier Scan” 
on page 3-22.

Stop scan Stops the current scan
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Note: To access any of the disabled functions, stop the Test Scan by selecting 
the Stop button on the iCys task bar. 
Note that it will take a few moments for the scan to stop. iCys completes 
the current scan field before stopping.

Adjusting Laser Power, PMT Gains, and PMT Offsets
➣ To adjust the PMT voltage and offset values:

1. Click the Start button  on the task bar to begin a Test Scan.

2. Pause the scan by clicking the Pause icon on the Task Bar to make 
adjustments on the active scan field.

3. From the Channel tab on the Detectors menu, you can change the following 
settings:

❍ Laser Power—Sets the amount of power (in milliwatts) used by the 488 nm 
laser. The laser is adjustable between 5 and 20 mW. In general, CompuCyte 
suggests that you do not change the laser power. There may be instances 
where it is necessary to do so, but first try to adjust the PMT settings. 

❍ Voltage%—Sets the percentage of PMT sensitivity. For a good quality 
sample, the Voltage should be somewhere in the range of 30-70%.

❍ Gain%— Sets the amount of signal amplification. The gain should be left at 
100%.

❍ Offset (Volts)—Sets the background sensitivity. 

4. Set the laser power to a level appropriate for your experiment.
Fluorescent dyes absorb a certain amount of energy, so increasing the laser 
intensity (power) will cause the dye to fluoresce more strongly, but only up to a 
point. Once the dye is saturated, there will not be any increase in fluorescent 
brightness. The saturation point is dye specific, but generally, 5mW of Argon is a 
good intensity (this corresponds to approximately 1mW at the objective).

5. Set the Voltage%:
In the field image window, move the cursor over the brightest pixels and read the 
pixel values located in the status bar.
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If the brightest event pixels have pixel values greater than 14,000, incrementally 
decrease the PMT voltage value and re-scan the scan field by selecting rescan () 
icon. If the brightest event pixels have pixel values less than 12,000, 
incrementally increase the PMT voltage value and re-scan the scan field again (by 
first pausing the scan and then rescanning).
Make sure that none of the brightest pixels are saturated (reading 16383) and the 
brightest pixel values are predominantly in the range of 12,000 to 14,000.

6. To help determine if you have sufficient pixel intensity, you may want to use the 
bright contrast dialog in the field image view.

7. Set the Gain%:
For very bright samples requiring very low voltage settings (below 10%), you can 
decrease the Gain. This will allow you to get a better signal at a lower Voltage. 
For changes in Gain to be effective, you need to make fairly large changes in the 
parameter; try starting with a 20% change.

8. Set the Offset:
In the field image window, move the cursor over the dimmest pixels and read the 
pixel values located in the status bar at the bottom of the field image window, as 
shown in the previous figure.
If the background pixels have values less than 300, incrementally increase the 
PMT offset value and re-scan the scan field. If the background pixels have values 
greater than 500, incrementally decrease the PMT offset value and re-scan the 
scan field by selecting the rescan icon. The offset is very sensitive, you may only 
need to change it by 0.1 or 0.2 percent. Offset values are usually negative. 
Decrease the offset to decrease the background values.

pixel value

status bar



iCys™ Cytometric Analysis Software Application Overview iCys Task Bar

3-84  iCys Research Imaging Cytometer User Guide Revision B

Make sure that none of the dimmest pixels are reading 0 and the background pixel 
values are consistently in the range of 300 to 500.

Note: Offset range is between -5 and 5 volts. Changing offset to correctly adjust 
background pixels will also affect bright pixels. Check bright pixels after 
offset adjustments, and adjust voltage if necessary. 

Note: Staining often varies across the specimen; review multiple scan fields to 
ensure that settings are appropriate.

9. When you are satisfied with the settings, you can confirm that they are optimized 
by using the bright contrast tool in the field image window.

Scan and Save
Once you are satisfied with the settings for your scan, you can click the Scan and Save 
button. Scan and Save begins the formal scan process.

➣ To Start a Scan and Save:

1. Click Scan and Save from the Task Bar. The Scan and Save dialog displays:

2. Enter a Run name.

3. Enter a Run Annotation if desired
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4. Check appropriate Data Saving entries. Save images as either Jpeg or Flat.

5. Click OK. The window closes and the iCys scan begins.

Keep in mind that during Scan and Save, most options are disabled. 

When you stop the scan before all scan areas have been scanned, you will be given the 
chance to keep the data that has been already saved:

If you select No, the all run data already saved will be deleted. The run number will 
not be reused, so the number for the next saved run will be incremented. 

Instrument Section 

Laser Shutter buttons

The laser shutter buttons allow you to manually open laser shutters. When the laser 
shutter is open, the button appears pressed and the laser graphic is colored. During 
scan the buttons update to reflect the current shutter status.

Objective pulldown
Use the Objective pulldown to let the software know which objective is currently 
selected in the turret.
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Data Structure

Workspaces and Workspace Files
Configuring for an experiment involves setting up the instrument for data acquisition, 
organizing the data displays for subsequent analysis, and storing selected information 
about each well on a plate or slide. All of these instrument and display settings are 
saved in a Workspace file, which always has a.WS.XML extension. 

The Workspace contains three main sections, as described below.

Workspace Protocol Settings
The Workspace protocol settings include information about the scan settings and 
analysis settings, including: 

❑ Carrier and scan areas

❑ Protocol settings from the protocol window

❑ Run annotations

❑ Data saving options

Note: The protocol settings are also saved in the Raw and Event files.

Workspace Display Protocol Settings
The display protocol settings, including gating and graph settings such as:

❑ The features for each graph as well as its position and status

❑ The relationships among gating regions of the scattergrams, histograms, 2-
parameter histograms, and cell analysis windows

❑ Run statistics, galleries, scan field images, and histogram files that you wish to 
have automatically saved during the scanning process

Workspace Desktop Settings
Workspace Desktop settings include the size and window positions of the standard 
windows. The information includes:

❑ Tabs

❑ Window positions and sizes

Using Workspaces
You can change, delete, or add new analysis windows to your desktop. Any changes 
can be saved either by overwriting the current Workspace file or saving the 
Workspace under a new name.
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Saving Workspaces
When you make changes to the Workspace and then perform any action that closes the 
current Workspace, prompts you to save your changes as follows:

The Save Workspace message indicates that Workspace elements were changed since 
the last time the Workspace was saved. If no changes were made, the Workspace 
closes without displaying the Save Workspace message.  

❑ If you click No, iCys discards your changes.

❑ If you click Cancel, the action is canceled.

❑ If you click Yes, iCys saves the Workspace. Depending on the action that causes 
the Workspace to close, iCys takes one of the following actions:

❍ Open Run—Displays the Open Run window to allow you to open a new Run 
(which includes the Workspace associated with that Run).

❍ Open Workspace—Displays the Open Workspace window to allow you to 
open an existing Workspace.

❍ Save Workspace—Saves the current Workspace, which remains open.

❍ Save Workspace As—Displays the Save Workspace As window to allow 
you to save the Workspace under a new name or into a new directory.

❍ Close Workspace—Opens the default.WS.XML Workspace.

❍ Exit—Closes iCys.

Note: When you save a read-only Workspace (such as a template or a 
Workspace associated with a Run file), the Save Workspace As window 
displays and the new Workspace will be saved in the WorkFiles directory.

Any open Raw or Event files remain open.

The Save Workspace and Save Workspace As messages inform you of what changes 
have been made to the Workspace, as follows:

❑ Protocol —Changes to the scan protocol, such as channels, PMTs, and other 
items, as described in “Workspace Protocol Settings” on page 3-86 and 
“Workspace Display Protocol Settings” on page 3-86.

❑ Analysis—Changes to scattergrams, histograms, galleries (including window 
positions), and run statistics.

❑ Layout—Changes to positions for windows such as the Scan View window, 
Carrier, iNovator, and Well Statistics windows.
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If your system is using the iNovator Toolkit, described in Appendix B, Using the 
iNovator Toolkit,” then the macro associated with the Workspace is saved when you 
save the Workspace.

➣ To save a Workspace:

Select File ⇒ Save Workspace. The Workspace is saved with the current name. If the 
Workspace already existed, any changes you made to it are saved.

➣ To save a Workspace file under a different name:

1. Select File ⇒ Save Workspace As. The standard Microsoft Save As window 
displays. If the Workspace is read-only, the WorkFiles directory automatically 
opens.

2. Save the Workspace under a different name in the WorkFiles directory.

When you open the Workspace file later, the entire experiment is loaded, including 
instrument settings and the configuration of data displays on the screen. 

Creating A New Workspace
To create a new workspace:

1. Open an existing Workspace, such as default.WS.XML.

2. Make the changes you want for the new Workspace.

3. Select File ⇒ Save Workspace As and save the Workspace with a new name into 
the WorkFiles directory. The Workspace is saved.

Opening an Existing Workspace
If you are doing a series of similar experiments, you may want to set up a single 
Workspace and reuse many or all of the same parameters. Using an existing 
Workspace allows you to do so.

➣ To open an existing Workspace:

1. Select File ⇒ Open Workspace.

2. If desired, save the current Workspace and then browse to the Workspace you 
want to open, and click Open. The new Workspace opens. It contains the 
histograms, scattergrams, PMT settings, and other settings that were saved with 
that Workspace.

If your site is using the iNovator Toolkit, described in Appendix B, “Using the 
iNovator Toolkit,” then the macro associated with the Workspace becomes 
available when you open the Workspace and select iNovator ⇒ Initialize.

Other File Types
iCys creates and uses several file types, and stores them in specific locations. These 
are summarized below.
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Run files
✧ Run.xml files—Contains run metadata and indexes to all other files. 

Stored in the Run folder.

✧ Workspace files (*.ws.xml)—The workspace used to generate the run. 
Stored in the run folder.

Field images
Generated by Field Scans, stored per scale in two folders:

✧  Acquired field images (*.jpg or *.flf) in the carrierX\scanX\FLD 
subfolder

✧  Computed field images (*.jpg or *.flf) (for virtual channels and 
compucolor) in the carrierX\scanX\FLDC subfolder

 Mosaic images
Generated by Mosaic Scans or Field Scans if “Save Mosaic” checked. Stored per scale 
in two folders

✧ Acquired mosaic images (*.jpg) in the carrierX\scanX\MOS subfolder

✧ Computed mosaic images (*.jpg) (for virtual channels and compucolor) 
in the carrierX\scanX\FMOSC subfolder

Event files (*.evt)
Stored per carrier in the carrierX\EVT subfolder

Run statistics files (*.stat.txt)
One file per component in the run folder, generated according to the Statistic Setup. 
Stored in the run folder.

Saved Graphs
All defined graphs are stored per data unit (well or scan area event) for each carrier.

✧  Scattergrams (*.bmp) in the carrierX\SCA subfolder

✧  Histograms (*.his) in the carrierX\HIS subfolder

✧  2-parameter Histograms (*.h2s) in the carrierX\H2S subfolder

Galleries (*.jpg)
All defined galleries are stored per data unit (well or scan area event) for each carrier 
in the carrierX\GAL subfolder
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Specialized Features

Oscilloscope
Using the Oscilloscope Feature
The oscilloscope menu is accessible from the Instrument menu on the menu bar. It is 
shown below.

The iCys oscilloscope feature displays a waveform of the collected signal for one or 
more PMTs across a scan line. The oscilloscope will use the detector settings marked 
as default in the protocol window.

Note: Home, Objective Up, Objective Down, AutoFocus, and Objective Step 
will be available only if your system has the optional AutoFocus feature. 
If your system does not have AutoFocus, these buttons are greyed out and 
unavailable.

The Oscilloscope window has the following icons:

Table 3-9: Oscilloscope Icons 

Option Icon Meaning

Home Moves the objective to Home.

Objective Up Moves the objective up the number of microns specified in the 
objective step box.

Objective 
Down

Moves the objective down the number of microns specified in the 
objective step box.

AutoFocus AutoFocuses the objective. Only available if AutoFocus is selected, 
as described in “Focus and Performance” on page 3-33.

Play or Stop Opens or closes the selected shutter, and activates the display. 
Select appropriate laser(s) on task bar.
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Merging Runs
The Merge Runs feature allows you to merge field image data from two similar Runs 
into a third virtual Run that contains the data that you specify. Merging runs can be 
useful to study the change in a cell over time or to virtually create more channels. You 
can, for example, modify a previously scanned sample by staining it with a different 
dye or treating it with a different drug, and then rescanning so that the changed cells 
can be compared directly to their originally scanned counterparts. 

To merge two Runs, both Runs must have been generated using similar parameters, as 
follows: 

❑ Both Runs must have been created using one Field Scan with saved field images 
that use the same format (either Jpeg or Flat). 

❑ The Runs must have the same carrier type and contain only one carrier. 

❑ The Runs must have been generated using the same objective and resolution. 

Additionally: 

❑ Only scan areas with the same ID and size will be included in the merged Run. 

❑ For partially scanned scan areas, the common scan fields will be included in the 
merged Run 

To merge two Runs: 

1. Open the first Run you wish to merge. 

2. Select File ⇒ Merge Runs. The Merge Runs window displays with information 
about the current run in the Current Run section:

Objective Step Specifies the number of microns to move the objective up or down 
when you click the Objective Up or Objective Down icon.

Channel Allows you to select the channel with which to use the oscilloscope. 
If you select All Channels, the oscilloscope displays overlapping 
lines; one for each selected channel, as described in “Selecting the 
Lasers and Channels” on page 3-41.

Table 3-9: Oscilloscope Icons  (Continued)

Option Icon Meaning
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3. Click the Select button. The Open Run window displays. Select the Run you want 
to open as the Second Run. The information from the second run is entered into 
the Merge Runs window:
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When the second run is opened, the following information is automatically entered: 

❑ In the Second Run section: Run information for the second run. 

❑ In the Merged Run section: 

❑ Common scan areas—Scan areas for which there is similar data in both carriers. 
Only the common scan areas can be merged. 

❑ Channels—All real channels from each run. Virtual channels are not included. 
For duplicate channels (that is, where the channel exists in both runs), the letter m 
(for merged) is appended to the end; that is, for the first Run, the channels are 
listed as Orange-m1, Blue-m1, Blue 2-m1, and so on; for the second Run, the 
channels are Orange-m2, Blue 2-m2, and so on. If you then merge a previously 
merged run, the merge number is incremented; for example Orange-m3, Long 
Red 2-m3, and so on. If desired, you can change the name of the channel from the 
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Channels list. Select the name of the channel you want to change and type in a 
new name. 

4. In the Common Scan Areas section, all common scan areas are automatically 
selected for merging. If desired, clear the checkbox for any scan areas you do not 
want merged. 

5. In the Channels section, all channels are automatically selected. Clear the 
checkbox for any channels you do not want included in the merged run. If desired, 
you can change the name of any channel. 

6. Enter a new Run Name and, optionally, an Annotation. 

7. If you want the new, merged run to open automatically, select Open Merged 
Run. 

8. Optional Image Registration:

When you generate runs for merging, you may find that the events for each run do 
not line up exactly due to slight positioning discrepancies. You can apply “Image 
Registration” to corresponding images so that they are properly aligned.

To preview how these two runs' images match, click the Preview button. The 
Merge Preview window opens: 
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A combined field image from two runs is shown in the window. You can adjust the 
color and intensity for each run's image to best identify the cells of each run. You can 
also choose to view different channel or scan field.

If images of the two runs match well close the window.

If there is a discrepancy between the runs you can apply image registration by clicking 
on Image Registration button. The Image Registration window displays:

In this window you select two points in the first carrier and two points in the second 
carrier that you want to align. To select a point, choose a channel, scan area and scan 
field that shows an easy identifiable location and then move the marker to that 
location.

Most likely the corresponding location appears in the same scan field of the second 
run. If not, clear the checkbox “Same as the first run” and choose the correct scan 
field.

Note: When selecting the second pair of points, choose a scan area that is 
physically far away from the first one. A long distance between the points 
gives the most accurate result.

Once the four points have been selected, click Apply to see the results in the Merge 
Preview window. 
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To view the transformation data for the image registration, click the Transformation 
Details button
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If you are not satisfied with the result, open the Image Registration window and click 
the Reset button to clear the transformation data. You can then reselect points. 

If you are satisfied with result, close the Merge Preview window. 

9. Click OK on the Merge Run window to start the merge, a message, “Merging 
files, please wait” displays.

When the merge is complete: 

❑ If you selected Open Merged Run and there were changes to the current Run 
Workspace: 

❑ The Save Workspace window displays. Click the appropriate button, as described 
in “Saving Workspaces” on page 3-87.

❑ When the merge is finished, a new Run opens that contains only the merged data. 

❑ If you did not select Open Merged Run, the new Run is saved, but the original 
Workspace and Run remains open. 

10. In the new Run, only the field image data and the Workspace are saved. After the 
Runs have been merged, you will need to perform a Scan & Save using the new 
merged data to generate new analytical data for the merged Run. 

Working With a Merged Run 
❑ After you generate new data, the merged channels are very similar to any other 

virtual channels (for more information about virtual channels, see “Working With 
Virtual Channels” on page 3-47). 

❑ Merged channels are available in the merged run for analysis and for creating new 
virtual channels.

❑ Any virtual channels from the first run are brought forward (along with the other 
Workspace settings of the first run) into the merged run's Workspace.

❑ Virtual channels, and other Workspace information, from the second Run are not 
brought forward into the new merged Run.

❑ When using Dynamic Background, channels merged in from the second run will 
be background-corrected by default. 

Reanalyzing Runs
There are two modes available for reanalyzing saved Runs: Analyze Events and 
Reanalyze. These modes are selectable in the Open Run dialogue window from the 
Task bar.
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Analyze Events
In the analyze events mode the events for the saved Run are may be displayed in 
existing or newly defined scattergrams histograms and expression maps. Gating 
regions may be created, deleted or manipulated. Run Statistics may be altered. Events 
may be relocated in their Field or Well images. 

Reanalyze
In the Reanalyze mode the saved field scan images may be re-processed using the 
protocol. Parameters in the protocol (other than hardware parameters such as PMT 
settings, focus settings, objective selection, scan areas, etc.) may be modified. These 
include contour channels, threshold values, virtual channel definitions, associations, 
etc. In addition to these protocol changes, all of the event analysis options available in 
the analyze events mode are available in the Reanalyze mode as well. Runs may test-
scanned or scan-and-saved. Scan and saved runs are saved as a separate runs which 
itself can be reanalyzed.

Reanalysis and Workspaces
When selecting a run for Analyze Events or Reanalysis the default is to open the run 
with the Workspace that was saved with that run. You also have the option to open the 
run with a different Workspace. This allows you, for example, to modify a given 
workspace and then use that modified Workspace to analyze multiple Runs. The 
Workspace and the Runs need to be compatible. 

To select a Workspace, click on the Select button to display the Open Workspace 
Dialogue. From here navigate to and select the desired Workspace.
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Chapter 4

Generating Analytical Data

This chapter discusses how to set up analysis parameters in the  iCys™  Cytometric 
Analysis Software.The iCys software is designed to allow you to create and analyze 
the data you want. Using iCys, you can define contours, scattergrams, histograms, and 
other analytical tools.

This chapter describes the analysis parameters and how they are used in iCys.

Included in this chapter:

❑ Contours, page 4-2

❑ Displaying Run Statistics, page 4-16

❑ Displaying Region Statistics, page 4-18

❑ Defining and Creating Galleries, page 4-20

❑ Creating and Changing Scattergrams, page 4-22

❑ Creating and Changing Histograms, page 4-38

❑ Locating and Viewing Events in the Field Image Window, page 4-45 
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Contours
Contouring is the automated process of setting boundaries to segment and define 
individual events. The Channel, Threshold, and Contour sections of the Protocol ⇒ 
Contour menu and the Protocol ⇒ Event menu allow you to define contours. (see 
“Protocol” on page 3-30.) The features of these menus are summarized below.

❍ Channel—The first step in defining a Contour is choosing the Channel on 
which to base the definition. Select a Channel from the Protocol ⇒Contour ⇒ 
Channel menu. For more information on selecting a channel see “Channel” on 
page 3-52.

❍ Threshold—The Threshold and Channel determine what qualifies as an 
event. The Threshold defines the contiguous pixels whose values are equal to 
the calculated background for the event plus the threshold value for that 
channel. This contour defines the presence of the event at that location. 
Threshold settings are available in the Protocol ⇒ Threshold menu. Primary 
(Threshold) contour settings are found in the Protocol ⇒ Contour menu. For 
more information on setting the Threshold see “Threshold” on page 3-52.

❍ Integration—Defines the boundary within which the total fluorescence of the 
event will be calculated (integrated). Settings for the Integration contour are 
found in the Contour tab of the Protocol ⇒ Event menu. For additional 
information on setting the Integration contour, see “Defining the Integration 
Contour” on page 4-7

❍ Background—Defines two boundary lines that are used to calculate the 
background fluorescence for an event. Setting for the Background contour are 
found in the Background tab or the Protocol ⇒ Event menu. For information 
on defining the Background contour see “Generating Background Contours” 
on page 4-8

❍ Peripheral—Defines two boundary lines that are used to determine the 
periphery of an event. For additional information on Peripheral contours, see 
“Peripheral Contouring and Background Correction” on page 4-13

❍ Phantom—Defines contour lines based on non-event criteria. Phantom 
contours are described in “Phantom Contours” on page 4-11. 

The figure below shows a magnified view of an event with the various contours 
displayed. Note the gradations of grayscale colors in the individual squares. Each of 
these squares is a pixel. By moving the cursor around in the Field Image window, you 
can read the individual values of each pixel in the status bar.
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Figure 4-1: Contour Lines

Types of Contours
iCys allows you to generate a number of different types of contours, which were 
briefly described above. This section describes contours in greater detail.

Defining Contours

Threshold Contours
As described above, iCys considers the Threshold contour the primary contour. In 
iCys, the Integration, Background and Peripheral contours are all generated a 
specified number of pixels out from the Threshold contour.

Generating the Threshold Contour
To set a primary contour, you need to assign a channel and then set the parameters for 
the contour.

A pixel

Background

Integration

Threshold

Peripheral
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Assigning Contouring Channels
➣ To assign contour channels:

1. From the Protocol window, choose Contour ⇒ Channel and click in the field to 
the right of the Protocol menu to create a new Channel module, or click on an 
existing Channel module.

 The following module settings will be displayed.

2. .Select the channel, real or virtual, that you want as the contour channel from the 
Channel pull-down menu.

Setting the Threshold
The Threshold represents the minimum amount of pixel fluorescence required to 
generate a contour for an event.

Settings for the Threshold contour are accessible from the Protocol ⇒ Threshold 
menu.

Contour ⇒ Channel
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➣ To set the Threshold:

1. From the Protocol window, choose Contour ⇒ Threshold and click in the field to 
the right of the Protocol menu to create a new Threshold module, or click on an 
existing Threshold module.

The following module settings will appear.

When setting the threshold you can choose Auto, which will automatically set 
the threshold, or you can set it manually using a slider.
The threshold module will display either the word Auto or the numerical 
setting you have entered, as seen below.

Contour ⇒ Threshold
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To select an appropriate threshold value, open the Well image window, and 
move the cursor over the pixels at the edges of events. Read the pixel values 
located in the status bar, and use those numbers to estimate a threshold value.

Note: Any event that touches the border of the scan field cannot be contoured. 

Additional Contour Parameters
Creating a new Contour module from the Protocol ⇒ Contour ⇒ Contour module, or 
clicking on an existing Contour module brings up the following module settings.

❑ Component name—Enter the name for the contour in this field.

❑ Minimum Area—The minimum area that an event must have to be considered 
for contouring. This can be specified either as µm2 or mm2.
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Note: To be contoured, all the pixels within the area must be brighter than the 
threshold level.

❑ Check Maximum Area—If this box is checked, the Max area field appears. 
Events with a greater area than that specified in this field will not be contoured. 
This feature is useful for microarrays where each core has a known size.

❑ Follow concave contour—Checking this box instructs the software to continue 
tracking along concave segments of a contour.

❑ Color—Select the color for the contour using either the pulldown menu or the 
color palette ( ).

❑ Fill—Check this box if you want the elements in the interior of the contour to be 
colored.

Integration Contours
An Integration contour defines the area within which fluorescence will be integrated 
for a given event. The integration contour is intended to capture more of the 
fluorescence associated with an event by adding adjacent fluorescence just below the 
threshold value.

An integration contour is specified in the Event module (Protocol ⇒ Event ⇒ Contour 
tab):

Defining the Integration Contour
❑ Expand by—Adds a specified number of pixels between the threshold contour 

and the integration contour. Keep in mind the following:

❍ If Added Pixels is set to 0, the Integration contour overwrites the Threshold 
contour (that is, you only see the Integration contour line).

❍ If Added Pixels is set to 1, the integration contour is adjacent to the threshold 
contour.
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Background Contours
Background contours are available from the Protocol ⇒ Event ⇒ Background menu, 
shown below.

Background contour lines are used to capture an approximate value that represents the 
background fluorescence surrounding an event. The value of the background is 
calculated by taking the pixels between the Use Pixels Between boundaries, and 
determining a mean background value. This background value is then subtracted from 
each event pixel.

In the following example, the background annulus of Event1 overlaps Event2, which 
will skew the Event1 background higher. By setting Use Pixels Between, you can 
limit the effect of these kinds of non-background anomalies.

Generating Background Contours
Determine whether you want background contours. 

Event 1

Event 2

Event 1 background
contour lines
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➣ To add background contours:

1. Click the Background tab of the Protocol ⇒ Event window.

2. Check the Use Dynamic background box. Background contouring will be inactive 
unless this box is checked.

3. Set the following parameters:

❍ Distance—The distance between the integration contour and the first 
background contour. Set the first background contour away from the 
integration contour such that it is away from the event fluorescence. 

❍ Width—The distance between the first and second background contour. Set 
the width such that the outer contour line includes the dimmest pixels adjacent 
to an event. 

❍ Use Pixels Between—When determining the background, you usually want 
to use those pixels that represent the mean pixel value, such as 30-70%. If, 
however, the background is very bright, you might want use a lower 
threshold, such as 20-50%.

❍ Color—Select the color for the Background contour using the pulldown 
menu or the color palette.

4. Once the background value has been determined, you can use Corrected 
channels to subtract that value from each event pixel, thereby compensating the 
selected channels for the background noise. 

When using dynamic background, subsequently added channels (such as virtual 
or merged channels) will be background corrected by default. 

For a discussion of when you might want to do this, see “Peripheral Contouring 
and Background Correction” on page 4-13.

Peripheral Contours
You can use additional contour functions to add more information to your data file. 
For example, Peripheral contours give you a measure of the fluorescence in a fixed 
annulus outside of the threshold contour, which is useful for sampling the cytoplasm 
when contouring nuclei with nucleic acid dyes.

Peripheral contour settings are available from the Peripheral tab of the Protocol ⇒ 
Event ⇒ Event menu, shown below.
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➣ To add peripheral contours:

1. Check the Peripheral contour box. Peripheral contouring will be inactive unless 
this box is checked.

2. In the Distance field, enter the number of pixels between the threshold  contour 
and the inner annulus of the Peripheral contour.

3. Enter the width in pixels of the Peripheral contour in the Width field.

4. Select a color for the Peripheral contour.
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When you use Peripheral contouring (yellow in the above example), the integral 
value generated is expressed as the Peripheral integral feature. It is independent of 
the Integral contour, expressed as the Integral feature. MaxPixel data can also be 
measured in the Peripheral contour, and is expressed as the Peripheral Max 
feature.

Phantom Contours
Phantom contours are artificial events that are generated by the iCys software from 
circular contours that are applied over the laser-scanned image. These phantom 
contour events have the following features:

❑ Integral

❑ MaxPixel

❑ X Position

❑ Y Position

❑ Area

❑ Time

❑ Scan

Phantom contours may be laid down within a Field Image in a random fashion or in a 
lattice (two-dimensional array.) They are typically used in applications where you 
want to assess and quantify the fluorescence expression of the image, independent of 
the actual events.
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Generating Phantom Contours 
Creating a new Phantom module from the Protocol ⇒ Event ⇒ Phantom menu, or 
clicking on an existing Phantom module displays the following menu.

➣ To generate Phantoms:

1. Enter a name for the Phantom Component.

2. Select a color for the Phantom.

3. Select Random or Lattice to define the desired pattern of placement:

❍ Lattice—Creates an evenly spaced field of Phantom contours 

❍ Random—Generates a random pattern of contours.

4. Enter the Radius in microns for the Phantom contours.

5. Enter the minimum distance between centers for the Phantom contours.

6. Enter the count per field. The Count per field parameter specifies the maximum 
number of phantoms per scan field.

Displaying Phantom Contours in Field or Well Images

To view phantoms in any of the Field or Well Image select ( ) The phantoms in the 
figure below are randomly placed.
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Using Contouring
Following are some examples of how contouring can be used.

Comparing the Size of the Nucleus to the Amount of Cytoplasm
You can set up contours to compare the size of the nucleus to the amount of 
cytoplasm. The key here is that by generating the contours, you can determine the 
integral areas for both the nucleus and the cytoplasm, as follows:

❑ Threshold contour isolates individual cells around the nuclear stained area. 

❑ Integral contour begins a specified distance from the threshold and integrates 
fluorescence in the nucleus. 

❑ Peripheral contours begin farther out from the threshold contour, and need not 
extend to the end of the cytoplasm. Pixel values within the peripheral contours are 
integrated, providing a measure of cytoplasmic fluorescence. 

❑ Background contours begin just outside the peripheral contours for background 
sampling.

Peripheral Contouring and Background Correction
When using peripheral contours, you usually do not want to subtract background from 
the detector that measures the cytoplasmic stain of interest. For example, consider a 
specimen where the primary contour is set to segment events based on the Blue 
detector and the cytoplasmic staining is measured in the Green detector. To prevent 
the background value, which is determined for each detector by the pixels in the 
event's background contours, from subtracting too much from your peripheral 
integral, deselect the Green detector in the Corrected Channels list box on the 
Background tab of the Event module.
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Using Inverted Scatter for Contouring
Using the Inverted Scatter channel for contouring allows you to generate precise 
contours on events with little or no fluorescence. When you use the Light Loss scatter 
position, events appear dark on a bright background (light loss due to absorbance and 
refraction is measured). Therefore, using Inverted Scatter generates bright events with 
a dark background. With appropriate settings, the bright events can be contoured.

➣ To use Scatter for contouring:

1. In the Protocol ⇒ Detectors window choose the Virtual Channel tab.

2. Create a virtual channel using Inverse Scatter. Give the channel a meaningful 
name (such as ScatterInvert). For details on creating a virtual channel, see 
“Creating Virtual Channels” on page 3-43.

3. In the Scatter tab of the Detectors window, select Light Loss as the Scatter 
position. 

4. In the Protocol ⇒ Detectors ⇒ Virtual Channel tab, check the name, e.g. 
ScatterInvert, of the new virtual channel.

5. Create a new channel module using the inverse scatter virtual channel. For 
additional information on channel modules see “Channel” on page 3-52.

When you run iCys, the contoured events will appear bright on a dark background, as 
shown:

Green 
channel 
cleared
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Inverse  
Scatter  
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Scatter  
channel 
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Displaying Run Statistics
➣ To open the Run Statistics Window, click View ⇒ Run Statistics

The Run Statistics Window displays the statistics that are defined for each component:

Defining Run Statistics
For information how to define the statistics see “Statistics” on page 3-60. You can also 
open the Setup Statistics window by double-clicking on the window. Changes to the 
Statistics Setup become effective immediately and you can view the updated values 
for all available events.

Tabs
A tab will be available for each component for which statistics have been set up. In 
this example, the Well tab shows a row for each well, and the Primary tab shows a row 
for each Primary event.

Columns
There are typically three sets of columns:

❑ Row number (#)—A sequential number for the row. Clicking on the # returns the 
rows to the original sort order.

❑ Row identification—(Carrier, Room, Well, <Parent Component Name>, 
<Component Name>) At the minimum there will be a <Component Name> 
column (such as Well or Primary), to identify the item on the row. Additional 
columns such as Carrier, Room, and/or <Parent Component Name> will be 
displayed if needed.

❑ Statistics—one column for each defined run statistic.
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Sorting the Data
The data in the Statistics window can be listed in either ascending or descending order 
by any column. To change the order of the data, click on the column name on which 
you want to sort. Click once to change the order of the data to descending; click a 
second time to reverse the order. To return to the original sort order, click on the # 
column.

Exporting the Statistics
Right-clicking on the statistics window brings up a context-menu from which you can 
export the tabular data to third party applications such as Excel for further analysis:

❑ Copy—copies all rows of the current tab to the clipboard from where they can be 
pasted into Excel for example.

❑  Save As…—allows saving the values tab-delimited to a text file.
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Displaying Region Statistics
➣ To open the Region Statistics window, click View ⇒ Region Statistics.

The Region Statistics window displays detailed statistics about each scattergram, 
histogram and region in your Workspace, including statistics for the events in each 
region:

Tip: If no regions have been set, you can still invoke region statistics to see 
statistics on total events in each graph.

The Region Statistics window displays the following information:

Table 4-1: Region Statistics Window Statistics

Statistic Description

Region The id of this scattergram (S1, S2, for example), histogram 
(H3, H4), or region (R1, R2) along with:
❑ The number of data points in the defined area.
❑ The percentage of data points currently displayed in the 

graph as compared to the entire population of events. For a 
scattergram or histogram, the percentage should be 100% 
(assuming that both axes are normalized and the graph is 
not gated from another graph).

Label If you labeled this region, as described in “Labeling Regions” 
on page 4-34, the name appears here.
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For more information about scattergrams, see “Creating and Changing Scattergrams” 
on page 4-22.

For more information about histograms, see “Creating and Changing Histograms” on 
page 4-38.

Param The parameter(s) used in this region, as described in 
“Scattergram and Histogram Feature Parameters” on page 4-
24.
❑ For scattergrams, and regions within scattergrams, there 

are two parameters, one for each axis.
❑ For histograms, and regions within histograms, there is 

one parameter, reflecting only the X axis.

Mean The mean of the events in this region.

CV% The coefficient of variation for events in this region. The CV% 
is Standard Deviation/Mean.

STD The standard deviation for events in this region.

FWHM% The measurement of the full width at half maximum for each 
parameter.

Table 4-1: Region Statistics Window Statistics

Statistic Description
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Defining and Creating Galleries
Galleries are a series of images centered on events in a specified region. Galleries may 
be generated in one of two ways:

❑ Select View ⇒ New Gallery from the iCys menu bar to create gallery images that 
are automatically saved. This method is described in “Creating a Gallery from the 
View Menu” on page 4-20.

❑ By clicking on Create Gallery from the View Cells window as described in 
“Viewing Cell Details” on page 4-35. This method is described in “Creating A 
Gallery From the View Cells Window” on page 4-20.

Creating a Gallery from the View Menu
Galleries created from the View menu can be viewed during a scan. As each scan area 
is scanned, the gallery updates to show the first 25 events in the region.

➣ To create a new gallery from the View menu:

1. Select View ⇒ New Gallery from the iCys menu bar.The Gallery  dialog 
displays:

2. Select the region for which you want to define the events to be included in the 
gallery. When the gallery appears, you can choose which channel you wish to see 
by selecting the appropriate tab at the top of the gallery.

Note: To display a gallery you must specify a region that defines the events to 
be included. If you have not created any regions in your Workspace the 
New Gallery selection is grayed out.

Creating A Gallery From the View Cells Window
Galleries created from the View Cells window have the following properties:



Revision B iCys Research Imaging Cytometer User Guide  4-21

May 6, 2005 Generating Analytical Data

❑ These gallery images are not automatically saved. To save a gallery image, right-
click on the image. When you click on Save Gallery Image, the Save As window 
displays. Gallery images can only be saved in JPG format.

❑ By clicking on the tabs at the top of the gallery, you can display the events for all 
active channels.

➣ To create a gallery from the View Cells window, click the Create Gallery button. 

The images displayed in the gallery begin with the selected event (or the first 
event, if no events are selected). Each window in the gallery displays the next 
event in the list until all the windows are filled or iCys reaches the end of the 
events list. For example:

Copying a Gallery
You can copy a picture of a gallery to any application that accepts data from the 
Windows clipboard. 

➣ To copy a gallery:

1. Right-click on the gallery.

2. Select Copy from the pop-up menu.

3. Open any application that accepts data from the clipboard (such as WordPad, 
Word, or Excel), and use the Paste function from that application to paste the 
graphic into the application.
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Creating and Changing Scattergrams
This section contains the following topics:

❑ About Scattergrams, page 4-22

❑ Using the Graph Property Window, page 4-23

❑ Setting Scattergram Regions, page 4-30

❑ Setting Region Attributes, page 4-31

❑ Viewing Cell Details, page 4-35

❑ Other Scattergram Information, page 4-37

About Scattergrams
Scattergrams are two parameter graphs that allow you to view and save a wide variety 
of data during an iCys scan. Each spot on a scattergram represents an event that 
corresponds to the attributes you have selected.

Within an iCys scattergram, you can create one or more regions. A region is a subset, 
or area of interest, within the scattergram from which you can:

❑ Create relationships between scattergrams and histograms so that the data in one 
graph is derived from events that are within regions in other graphs. This is called 
“gating,” and is described in greater detail in “Scattergram and Histogram Event 
Type Tab” on page 4-26.

❑ Generate statistical analyses of the events in regions. For more information, see 
“Viewing Cell Details” on page 4-35 and “Displaying Region Statistics” on 
page 4-18.

❑ Add color to regions to allow you to easily identify or compare subpopulations of 
events that appear in different analysis graphs. For more information, see 
“Changing Region Color” on page 4-32.

You can make changes to the existing scattergrams or add more scattergrams.

➣ To create a new scattergram, select View ⇒ New Scattergram from the menu bar or 
right-click on the Workspace and select New Scattergram.

Note: Scattergram and Histogram windows are numbered consecutively. 
Scattergrams have an S prefix, histograms have an H prefix.

A new scattergram is added to your Workspace.
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Using the Graph Property Window
➣ To adjust the scattergram, right-click on the scattergram to open the Graph Property 
window. The Graph Property window contains three tabs:

❑ Axis Tab

❑ Event Type Tab

❑ General Tab

This section discusses the tabs in the Graph Property window.

Scattergram and Histogram Axis Tab
The Axis tab for both the scattergram and histogram windows lets you choose what 
data to display and how to display it. The only difference between the Axis tabs for 
these graphs is that the Y-axis for histograms is always set to Count and cannot be 
changed.

For more information about histograms, see “Creating and Changing Histograms” on 
page 4-38.

You can set the following parameters on the Axis tab:

❑ Axis for Scattergram—Select the axis (X or Y) to which you want to make 
changes.

❑ Ticks—Specify a number that determines the number of tick-marks displayed on 
this axis.

Note: When the parameter is X or Y position, iCys flips the axes (so the 0,0 is in 
the upper right-hand corner. This causes an event’s position on the 
scattergram to parallel its position on the carrier.
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❑ Grid—If selected, overlays a grid on the display for the axis you have selected. 
The number of grid lines is based on the number of tickmarks selected in the 
Ticks parameter.

❑ Label—Specify a label for this axis. The name is displayed along the axis you 
selected. If Use default is checked, the axis will be labeled according to its 
parameter.

❑ Feature—Select the measured parameter for each axis. The features that are 
available depend on the type of event. If the feature is not appropriate for the 
event (for example, Parent ID for a Primary Event), it will not appear in the 
Feature pulldown.

Tip: For features designated with a (Sub *), a selection will display in the 
Features pulldown for each subcontoured channel. For example, if you 
have both Green and Orange subcontours, you will see the following:

Area (Sub Green)
Area (Sub Orange)

Depending on the event type, the available features are:

Table 4-2: Scattergram and Histogram Feature Parameters

Feature Meaning

Area Area in square microns of each event.

Area (Sub *) For primary events if there are subcontours—The 
total area, in square microns, of all sub events 
associated with the primary event.

Array XPos For tissue arrays, the x position in the array

Array YPos For tissue arrays, the y position in the array

Background When using Dynamic Background, the background 
fluorescence or signal nearby each event.

Circularity How close the event is to a perfect circle. The 
circularity is determined by:

perimeter2/area
Therefore, the circularity of a perfect circle is 4π 
(12.566). The larger the circularity number, the less 
circular it is.
Note that, due to normalization, the circularity of an 
event may be less than 12.566.

Count (Sub *) For primary events if there are subcontours—A 
count of the number of sub events associated with the 
primary event.
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Tip: You can combine parameters by choosing a numerator as well as a 
denominator parameter. The resulting parameter will reflect the value of 
the numerator divided by that of the denominator.

❑ Channel —Assign the channel to display for features that are channel-specific.

❑ Log scale—If checked, displays this parameter in a base 10 logarithmic scale 
(that is 0= 100, 1= 101, and so on). This can be useful if the data for this parameter 
has a very broad range. For example, integral data may display better in log scale.

Cycle For repetitive scans, the cycle number within the 
series of scans. 

Integral Integrated fluorescence per event for each saved 
channel.

Integral (Sub *) For primary events if there are subcontours—The 
Integrated fluorescence per sub event for each saved 
channel.

MaxPixel Brightest pixel value per event for each saved 
channel.

Parent ID Subcontours only—The WellID of the primary event 
to which this subcontour is related.

Perimeter The number of microns that comprise the perimeter 
of the event.

Peripheral Integral Peripheral contours only —The integral of the 
fluorescence in the area defined by the peripheral 
contour.

Peripheral Max Peripheral contours only —The MaxPixel in the area 
defined by the peripheral contour.

Scan Pixel number, from 0 to 768, indicating the y-
position of the scanning mirror where the event was 
detected.

Time Time, in seconds, at which event was acquired.
When rescanning a Raw file, the Time parameter 
contains the Well Number of this scan area.

Well # Well number (or scan area number) of event.

X position X position in the carrier for each event.

Y position Y position in the carrier for each event.

Z position Z position in the carrier for each event.

Table 4-2: Scattergram and Histogram Feature Parameters (Continued)

Feature Meaning
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❑ Normalize when applied—If checked, automatically scales the axis for this 
parameter so that all datapoints are included. The axis will be normalized only 
when OK or Apply is pressed, not continuously as the data changes.

❑ Range—Allows you to specify the range of the value displayed in the graph by 
entering specific values.The Range fields default to settings appropriate for the 
parameter chosen for the axis.

Scattergram and Histogram Event Type Tab
This tab allows you to specify the events that will trigger a spot on a scattergram or 
histogram.You can set the following parameters on the Event Type tab:

❑ Component—Select a component defined in the protocol. Events of this 
component will be displayed.

❑ Gating—Specify whether you want to include all events in this graph or only 
those that conform to a specific region, or “gate” on another graph. You can 
combine two regions into a gate by selecting the first region, and combining it 
with a second region using the Boolean operators AND, OR, or NOT.

The Gate type field indicates the type of gate specified in the first (left-hand) 
field: 

❍ Normal—The graph from which you are gating (that is, the current graph, 
which can be either Primary or Sub) is of the same event type as the graph in 
which the region(s) lie. 

For normal gating, make sure that you only gate between events contoured 
using the same component. If you create gates between different components, 
the results are undefined.

❍ ParentToChild—The graph on which you are gating (that is, the current 
graph) is a Sub event graph and the region lies within a Primary event graph.

❍ ChildToParent—The graph on which you are gating (that is, the current 
graph) is a Primary event graph and the region lies within a Sub event graph.

❑ Child to Parent Mode—When the Gate type is ChildToParent, as described 
above, you may have a situation as follows;

You can select one of the following options:

❍ Inclusive—Include those events that have any sub events in the region.

❍ Exclusive—Include those events that contain only the selected sub events in 
the region.

In the following example:
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❍ The first scattergram to the far left is gated to another scattergram (not shown) 
such that it only displays events that contain two orange subevents.

❍ The second scattergram is inclusive and shows all events that within the 
region that contain two subevents. Note that the exclusive events are also 
shown in this scattergram (in red).

❍ The third scattergram is exclusive and shows only those events for which the 
two subevents are relatively large (that is, for which the integral is high). 

Tip: The Inclusive and Exclusive scattergrams are shown in low resolution, as 
described in “Scattergram General Tab” on page 4-27.

For more information about creating regions for scattergrams, see “Setting 
Scattergram Regions” on page 4-30.

For more information about creating regions for histograms, see “Setting Histogram 
Regions” on page 4-41.

Scattergram General Tab
The General tab allows you to set a number of miscellaneous parameters. The general 
parameters for scattergrams and histograms are different; for more information about 
the histogram parameters, see “Histogram General Tab” on page 4-39.

The parameters available from this tab are:

❑ Title—Enter a title for this graph. The title appears at the top of the graph.

❑ Display (Global)—Specify whether you want to display scattergram and 
histogram data on a white or a black background. Note that this setting affects all 
scattergrams and histograms in this Workspace, not just the current graph.

❑ Resolution—Specify the display resolution. You can select either high or low 
resolution.

❑ Quadrant statistics—Displays a quadrant on the graph after you click Apply or 
OK. For example:

Child to Parent Gate Inclusive Gating Exclusive Gating
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After creation, the quadrants can be dragged to any position. When data is 
scanned, the percentage of data in each quadrant will appear in the graph.

❑ 2-Parameter Histogram—2-parameter histograms, provide a method displaying 
a third (Z) parameter in the scattergram using color to represent the Z axis. If you 
select 2-Parameter Histogram, you can choose one of the following options:

❍ Density—Color codes the data according to how many events have been 
assigned to a given pixel. 

❍ Expression—Color codes the data according to the value of the expression 
you choose in the accompanying pulldown menus.

2-parameter histograms are described in greater detail in “About 2-Parameter 
Histograms,” below.
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About 2-Parameter Histograms 
2-parameter histograms display aggregated data based on two parameters. iCys uses a 
color scale to show the value of a particular bin.

A 2-parameter histogram displays in iCys, as shown below.

iCys generates a 2-parameter histogram file for every scan area of every scattergram 
for which expression or density histograms have been requested. 2-parameter 
histogram files can also be viewed from iBrowser.

➣ To generate 2-parameter histogram, check 2-Parameter Histogram. You can display 
your data in color in one of two ways, Density or Expression:

❑ Density—Color codes the data according to how many events have been assigned 
to a given pixel. The more events accumulated, the higher the color of that pixel 
will be on the scale. This allows you to visually assess the distribution of the data.

❑ Expression—Color codes the data according to the value of the expression you 
choose in the accompanying pulldown menus. You may choose, for example, 
Integral of Green fluorescence as an expression on a graph of scatter vs. long red 
fluorescence. Although the graph does not display green fluorescence as a 
parameter, those events with the most green fluorescence will show as a higher 
color on the scale.

For more information about 2-parameter histograms in iBrowser, see the iBrowser 
Data Integration Software User’s Guide.
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Setting Scattergram Regions
➣ To create a scattergram region, right click in any part of a scattergram to display the 
Scattergram menu. Note that several of the options are grayed out at this point.

Select the type of region you want to create:

❑ Create Rectangle—Allows you to define a rectangular scan area using the 
mouse. The mouse pointer changes from an arrow to a cross hair to indicate this 
mode. Note that you cannot change direction when creating the rectangle. That is, 
if you begin at the top left corner of the rectangle and move the cursor down and 
to the right, you can not then move up and to the left past the initial vertex.

❑ Create Polygon—Allows you to define a polygonal scan area using the mouse. 
The mouse pointer changes from an arrow to a cross hair to indicate this mode. 
Click to create the first vertex. Create additional vertices by moving the cursor to 
the next position (no need to hold the mouse button down) and left clicking. 
Finish the polygon with a right mouse click.

❑ Create Ellipse—Allows you to define a circular or elliptical scan area using the 
mouse. The mouse pointer changes from an arrow to a cross hair to indicate this 
mode. Note that there is a similar constraint on reversing direction as described 
above in Rectangle.

The figure below illustrates the three different region types: Rectangle (R1), 
Polygon (R2), and Ellipse (R3).
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Setting Region Attributes
Once you have created a region, you can set a number of attributes, including the size, 
color, and name. 

➣ To activate an existing region, click anywhere inside the region. Then, when you right-
click, many of the previously grayed-out selections on the scattergram menu are activated:

This section discusses the region attributes.

Adjusting Region Size
To adjust the size and position of an existing region, click anywhere inside a region to 
activate it:

❍ Click and drag anywhere inside an activated region to reposition it in the 
graph.

❍ Use the handles of an activated region to resize and reshape it. Drag on the 
handles in the corners to resize the entire region. Drag the handles between 
the corners to stretch the region vertically or horizontally.

The figure below is an activated polygonal region. You can reposition any of the 
vertices by dragging the appropriate handle.



Generating Analytical Data Creating and Changing Scattergrams

4-32  iCys Research Imaging Cytometer User Guide Revision B

Once you have created a region, you can set attributes for it.

Changing Region Color
Assigning color to a region allows you to identify the same population in several 
graphs.

➣ To set the color for a region:

1. Select the region for which you want to set the color.

2. Right-click to display the Region Attributes menu, and click on Color Region.

3. Select the color you want for that region. 

4. Click on the color. The color will change and be reflected in all graphs.

About Using Colors
The colors in the Color Region menu are shown in hierarchical order, from red to 
cyan. 

For example, let’s say you create two scattergrams using different criteria: one with a 
red region and the second with a yellow region. Where the datapoints do not overlap, 
the red and yellow regions are colored accordingly. However, if any datapoint does 
overlap, it takes on the color of highest precedence; which in this case, is red.

In the following example, the following regions are shown:

❑ R2—Red

❑ R4—Yellow
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❑ R5—Magenta

❑ R6—Cyan

Figure 4-2: Region Color Example

Note the following:

❑ In the first scattergram (S2), the datapoints that do not fall within the red region 
take their colors from the second scattergram (S8).

❑ In the second scattergram, the datapoints that coincide with R2 in the first 
scattergram are also red.

❑ In addition to coloring the regions within the scattergrams, any color added to a 
region is reflected in the histograms, as shown in Figure 4-2. Conversely, colored 
histogram regions, as discussed in “Changing Region Color” on page 4-42, will 
be reflected in the scattergrams.

❑ You can use colored regions to highlight events within the Field Image window. 
For example, using the colored regions described above, and with the Highlight 
feature ( ) selected, the Field Image window shows the region in which each 
event falls:
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❑ If you do not add color to a scattergram region, the histogram bars default to 
black.

Labeling Regions
Select Label Region to add a name to the region. The label displays in the Region 
Statistics window, as described in “Displaying Region Statistics” on page 4-18.

Using the Zoom Function
If you select Zoom Region, iCys generates a new scattergram that contains just the 
area within the region.Wherever possible, the new scattergram uses the same 
parameters as the original scattergram. In the following example, the original 
scattergram had Quadrant statistics set (as described in “Scattergram General Tab” 
on page 4-27). The new scattergram, therefore, also has them:

The zoom scattergram is a standard scattergram. You can create regions, zoom, and 
make any other changes to it.

Deleting a Region
To delete a region from a scattergram, click Delete Region.
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Viewing Cell Details
To find detailed information about each event within the region, click View Cells in 
Region. The View Events window displays:

From this window you can:

❑ View information about a single event.

❑ Locate and display an event in the Field Image View window.

❑ Locate and display another event in the Field Image window. 

The View Events window is described in this section. Locating events is described in 
detail in “Locating and Viewing Events in the Field Image Window” on page 4-45.

Title Bar Information
❑ Region number (in this case Region 1).

❑ Type of event (in this case Primary; the type of count depends on the scattergram 
Event Type—If the Event Type is Sub contour, the type of count will be the Sub 
contourname, where contourname is a subcountour specified as described in 
“Generating the Threshold Contour” on page 4-3).

❑ The count of events (in this case, 500).

Other Actions
The View Events window offers the following options:

❑ View Mode—Allows you to determine whether you are viewing events in the 
Field Image window in Scan mode, Observation mode or both. For more details 
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about modes for locating events, see “Locating and Viewing Events in the Field 
Image Window” on page 4-45. 

❍ Scan—When you move to events in Scan mode, the scan area may be 
rescanned and the event is displayed in the Field Image window. 

❍ Observation—When you move to events in Observation mode, the scan area 
may be rescanned, and you can use the eyepieces to view the event, but the 
event will not display in the Field Image window. If you are using the camera, 
the event will be displayed in the camera monitor. See “Locating and Viewing 
Events in the Field Image Window” on page 4-45 for more information.

❑ View—Opens the Field Image window (if it is not already open) and draws a red 
box around the selected event. For detailed information about locating events, see 
“Locating and Viewing Events in the Field Image Window” on page 4-45.

❑ Next—Moves to the next event in the window and locates that event in the Field 
Image window.

❑ Details—Opens the Event window, which displays detailed information about a 
single event:

 

The details of the Event window are described in “Event Window Details” below.

❑ Create Gallery—Creates a gallery of event images. For detailed information, see 
“Displaying Run Statistics” on page 4-16.

Event Window Details
The event window is divided into two or three sections, as described below:
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❑ The first section contains event features.

❑ The second section contains channel-specific event features:

❑ If you have generated any sub events, a third section displays a list of child events 
and their features for each sub component.

Other Scattergram Information
In addition to creating and manipulating regions, use the Scattergram menu to: 

❑ Clone—If you display the Scattergram menu when you do not have the cursor 
within a region, iCys will create a scattergram that is an exact copy of the selected 
scattergram.

❑ Clone For Rx—If you display the Scattergram menu when you do have the 
cursor within a region, iCys will create a scattergram that contains only the data 
from the selected region and is gated to the selected region, as discussed in 
“Scattergram and Histogram Event Type Tab” on page 4-26.

❑ Normalize XY—For XY graphs only—Tracks the XY coordinates for each active 
well. During a scan, if checked, causes iCys to normalize to the scanning well.

❑ Copy—Creates a snapshot image of the selected scattergram (in bitmap format) 
and saves it to the clipboard. You can then paste the image to another application.
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Creating and Changing Histograms
This section contains the following topics:

❑ Using the Graph Property Window, page 4-39

❑ Setting Histogram Regions, page 4-41

❑ Setting Region Attributes, page 4-41

❑ Viewing Cell Details, page 4-44

❑ Other Histogram Information, page 4-44

The default Workspace contains threes histograms. Histograms are graphs that allow 
you to view and save a wide variety of data during an iCys scan. Each line on a 
histogram represents a set of events that correspond to the attributes you have 
selected.

You can make changes to the existing histograms or add more histograms.

➣ To create a new histogram, select View ⇒ New Histogram from the menu bar or right-
click on the Workspace and select New Histogram.

Note: Scattergram and Histogram windows are numbered consecutively. 
Scattergrams have an S prefix, histograms have an H prefix.

A new histogram is added to your Workspace.
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Using the Graph Property Window
➣ To adjust the histogram, right-click on the histogram to open the Graph Property 
window. The Graph Property window contains three tabs:

❑ Axis Tab

❑ Event Type Tab

❑ General Tab

This section discusses the tabs in the Graph Property window.

Histogram Axis Tab
The Histogram Axis Tab allows to you define the X-Axis.The Histogram Axis Tab is 
exactly like the Scattergram Axis Tab with the exception that the Y-Axis is always 
Count and cannot be changed. For information about setting the Histogram Axis Tab, 
see “Scattergram and Histogram Axis Tab” on page 4-23.

Histogram Event Type Tab
This tab allows you to specify the events that will trigger a spot on the histogram.

The Histogram Event Type Tab is exactly like the Scattergram Event Type Tab. For 
information about setting the Histogram Event Type Tab, see “Scattergram and 
Histogram Event Type Tab” on page 4-26.

Histogram General Tab
The General tab allows you to set a number of miscellaneous parameters. The 
parameters available from this tab are:

❑ Title—Enter a title for this graph. The title appears at the top of the graph.

❑ # of channels displayed—Specify the resolution of the X-axis. You can specify 
either 200 or 500 channels. A “channel,” in this instance, is the number of 
divisions along the X-axis. The default is 200. 

When you specify 500, iCys displays the histogram in wide mode, as follows:

❑ Bin count—Specify the width of each datapoint in the bar graph. By default, the 
number of bins is equal to the number of channels, and each datapoint is one pixel 
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wide. When you change the number of bins, the bar width of each datapoint 
reflects the number of bins that will fit in each channel (that is, when both channel 
number and bin count are 200, the bar width is 1 pixel wide [200/200]). 

To change the number of bins, select a new bin count from the Bin count 
pulldown menu. For example, in a 500 channel histogram with a bin count of 100, 
the bar width for each datapoint is 5 pixels (500/100=5). 

The histogram appears as follows:

❑ Plot Style—Specify whether you want the histogram to show as a bar graph or as 
an outline graph. For example:

❑ Auto Y Scale—If selected, Auto Y Scale sets the top of the Y scale to the 
maximum number of counts per channel registered for this histogram during the 
scan. 

Bar Graph Outline Graph
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Setting Histogram Regions
➣ To create a histogram region:

1. Right click in any part of a histogram to display the Histogram menu. Note that 
several of the options are grayed out at this point.

2. Select Create Region and place your cursor in the histogram. Left-click and hold 
your mouse while pulling the cursor to the left. As you pull, the region is created. 
For histograms, the region always encompasses a section of the X axis, as shown:

Setting Region Attributes
Once you have created a region, you can set a number of attributes, including the 
width, color, and name. To activate an existing region, click anywhere inside the 
region. Then, when you right-click, many of the previously grayed-out selections on 
the histogram menu are activated:



Generating Analytical Data Creating and Changing Histograms

4-42  iCys Research Imaging Cytometer User Guide Revision B

This section discusses the region attributes.

Adjusting Region Size
➣ To adjust the size and position of an existing region, click anywhere inside a region to 
activate it:

❍ Click and drag anywhere inside an activated region to reposition it in the 
graph.

❍ Use the handles of an activated region to resize it. Drag on the handles to 
resize the entire region.

Once you have created a region, you can set attributes for it.

Changing Region Color
If you have multiple regions, you may want to add color to make it easier to 
differentiate. For example:

When you color the regions within the histograms, the color is reflected in the 
histograms. For example, the following histogram reflects data in Region 7 (green) 
and Region 8 (blue):
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If you do not add color to a histogram region, the histogram bars default to black.

For more information about using colors within histograms and scattergrams, see 
“About Using Colors” on page 4-32.

Labeling Regions
Select Label Region to add a name to the region. The label displays in the Region 
Statistics window, as described in “Displaying Region Statistics” on page 4-18.

Using the Zoom Function
If you select Zoom Region, iCys generates a new histogram that contains just the area 
within the region.Wherever possible, the new histogram uses the same parameters as 
the original histogram:
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The zoom histogram is a standard histogram. You can create regions, zoom, and make 
any other changes to it.

Deleting a Region
To delete a region from a histogram, click Delete Region.

Viewing Cell Details
As with scattergrams, click View Cells in Region to display the View Events 
window. For information about the View Events window, see “Viewing Cell Details” 
on page 4-35.

Locating events is described in detail in “Locating and Viewing Events in the Field 
Image Window” on page 4-45.

Other Histogram Information
In addition to creating and manipulating regions, you can use the Histogram menu to: 

❑ Clone—If you display the Histogram menu when you do not have the cursor 
within a region, iCys will create a histogram that is an exact copy of the selected 
histogram.

❑ Clone For Rx—If you display the Histogram menu when you do have the cursor 
within a region, iCys will create a histogram that contains only the data from the 
selected region and is gated to the selected region, as discussed in “Scattergram 
and Histogram Event Type Tab” on page 4-26.

❑ Normalize XY—For XY graphs only—Tracks the X coordinates for each well.
❑ Copy—Creates a snapshot image of the selected histogram (in bitmap format) and 

saves it to the clipboard. You can then paste the image to another application.
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Locating and Viewing Events in the Field Image Window
You can use the View Events window to locate and display events, by number, in the 
Field Image window or in an Observation Port (either the eyepieces or Color Camera 
Monitor) after data is acquired using any of the following scanning methods:

❑ Scan & Save

❑ Test Scan

❑ Play or Next in the Field Image window during a scan

When you locate an event in the View Events window, iCys highlights the event in the 
Field Image window by drawing a cross at its center.

When you select a new event from the View Events window, iCys moves the stage to 
the new event (if appropriate), and changes the display in the Field Image window.

There are a number of scenarios for locating and viewing events, depending on 
whether you are working with live data or existing run data. This section describes 
each scenario.

Locating and Viewing Events using Live Data
Immediately after a scan, but before you have saved your data into a Raw file, 
you can locate (and rescan) events using “Live Data,” that is, the samples in 
the carrier currently on the microscope stage. You can locate events using live 
data either immediately after iCys has acquired data during either a Test Scan 
or Scan & Save run or when you have the Event data available and the sample 
on the microscope stage.
When using live data, you can locate and view scan images of event directly from the 
data or from an Event file.
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➣ To locate events immediately after a scan:

1. If you have a run open, iCys uses the event data of that run. If you do not have a 
run open, iCys uses the data that is currently stored in memory.

2. Use Select Active Well in the Carrier window, as described in Table 3-1, 
“Microplate Scan Area Setup Window,” on page 3-18 or Table 3-2, “Freeform 
Scan Area Setup Window,” on page 3-24, to determine which set(s) of data you 
want to activate. 

3. Right-click on the region of interest and select View Cells in Region to open the 
View Events window and select the event you want to view, as described in 
“Viewing Cell Details” on page 4-35.

4. You can choose to view the selected event in the Field Image window, directly 
with the eyepieces, with the camera, or in any combination of the three. 

❍ To view the event in the Field Image window, select Scan from the View 
Mode box in the View Events window. 

❍ To view the event using the eyepieces, camera, or both, select Observation. 

❍ To view the event in the Field Image window and with the eyepieces, camera, 
or both, select both Scan and Observation.

Tip:  If the View Mode is set to Scan, the microscope Light Path Selector lever 
must be in the Side Port position ( ), as described in “iCys Microscope 
Components” on page 2-13.   
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5. Click on the row of the event of interest (or default to the first event), then click 
View to acquire the image of the highlighted event. iCys locates the image as 
follows:

❍ If Field Image is selected:

✧ The stage moves to the start of the scan field that contains the event of 
interest.

✧ iCys moves the microscope objective to the focus position used during the 
original scan.

✧ The scan field is rescanned using the setup from the original scan (number 
of lasers, PMTs, and so on). 

✧ The event is displayed and highlighted by a red box in the Field Image 
window. 

❍ If both Scan and Observation are selected:

✧ After the appropriate scan field is rescanned, the stage moves so the event 
of interests is in the middle of the field of view through the eyepieces or 
color camera monitor. 

✧ iCys moves the microscope objective to the focus position used during the 
original scan.

✧ To view the event through the eyepieces or camera monitor, turn the Light 
Path Selector Lever to the Observation position ( ). 

❍ If Observation is selected, the event is not rescanned.The following steps 
occur:

✧ The stage moves so the event of interests is in the middle of the field of 
view through the eyepieces or color camera monitor.

✧ iCys moves the microscope objective to the focus position used during the 
original scan.

Note: When Observation is selected, iCys will turn the Brightfield on for 
viewing. Brightfield will be turned off when viewing an event with 
observation unchecked, or when closing the View Events window.

In Observation-only mode, the event is not displayed in iCys. 

If Observation-only is selected, make sure the Light Path Selector lever is 
also in the Observation ( ) position.

Note: To locate an event for which the Time value (in the View Events window) 
is different from the previous event’s value, and Scan is selected (with or 
without Observation), make sure the Light Path Selector lever is set to the 
Side Port position before selecting Next or View. This is required because 
the newly selected event is in a different scan area and will be rescanned.
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If your system does not have AutoFocus, you will need to adjust the focus 
by the appropriate offsets for the current action (Scan and/or 
Observation).

Locating and Viewing Events using Saved Data
When you are locating events in runs that have already been saved, you can use the 
previously saved data. 

1. Open a run, selecting “Analyze Events.”

2. When the run is open, use Select Active Well in the Carrier window, as described 
in Table 3-1, “Microplate Scan Area Setup Window,” on page 3-18 or Table 3-2, 
“Freeform Scan Area Setup Window,” on page 3-24, to determine which set(s) of 
data you want to activate. 

3. Right-click on the region of interest and select View Cells in Region to open the 
View Events window and select the event you want to view, as described in 
“Viewing Cell Details” on page 4-35.

4. You can choose to view the selected event in the Field Image window, directly 
with the eyepieces, with the camera, or in any combination of the three. 

❍ To view the event in the Field Image window, select Scan from the View 
Mode box in the View Events window. 

❍ To view the event using eyepieces, camera, or both select Observation. 

❍ To view the event in the Field Image window and with the eyepieces, camera, 
or both, select both Scan and Observation.

5. Click on the row of the event of interest (or default to the first event), then click 
View to acquire the image of the highlighted event. iCys locates the image as 
follows:

❍ If Field Image is selected, the .jpg image of field that contains the event of 
interest is displayed in the Field Image window. The live sample is not used 
(no stage or microscope objective movement required). 

❍ If both Scan and Observation are selected:

✧ The stage moves so the event of interests is in the middle of the field of 
view through the eyepieces or color camera monitor. 

✧ If your system has AutoFocus, iCys moves the microscope objective to 
the focus position used during the original scan. If your system does not 
have AutoFocus, you will need to manually focus the objective on the 
event of interest.

✧ To view the event through the eyepieces or camera monitor, turn the Light 
Path Selector Lever to the Observation position ( ). 

❍ If Observation is selected:
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✧ The stage moves so the event of interests is in the middle of the field of 
view through the eyepieces or color camera monitor.

✧ If your system has AutoFocus, iCys moves the microscope objective to 
the focus position used during the original scan. If your system does not 
have AutoFocus, you will need to manually focus the objective on the 
event of interest.

Note: In Observation-only mode, the event is not displayed in iCys. 

r
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General Installation Information
Installing iCys™ Research  Imaging Cytometer requires the following:

❑ Sufficient space to accommodate the physical iCys equipment

❑ Proper electrical power configuration and receptacles 

❑ Acceptable environmental conditions

Note: iCys needs a vibration-free bench top. (Shock mounting is not required.)

Unpacking the iCys System
The iCys should be unpacked and installed only by a representative from CompuCyte 
or an authorized agent. If the system is to be stored temporarily before installation, it 
should be in a secure, heated, and dry area.

Upon receipt of the iCys, examine the shipping materials for exterior damage or 
evidence of mishandling. If they appear damaged, notify the carrier and CompuCyte 
or an authorized agent and request an inspection from the carrier.

Following initial installation, a representative from CompuCyte Corporation or an 
authorized agent will instruct designated personnel on the basic operation and care of 
the iCys.

Physical Space Requirements
The following table specifies the iCys’s space requirements:

Table A-1: iCys Physical Space Requirements

Analysis Unit ❑ Width 44 in. (112 cm)
❑ Depth 32 in. (82 cm)
❑ Height 31 in. (79 cm)

To allow for servicing, the space above the table surface 
should be at least 44 inches or (112 cm)

❑ Weight 275 lbs. (125 kg.)

Computer ❑ Width 8 in. (21 cm)
❑ Depth 19 in. (49 cm)
❑ Height 17 in. (44 cm)

Monitor ❑ 20” Flat panel display monitor 
20” (51cm) wide, 12” (31cm) depth, 20” (51cm) height

❑ Dual monitors are optional

Autofocus 
monitor (if 
installed)

❑ Width 9 in. (23 cm)
❑ Depth 10 in. (26 cm)
❑ Height 9 in. (23 cm)
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Electrical Requirements

Specifications
The table below lists the power requirements for the iCys system.

Autofocus 
Control unit (if 
AutoFocus 
installed)

❑ Width 14 in. (36 cm)
❑ Depth 11 in. (27 cm)
❑ Height 4 in. (10 cm)

Laser cooling 
fan

❑ Width 9 in. (23 cm)
❑ Depth 9 in. (23 cm)
❑ Height 9 in. (23 cm)
Laser cooling fan can be placed up to 6 ft. (1.85m) from the 
Analysis Unit. For isolation from vibration, do not place 
laser cooling fan on the same table as the Analysis Unit.)

Laser power 
supply

❑ Width 9 in. (23 cm)
❑ Depth 12 in. (31 cm)
❑ Height 6 in. (16 cm)
Laser power supply can be placed up to 6 ft. (1.85m) from 
the Analysis Unit. For isolation from vibration, do not place 
laser power supply on the same table as the Analysis Unit.)

Color camera ❑ Width 2.5 in. (6 cm)
❑ Depth 2 in. (5 cm)
❑ Height 7 in. (18 cm)

Camera 
monitor

❑ Width 17 in. (43 cm)
❑ Depth 17 in. (42 cm)
❑ Height 21 in. (53 cm)

Brightfield 
power supply

❑ Width 3 in. (8 cm)
❑ Depth 8.5 in. (22 cm)
❑ Height 5 in. (13 cm)

EpiFluorescence 
power supply (if 
installed)

❑ Width 5 in. (13 cm)
❑ Depth 11.5 in (30 cm)
❑ Height 7 in. (18 cm)

Table A-1: iCys Physical Space Requirements (Continued)

Table A-2: iCys Power Requirements

Component Voltage Current Frequency

Cytometer 120VAC
or 230VAC

16 A
10 A

60 Hz
50 Hz
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Note: External protective conductor must be at least equal to supply wires in 
ampacity.

The system must be connected to a dedicated circuit with an adequate 
circuit breaker.

Input Power Controls
The main power switch for the iCys cytometer is located on the left side panel of the 
instrument. In the “I” position this switch applies AC input power to the instrument 
and provides AC power to the auxiliary outlets located on the left and right side of the 
instrument. The figure illustrates the iCys power entry panel

Power to the laser power supply, which is located external to the instrument, is 
activated through a keyed switch located on the laser power supply. Power for the 
computer and monitor is located on the front of the computer and monitor.

Computer 115/220 VAC 10/5 A 50/60 Hz

Flat screen monitor 110-120/220-240 VAC 0.7/0.3 A 50/60 Hz

Remote Control unit (if 
AutoFocus installed)

110/240 VAC 2 A 50/60 Hz

Autofocus monitor (if 
AutoFocus installed)

120 VAC
or 230VAC

.3 A

.2 A
50/60 Hz
50/60 Hz

Table A-2: iCys Power Requirements (Continued)

I

0

For laser power only

Laser
Power

Main
Power

Main power connector

Main power switch
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Figure A-1: iCys Selected Hardware Components

Optics/electronics Automated stage Monitor

MonitorCamera and
focus monitors,

Microscope, brightfield source,
EpiFluorescence, camera,
and automated stage

Optics/Electronics

Remote Control unit
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Typical Installation Setups

Figure A-2: Installation Setup, Rear View

❑ Standard tower case computer may be placed on or beneath the table.

❑ Air hose attaches at either the back (shown in figure) or the left side of the 
instrument.

❑ If your system uses the optional AutoFocus feature, the AutoFocus monitor and 
controller may be installed on the table or within ~6 ft. (2m) of the cytometer. 

Air hose attachment

Argon ion laser cooling fan

Argon ion laser power supply

Panel for alternate
air hose mounting



Appendix B

Using the iNovator Toolkit

The iNovator Application Development Toolkit allows you to extend the 
capabilities of the basic iCys. The iNovator extends the module-based, graphical 
protocol development tools found in the basic iCys to allow the user considerable 
more flexibility and power. The iNovator provides additional modules to allow image 
filtering, Boolean and arithmetic operations on images, Mosaic scanning and multi-
scale scanning.

Included in this chapter:

❑ iNovator-specific Templates, B-2

❑ References to Using the Protocol Menu Bar and to Building and Modifying 
Protocols, B-7

❑ iNovator-specific Protocol Modules, B-8

❑ Using the Protocol Menu View Image Feature with iNovator, B-28

❑ Multi-scale Scanning, B-30
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iNovator-specific Templates
The iNovator provides additional templates not available in the basic iCys as shown in 
the New Run dialogue below.

These iNovator specific templates are:

[5] Two Primaries,
[6] Mosaic Scan,
[7] Interactive Tissue Scan and
[8] Automated Tissue Scan

These templates are described below.

Note: Templates cannot be overwritten. If you wish to make changes to them, 
you must use the Save as option to create a new file.

[5] Two Primaries
The Two Primaries template contains a Protocol tab and a blank Data tab. The default 
carrier is a 96 well plate. The protocol is shown below.
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This protocol defines two primary event components that are generated based on 
independent contouring criteria. This is similar to the Primary-Sub protocol templates 
(see pages 3-12 to 3-14) but the two components are not associated. This template 
may be expanded to multiple independent primary event components.

[6] Mosaic Scan
The Mosaic Scan template contains a Protocol tab; an Image tab with the carrier 
window and Well, Region and Field image windows; and a Data tab with the carrier 
window. The default carrier is a 4 slide carrier. The protocol is shown below.
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This protocol is similar to the One Primary protocol except that it uses a Mosaic Scan 
instead of a Field Scan. Use this template if you want to contour on large events that 
cross scan fields.

[7] Interactive Tissue Scan
The Interactive Tissue Scan template contains a Protocol tab; an Image tab with the 
carrier window and Well, Region and Field image windows; and a Data tab with the 
carrier window. The default carrier is a 4 slide carrier. The protocol is shown below.
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This protocol is designed for multi-scale scans. The 1st scale scan on the left is a 
Mosaic Scan that is set to run at low resolution to scout for tissue sections or other 
large events. The Scan Area Event module generates event data as well as Dynamic 
Scan Areas that are used as the scan areas for the subsequent Field Scan (on the right.) 
The bridge between the two Scan modules is set to Pause, indicating that the iCys will 
pause to allow the user to review the Dynamic Scan Areas prior to initiating the 2nd 
scale Field Scan. For more information on multi-scale scans see the section entitled 
“Multi-scale Scanning” on page B-30. 

[8] Automated Tissue Scan
The Automated Tissue Scan template is identical to the Interactive Tissue Scan 
template except that the bridge between the two Scan modules is not set to Pause. In 
this mode the 2nd scale Field Scan will proceed automatically directly after the 
completion of the 1st scale Mosaic Scan. Use this template for fully automated 
analyses when the first and second scales use the same objective lens. For a more 
information on multi-scale scans see the section entitled “Multi-scale Scanning” on 
page B-30. 
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References to Using the Protocol Menu Bar and to Building 
and Modifying Protocols

Using the Protocol Menu Bar 
Information on utilizing the Protocol menu tool bar and its features may be found in 
the section entitled “Protocol Menu Bar” beginning on page 3-30. Unique iNovator 
features of the View Image tool in the Protocol menu are described below in the 
section entitled “Using the Protocol Menu View Image Feature with iNovator” on 
page B-28. 

Building and Modifying Protocols 
Information on creating and modifying Protocols may be found in the sections entitled 
“Creating a New Protocol” beginning on page 3-35 and “Connecting Modules” 
beginning on page 3-59.
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iNovator-specific Protocol Modules
The iNovator toolkit provides you with a variety of protocol modules not found in the 
basic iCys. Each module’s function and available parameters are explained below. The 
module descriptions are organized by the category in which they are found in the 
protocol tool box.

Scan

Mosaic Scan Module
The MosaicScan module is similar to the Field Scan module (see page 3-49) with 
some exceptions as described here. The MosaicScan module stitches together all of 
the scan fields within a given Scan Area prior to segmenting events, developing event 
features and displaying data for that scan field. This allows the MosaicScan to 
segment events (or draw phantom contours) that cross scan field boundaries. 
MosaicScan also reformats the data to provide a 1:1 aspect ratio of the X:Y resolution. 

❑ General Tab—Under the General tab you can specify the objective you are using, 
the X-step size for the scan, and the field size as shown below: 

❍ Objective—Allows you to select which microscope objective lens you will 
use for this scale of the run. When not actively scanning, the objective is 
moved out of the way of the motorized stage to prevent a carrier from being 
bumped by the objective.

❍ X Step size—Determines the size of a single stage step in the X direction. 
From the X Step pull-down, select any value from .5µm to 20µm (in .5µm 
steps). For a low-resolution scan, select 20µm, the default value.

❍ Field size—Determines the number of X steps that iCys will take when 
scanning. You can choose a percentage (100%, 50%, or 25%) or choose to 
generate a square scan field. The scan field and pixel size are determined by 
the dimensions you select and are displayed in the Scan field dimension 
window below. A 100% scan field is 1000 scan lines wide, a 50 % one is 500 
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scan lines wide, and so on. A square scan field is 768 scan lines wide (because 
the Y dimension is always 768 pixels tall.)

❍ Scan field dimension—Displays the size of each pixel based on the 
parameters you have selected.

❑ Advanced Tab—When the Advanced tab is selected the following options 
appear.

❍ Scan mode—Describes the current scan mode (Virtual, Live, Bypass)

✧ Live—In this mode the Mosaic Scan acquires new data by scanning the 
sample.

✧ Virtual—In this mode the Mosaic Scan re-contours the saved data.

✧ Bypass—In this mode the Mosaic Scan in the first scale is by-passed and 
the user may perform a virtual second scale scan.

For more information on scan modes see the section entitled “Analysis Modes 
for Multi-scale Scans” on page B-34. 

❍ Correct Pixels—Checking this option enables a correction that accounts for 
variations in collection efficiency along the scan line. This is performed on 
each of the images as they are acquired. See also “Correct Pixels” on 
page 3-50.

❍ Sampling mode—When generating the Mosaic images, iCys combines pixels 
from the individual Scan Fields to generate the 1:1 aspect ratio needed in the 
Mosaic image. There are three selections for the algorithm that iCys may use 
to calculate the resultant pixel value in the Mosaic image. These are:

✧ Single—iCys uses the first pixel in the sampling bin.

✧ Average—iCys uses the average value of the pixels in the sampling bin.

✧ MaxPixel—iCys uses the pixel in the sampling bin with the maximum 
value.
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Output

Processed Image
The Processed Image module allows you to view an image at some intermediate stage 
of processing in the protocol. In the Protocol below, a Processed Image is

defined to display the output image from the Filter module. This image is viewable in 
the View Image window (see “Using the Protocol Menu View Image Feature with 
iNovator” on page B-28) as well as the Field, Well and Region image windows, and in 
Galleries.

When the Processed Image module is selected the following options appear.

❑ Title—Specify a name for this image. In the example above the Processed Images 
have been named to reflect their respective input modules.
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❑ Color—Set CompuColor for the Processed Image. Note that the CompuColor 
processed images do not appear in Galleries. Also, they are not saved with the 
Well, Region and Gallery images.

Image View
The Image View module is similar in function to the Processed Image module except 
that its output image is displayed in a separate window. This window opens at the start 
of the scan if an Image View module is part of the protocol. A separate CompuColor 
cannot be assigned to this image. 

Filter Modules
Filter modules allow you to apply filtering to images. You can use the filter modules 
to enhance the quality of an image or to emphasize characteristics of interest within 
one or more images. 

Tip: For detailed information about image processing and filtering, you may 
want to use a resource such as The Image Processing Handbook, 2nd 
Edition; Russ, John C.; CRC Press; 1995.

Image Filtering—the Filter Module
Performs filter operations on the input image.

For comparison purposes, the image shown in Figure B-1 has no filtering.

Figure B-1: Unfiltered Image
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➣ To set a filter:

1. Click on the Filter module. The Filter dialog box displays:

2. Select the filter you want to use and for most filters, the resolution. The filters are:

❍ HiGauss 5x5, 7x7, or 9x9—The Gauss filter performs a weighted sum 
(center pixel = highest weight). The result is normalized by the total kernel 
weight. 

Figure B-2: HiGauss 5x5 Image

❍ HiPass 3x3, 5x5, or 7x7—This filter sharpens edges and enhances detail. 
This filter magnifies gradients along edges in any direction. The higher 
numbers produce more extreme magnification.
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Figure B-3: HiPass 3x3 Image

❍ HorizontalEdge 3x3, 5x5, or 7x7—This filter highlights horizontal edges 
(gradients) within the image. All pixels not part of horizontal gradients are 
changed to black; all edges become white. 

Figure B-4: HorizontalEdge 7x7 Image

❍ LaPlace 3x3, 5x5, or 7x7—This filter weights the difference between the 
center pixel and its neighbors.
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Figure B-5: LaPlace 7x7 Image

❍ LoPass 3x3, 5x5, or 7x7—For the LoPass filter, all pixels included in the 
filter’s size are added up, and the result is divided by the number of pixels. 

Figure B-6: LoPass 7x7 Image

❍ VerticalEdge 3x3, 5x5, or 7x7—This filter highlights vertical edges 
(gradients) within the image. Pixels that are not identified as part of a gradient 
are set to black.



Revision B iCys Research Imaging Cytometer User Guide  B-15

May 6, 2005 Using the iNovator™ Toolkit

Figure B-7: VerticalEdge 5x5 Image

❍ Fish—The Fish filter is not currently functional in iCys.

3. Specify the number of operations you want to perform. You can select between 1 
and 5 passes.

Binary Image Filtering—Erode, Dilate, Open, Close Modules
The Erode, Dilate, Open, and Close modules all morphologically change the image. 
The input image must be binary. 

Tip: To create a binary image, call the Threshold module before calling a 
morphological filtering module. Threshold produces binary output.

The morphological change modules are:

❑ Erode—Performs morphological erosion of the image. Erosion is the process of 
turning off (setting to zero) pixels at the perimeter of a cluster of pixels, thus 
reducing the size of each pixel cluster. This eliminates very small clusters and can 
separate multiple clusters that are barely "touching."
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Figure B-8: Erode

❑ Dilate—Performs morphological dilation on the image. Dilation is the opposite of 
erosion. It turns on pixels at the perimeter of a cluster of pixels thus increasing the 
size of each pixel cluster. It may be used to close "holes" within a pixel cluster.

Figure B-9: Dilate

❑ Open—Performs morphological open on the image. Open is erosion followed by 
dilation. The Open operation may be used to open the spaces between pixel 
clusters or eliminate small clusters and then return the remaining clusters back to 
their original size.
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Figure B-10: Open

❑ Close—Performs morphological close on the image. Close is dilation followed by 
erosion.Closing, as the opposite process of opening, tends to close up the spaces 
between closely spaced events.

Figure B-11: Close
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➣ To perform a morphological erode, dilate, open or close:

1. Click to open the module. For all of these functions, a similar dialog box displays.

2. In the Structuring Element panel, specify the shape and size of the kernel you 
want to morph.

Watershed Module
The Watershed module performs watershed segmentation. Watershed segmentation is 
a process of using erosion and dilation (discussed in “Binary Image Filtering—Erode, 
Dilate, Open, Close Modules” on page B-15) on a Euclidean distance map to separate 
closely spaced or overlapping events. A grayscale image is generated from the binary 
image using a Euclidean distance map technique. A grayscale pixel value is generated 
for the positive pixels based on the distance of that pixel from the nearest background 
pixel. Localized peaks (called Ultimate Eroded Points or UEPs) are identified and the 
image eroded back to these UEPs. The image is then dilated until the positive pixels 
meet the original background boundary or until a second, dilating UEP is encountered. 
The dilation is stopped short of joining the UEPs, thus developing the intended 
separation. Various parameters may be set by the user to affect how this process 
proceeds.

Tip: To create a binary image for input to the Watershed module, call the 
Threshold module before calling the filtering module. The Threshold 
module produces binary output.

Figure B-12 shows a different image after watershed segmentation.
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Figure B-12: Watershed 

1. Click to open the module. The Watershed dialog box displays.

2. Set the Sensitivity, which determines the aggressiveness of the segmentation by 
affecting the size of minimum allowable peak value of the UEP. Higher sensitivity 
causes more aggressive splitting. The maximum value is 1, a typical value is 0.95. 
The iCys default value is 0.97.

3. Set the Ridge Length. The ridge length determines how to treat the space between 
two Ultimate Eroded Points (UEPs). A UEP is a point at the center of an object. 

❍ Minimum—If the distance between two UEPs is less than the specified 
value, two points are combined into one object.

A higher minimum ridge length causes more aggressive splitting.

❍ Maximum—If the distance between two UEPs is larger than the specified 
value, two points are considered to be separate objects.

A smaller maximum ridge length causes more aggressive splitting.



Using the iNovator™ Toolkit iNovator-specific Protocol Modules

B-20  iCys Research Imaging Cytometer User Guide Revision B

❍ Create new image—If Create new image is selected, a new image is created 
and the original input images are left intact.

❍ Modify input image—If Modify input image is selected, the input image is 
updated with the new image data.

Operation

Arithmetic operators

Add and Subtract Modules 
The Add and Subtract modules perform these operations on two input images to 
generate a third image. The resultant image is constructed by either adding or 
subtracting the values of each of the corresponding pixel values from the input 
images. In the case of the Subtract module the right image is subtracted from the left 
image. A protocol using the add module is shown below.

The Add and Subtract modules can be "nested" as shown below.
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iCys only reports pixel values between 0 and 16383. The number 16383 is the 14-bit 
saturation level of any measured signal. Addition of pixel values that result in values 
higher that 16383 are reported as 16383. Subtractions that result in values lower that 0 
are reported as 0.

Invert Module
The Invert module inverts the pixel values of the input image according to the 
following formula: 16383 – input value = output value. Thus saturated values of 
16383 become zero and zero values become 16383. An intermediate value of 12383 
becomes inverted to 4000. Note that the connector color of the Invert module is dark 
blue meaning that the input image may be either an Analog or a Binary image. An 
analog input produces an analog output; a binary input produces a binary output.

The parameters available to these modules are described under Boolean operator 
modules below. 

Boolean operators
The Boolean operator modules, AND, OR and XOR (exclusive OR) allow you to 
combine two binary images to result in a third binary image. A binary image has been 
thresholded. When the threshold function is applied to images in the protocol, all of 
the pixels below the threshold value are set to zero. All of the pixels at or above the 
threshold value are set to 16383. The result is a purely black and white image with no 
gray.

The result of each Boolean operation is explained below.
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And
The And module performs a Boolean AND on the two input images. A Boolean AND 
will yield the results shown below.

Or
The Or module performs a Boolean OR on the two input images. A Boolean OR will 
yield the results shown below..

Xor 
The Xor module performs a Boolean XOR (Exclusive Or) on the two input images. A 
Boolean XOR (Exclusive Or) will yield the results shown below..

When any Boolean or arithmetic operator module is selected you are given a choice 
between creating a new image and modifying the left image. For example, when the 
Xor operator module is selected, the following options appear.

Input 1
pixel value

Input 2 
pixel value

Output 
pixel value

0 0 0

0 16383 0

16383 0 0

16383 16383 16383

Input 1
pixel value

Input 2 
pixel value

Output 
pixel value

0 0 0

0 16383 16383

16383 0 16383

16383 16383 16383

Input 1
pixel value

Input 2 
pixel value

Output 
pixel value

0 0 0

0 16383 16383

16383 0 16383

16383 16383 0
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❑ Create new image—If Create new image is selected, a new image is created and 
the original input images are left intact. 

❑ Modify left image—If Modify left image is selected, the left input image is 
updated with the new image data.

Bright Contrast Module
The Bright Contrast module allows you to manipulate the Brightness and Contrast of 
the image. Its function is identical to that of the BrightContrast feature of the image 
right-click menu described on page 3-72.

Whereas the BrightContrast feature of the image right-click menu only affects the 
displayed image, the Bright Contrast module may be used to alter an image in the 
protocol and aid in contouring. Altering the image contrast may make it easier in some 
images to better determine the optimum threshold value. Although selecting the 
Binary button makes the Bright Contrast module behave like the Threshold module, 
the Binary mode should only be used for visualization purposes. Once a threshold 
value has been selected, input this value into the Threshold module and deselect 
Binary in the Bright Contrast module.

Selecting the Bright Contrast module displays the following options, similar to the 
BrightContrast feature dialogue in the image view (see page 3-72).
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Event

Scan Area Event
The Scan Area Event module is used only in the first scale of a two-scale scan. It 
generates two important outputs: events and Dynamic Scan Areas. 

The event output is similar to that of the event module. The output of a contour 
module provides input and this module produces events for that component. Those 
events may be treated as any other event.

The second output, Dynamic Scan Areas, are scan areas that are subsequently scanned 
in the second scale scan. For a description of two-scale scanning and how this module 
is utilized as a part of that process see the section entitled “Multi-scale Scanning” on 
page B-30.

When the Scan Area Event module is selected the following options appear.
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There are three options for generating dynamic scan areas and events: Whole section, 
Rectangle and Random.

❑ Whole section—generates a contour that meets the segmentation criteria in the 
protocol around the entire event. This contour becomes the event boundary and 
the dynamic scan area boundary. 

❑ Rectangle—generates a contour around the entire event as above. iCys then 
generates a rectangular scan area within this Whole section contour, centered on 
the centroid of the Whole section contour.

❑ Random—generates a contour around the entire event as above. iCys then 
generates a specified number rectangular scan areas placed randomly within the 
Whole section contour. This is pictured below for a Tissue Micro-Array element. 

Additional Parameters are:

❑ Component name—Specify the name of the component (as in the Event module, 
see page 3-56.)

❑ Size—If either Rectangle or Random is selected, the Height and Width of the 
rectangle must be specified in microns.

❑ Count—If Random is selected the number of scan areas to be generated within 
each threshold contour is specified.

❑ Color—The color of the contour line is specified.

❑ Show event name—Checking this option displays the event ID number (or 
ordered pair if the Array Alignment module is used.)
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Pictured below, on the same Tissue Micro-Array element, are the three types of 
dynamically generated scan areas (outlined in yellow). The numbers shown are the 
event IDs generated by the Show event name option.

Multi-Scale Association
The Multi-Scale Association module is analogous to the Association module as 
described on page 3-58 except that it operates across first and second scale scans 
whereas the Association module operates within first or second scale scans (or single 
scale scans.) This is illustrated in Tutorial Exercise 4 where the second scale event 
component is associated with the first scale Tissue component. There are no 
parameters for the Multi-Scale Association module.

Array Alignment
The Array Alignment module is typically used when doing a low resolution scout scan 
to identify the elements of a Tissue Micro-Array. The module identifies the contoured 
events for the component to which it is attached, as an ordered pair of numbers. This 
ordered pair represents the Column and Row for the element within the larger array. 
This is pictured below.

Whole section 
dynamic scan area

Rectangular dynamic scan area
—placed at centroid of element

Random dynamic scan area
—three scan areas specified
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Parameters available are:

❑ Max misalignment X & Y—The distance between centers of elements for which 
adjacent elements are considered to be in the same row or column (relative to the 
average X or Y dimension.) For example: a 50% X value means that adjacent 
tissue elements of 2 mm average size are considered to be in the same column if 
the X value of their centers are no more than 1 mm apart.

Use a higher value if elements are not parallel to the X-Y axes and are far apart. 
Use a lower value if elements are close together and parallel to the X-Y axes.
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Using the Protocol Menu View Image Feature with iNovator
In the basic iCys, the View Image feature (accessible by the  icon in the Protocol 
main menu) allows the user to interactively set the Threshold. It may also be used in 
the iNovator to interactively set any of these image processing tools:

All Filter modules

❑ Filter

❑ Erode

❑ Dilate

❑ Open

❑ Close

❑ Watershed

All Operation modules

❑ Add and Subtract

❑ Invert

❑ And

❑ Or

❑ Xor

❑ Bright Contrast

Selected Contour modules

❑ Channel

❑ Threshold

To utilize the View Image window: With an image or set of images in memory, such as 
during or after a Test Scan, select one of the image processing modules listed above, 
that is in your defined protocol. Then select the View Image icon  from the 
Protocol main menu bar. The output of the selected module will display in the View 
Image window. To interactively adjust the module, select a different setting and, if 
available, select the Test button. To view the result of a modification in one module, 
on the output of a downstream module, select the downstream module of interest and 

then select the Refresh icon  from the Protocol main menu bar.

The figures below show View image window displaying the results of the threshold 
module and of the Open module.
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Multi-scale Scanning

Introduction 
Multi-scale scanning involves defining a protocol for two sequential scans referred to 
as scales (because they are usually done at different resolutions). Typically, the first 
scale is done using the Mosaic Scan module at low resolution. This is referred to as a 
scout scan because it is scouting for relatively large structures such as tissue 
microarray elements, tissue sections, structures within tissue sections or cell colonies. 
Events found in this scout scan may be designated Scan Area Events. These scan area 
events become the defined scan areas for the second scale, typically higher resolution 
scan. Such a scan is defined in Tutorial 4, the protocol of which is shown below. 

Unique Features

Different Detector Module Settings
The two scales' Detector module settings are independent of one another. Data 
channels, virtual channels, detector gain and offset, laser selection and (if applicable) 
laser power may be independently selected and set for each scale. This allows the user 
to set up the system for the very different scan requirements of scout vs. high 
resolution scans.

Different Scan Module Settings
The scan module settings are at the heart of defining the operation of each of the two 
scales. As was mentioned, the first scale is a Mosaic Scan, typically at low resolution 
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to find areas of interest for more detailed analysis. For example, a slide will be scouted 
to identify the locations of tissue samples. When identified, each tissue can then be 
analyzed in detail using a higher resolution Field Scan or Mosaic Scan.

The settings required to locate tissue on a slide may be quite different from the 
settings for analyzing the structure within those tissues. Therefore, one might define a 
Mosaic Scan with a 10X objective and 20 micron steps to be followed by a Field Scan 
with a 40X objective and .5 micron steps. 

Scan Area Events and Other Events
Multiple event components may be defined in either the first or second scale scan. 
Such a protocol is shown below. One of these event components must be designated a 
Scan Area Event. The Scan Area Event module generates event data as any other 
event component but additionally the Scan Area Event contours are used as scan areas 
for the second scale scan. These scan areas, generated from Scan Area Events, are 
called Dynamic Scan Areas.

Manipulating Dynamic Scan Areas
While in the Pause state between scans, you may manipulate the Dynamic Scan Areas 
(DSAs) generated by the 1st scale scan or create new DSAs manually. When the 
system is Paused between the 1st and 2nd scale scan, the bridge between Scan 
modules will appear as shown below, pink and with the word Paused visible.

For more information about getting to a paused state, see “Analysis Modes for Multi-
scale Scans” on page B-34.

To manipulate an existing DSA, click on the DSA of interest. "Handles" will appear at 
the four corners of the DSA as shown below for the TMA element in the upper left of 
the image.
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The DSA may now be moved by dragging it with the mouse, or it may be deleted 
using the delete key.

To manually add a DSA, use the create region tool (  ) in the Well Image 
tool bar.

Rectangle and Ellipse allow you to draw DSAs of those shapes anywhere in the Well 
image. Freeform let's draw a freeform shape by dragging the cursor to define the 
desired contour. Custom allows you to define a shape of a specified size and place 
copies of it wherever you would like. In this way, many DSAs of identical size and 
shape may be added to an image. Define the custom shape by selecting Define 
Custom and use the Define Custom Region dialogue box.
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To manually add a DSA, select the desired shape from the pull-down menu and then 
select the tool, by clicking on the button. In the graphic below, the lower right DSA 
has been deleted and replaced with a manually added, elliptical DSA. The manually 
added DSAs may be resized by dragging the contour handles. Note that the DSA is 
numbered by the ArrayScan module based on its position relative to the other modules 
and the criteria defined in the ArrayScan module parameters. The entire array is 
renumbered, if necessary when new DSAs are added or deleted.
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Image Hierarchy
The first scale Mosaic Scan image is displayed in the Well Image window. As the 
second scale Field Scan progresses a mosaic image of each Dynamic Scan Area is 
displayed in the Region Image window. Each scan field image is displayed in the Field 
Image window.

From the Well Image, clicking on a particular Scan Area Event will display that event 
in the Region image window. Similarly, clicking on a particular scan field location in 
the Region Image will display that scan field in the Field Image window.

Analysis Modes for Multi-scale Scans
When setting up a new run or re-running an existing run, the user has several 
operating modes to choose from. What is meant by operating modes is this: Will the 
systems be acquiring new data by scanning a sample or will the system be reanalyzing 
previously acquired images by performing a virtual scan of those images? With multi-
scale scanning, certain combinations of these two modes are possible. All of these 
options are described below.

New Runs

Live-Live
With a new run, data must be acquired with a live scan. If a fully automated run is 
chosen then data will be acquired for both scales by live scanning of the sample. To set 
up a fully automated 2 scale scan, make sure the bridge between the two Scan modules 
is NOT set to pause by clicking on the box on the bridge until it appears blank, as 
shown in the figure below.

Test scans should be made to set the hardware and software protocol parameters for 
both scale scans. To set up the protocol for both scales create an abbreviated scout 
scan area, turn on the pause between scales and select the Test Scan button or the 
Next button (single field). During the scout scanning make the desired changes to the 
PMT settings. (NOTE: This may take several iterations of starting and stopping the 
test scan.)  When the PMT settings are complete, stop the scan and then acquire 
another Scout scan using the correct PMT settings. During the Pause, use the View 
Image tool as described in “Using the Protocol Menu View Image Feature with 
iNovator” of this appendix. Once you are satisfied with the contouring protocol, select 
or create Dynamic Scan Areas in the Well Image window to use for setting up the 2nd 
scale hardware and contouring protocol. Delete any unnecessary dynamic scan areas. 
(NOTE: You may want to increase the size of the dynamic scan areas to be large 
enough to complete the 2nd scale setup.)  Once you have selected the dynamic scan 
areas, press the Paused button to continue the test scan in the 2nd scale. During test 
scanning of the 2nd scale make the necessary hardware and contouring protocol 
changes. (Note: It may take several iterations of test scanning to accomplish the 
setup).
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Once the protocol parameters have been set, select Scan and Save  and the iCys will 
scan the 1st scale, automatically identify Dynamic Scan Areas and then scan these 
areas with the 2nd scale protocol.

Live (Scout only) and Live-Pause-Live
To scan only the first scale and then either save the data for later action or manipulate 
the Dynamic Scan Areas prior to continuing with the 2nd scale scan, set the bridge 
between the two Scan modules to Pause by clicking on the box on the bridge until 
Pause appears, as shown in the figure below.

When the first scale scan is complete, the Pause box will turn pink and Pause will turn 
to Paused:

In this paused state, you may review the Dynamic Scan Areas in the Well Image 
window. You have two possible options at this point:

❑ Save the scout scan data for a later  scanning of the 2nd scale scan,

❑ Continue with the 2nd scale scan now.

To save the scout scan data for later, click Stop and then yes to save the run. We will 
discuss opening and continuing with scout-only runs in the next section.

If you intend to continue with the 2nd scale scan, you may first review the Dynamic 
Scan Areas and if necessary, move or delete them, or create new ones. For more 
information on this process, see “Manipulating Dynamic Scan Areas” on page B-31. 
Once you are happy with the DSAs, you may resume scanning by clicking on the 
bridge; the box will become clear and scanning will resume. 

Reanalyzing Existing Runs
When the user selects Open Run, several options are presented in the Analysis Mode 
area of the dialog box highlighted below.



Using the iNovator™ Toolkit Multi-scale Scanning

B-36  iCys Research Imaging Cytometer User Guide Revision B

Analyze events (bypass-bypass)
Select this option if you do not want to rescan any existing images or acquire new 
data, but want to work only with the existing event data from a previous scan.

Reanalyze scale 1 (virtual-bypass)
Select this option if you want to virtually rescan existing scale 1 data, that is, reprocess 
scale 1 image data after modifying the protocol.

Modify the protocol to optimize the analysis, then click Scan and Save to generate 
new event data and DSAs and save the data as a new run.

Reanalyze scale 1 and scan scale 2 (virtual-live)
This option allows you to reprocess scale 1 image data as described above and then to 
acquire new data from a live scale 2 scan of your sample.

Modify the scale 1 protocol to optimize the analysis, then click Scan and Save to 
generate new scale 1 event data and DSAs and save the data as a new run. To continue 
with the 2nd scale scan, manipulate the DSAs if desired, and then click the Paused 
box on the bridge between the Scan modules to initiate the 2nd scale scan.

Reanalyze scale 2 (bypass-virtual)
Select this option if you want to use the saved 1st scale scan "as is" and virtually 
reanalyze the already acquired 2nd scale scan data. To initiate the 2nd scale scan, click 
Scan and Save. 
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Note that the Mode signature (such as virtual-bypass) serves as shorthand for the type 
of run that is being performed. This mode type is shown in the Scan Module graphics, 
as shown below.
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Appendix C

Administrator Tasks

This chapter describes certain iCys™ Cytometric Analysis Software administrative 
tasks.

Included in this chapter:

❑ Displaying the Administration Menu, page C-3

❑ Using the Manage Carrier Types Window, page C-5

❑ Defining Custom Carriers, page C-7

❑ Using the Light Meter Utility, page C-24 

❑ Forward Scatter Pixel Correction, page C-26
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About Administrator Tasks
The iCys administrative tasks fall into two tiers:

❑ Tasks available to an administrative user at the customer site. These tasks, which 
can be accessed from the Administration menu with the correct password, include 
changing the administrator password, managing carrier types, scatter pixel 
correction and using the lightmeter utility.

❑ Tasks that should be used only by (or with the assistance of) CompuCyte 
personnel. These tasks include various calibration utilities that can be used in 
troubleshooting and repairing the iCys hardware.

The Administration password will only display the first level of tasks in the 
Administration menu. For information about more advanced tasks, contact your 
CompuCyte representative.
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Displaying the Administration Menu
When you open the Administration menu in general administration mode, you will see 
four options:

❑ Manage Carrier Types

❑ Change Password

❑ Light Meter

❑ Scatter Pixel Correction

Managing carriers is discussed in “Using the Manage Carrier Types Window” on 
page C-5 and “Defining Custom Carriers” on page C-7.

Opening the Administration Menu
When you first open iCys, the Administration menu does not display on the task bar. 

➣ To gain access to the Administration menu:

1. Click the “Show Administration Menu” option from the Setup menu.

2. The Enter Password window displays:

3. Type Hello to gain access to the user administration menu.

Tip: As the administrator, you may want to change the password, as described 
in “Changing the Password” on page C-4.

4. After you enter the password and click OK, the Administration menu displays in 
the iCys menu bar. From this menu you can:

❍ Change the password, as described in “Changing the Password” on page C-4.

❍ Make changes to the carrier display list, as described in “Using the Manage 
Carrier Types Window” on page C-5.

❍ Add new carriers, as described in “Defining Custom Carriers” on page C-7.

❍ Use the Light Meter utility as described on page C-24.

❍ Calibrate the Pixel Correction Values for the Forward Scatter channels, as 
described on page C-26.
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Changing the Password
To ensure that other users do not inadvertently make changes to the carrier type 
definitions, you may want to change the administrator password.

➣ To change the administration password:

1. Click Change Password. The Change Password window displays:

2. Enter the current password.

3. Enter the new password. 

4. Confirm the new password.

5. Click OK. The new password will be required the next time you open the 
Administration menu.

Hiding the Administration Menu
➣ To remove the Administration menu from the menu bar:

1. Select Setup ⇒ Show Administration Window. The Administration selection will 
have a check mark (✓) next to it indicating the Administration menu is active.

2. Highlight ✓ Administration to close menu.
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Using the Manage Carrier Types Window
Select Manage Carrier Types from the Administration window to display the Manage 
Carrier Types window:

From the Manage Carrier Types window you can:

❑ Select which carriers you want your users to see in the General tab of the 
Instrument window, as described in “Hiding Unused Carriers” on page C-5.

❑ Make changes to carrier names, delete carriers from the Carrier Types list and 
make other changes to the supported carriers.

❑ Add custom carriers, as described in “Defining Custom Carriers” on page C-7.

Using the Hide Carrier Types Feature
If your site uses a subset of the carrier types supported by iCys, you can choose to hide 
the carrier types that you do not use. Hidden carrier types are not displayed in the 
Select Carrier Type window, accessed from the Carrier View.

Hiding Unused Carriers
➣ To hide carrier types:

1. From the Manage Carrier Types window, select a carrier type that you want to 
hide.

2. Click Hide.

The selected carrier type no longer appears in the Carrier Type list. More importantly, 
it will not display in the Select Carrier Type window, accessed from the Carrier View.
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Note: CompuCyte recommends that you hide, rather than delete, unused 
standard carriers.

Displaying Hidden Carriers
If desired, you can show the hidden carriers in the Carrier Types list.

➣ To show hidden carriers, select Show Hidden. The hidden carriers will reappear in the 
list; but will not be available in the Select Carrier Type window.

Including Hidden Carriers
➣ To include hidden carriers:

1. Make sure that Show Hidden is checked.

2. Select a hidden carrier (you can tell because UnHide displays on the Hide/UnHide 
button).

3. Click UnHide. The carrier type is now included both in the Carrier Types list and 
from the Select Carrier Type window.
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Defining Custom Carriers
CompuCyte now allows you to define custom carriers for your iCys system. Every 
carrier type has a unique name and ID number. 

You can define a custom carrier by either copying an existing carrier type or by 
defining an entirely new carrier type. Either way, the new custom carrier is given a 
unique ID.

Tip: Before you define a new custom carrier, try to obtain the dimensions of 
your carrier from the supplier or from the manufacturer’s website. Having 
the exact dimensions will greatly simplify the definition process.

➣ To define a custom carrier from the Carrier Types list:

❑  Select a similar carrier and click Copy. When you follow the directions in 
“Defining a Microplate Carrier” on page C-7 or “Defining a Freeform Carrier” on 
page C-16, keep in mind that you will be changing existing parameters rather than 
entering new parameters.

CompuCyte recommends that, whenever possible, you copy and rename a similar 
existing carrier.

❑ Click New. In this case, follow the directions in “Defining a Microplate Carrier” 
on page C-7 or “Defining a Freeform Carrier” on page C-16.

Defining a Microplate Carrier 
A microplate carrier contains a specified number of wells, each of which is identical. 
When generating a microplate scan, iCys assumes that the scan areas are identical for 
every well.

Note: When defining a custom plate, the plate map (that displays when you 
click Carrier), may not be a precise representation of the plate. The plate 
wells will always appear to start in the same location in the upper left 
corner of the plate map. However, the distances between wells and other 
criteria should display correctly.
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➣ To define a new microplate carrier:

1. From the Manage Carrier Types window, select New. The Edit Carrier Type 
window displays:

2. In the General tab, set the following:

❍ Type—Microplate. To define a freeform carrier, see “Defining a Freeform 
Carrier” on page C-16.

❍ Name—Enter a meaningful name for this carrier type. The carrier name will 
appear in the drop down list in the carrier window.

❍ Description—Optional, but useful. 

❍ Visibility—Select Hidden if you want to make this carrier type unavailable 
from the Instrument Setup window. The visibility can be overwritten by the 
Hide/UnHide button on the Carrier Types list. 

❍ r

CompuCyte automatically fills out the Created by and ID fields. The ID is unique 
ID for each carrier. 

3. To view the carrier while you are defining it, click Carrier from the task bar. 
When you click Save on the Edit Carrier Type window, the Carrier window 
updates to reflect the changes.

4. Before you start describing the dimensions, make sure that the microscope 
objective selected in the current Workspace matches the objective you are using. 
The objective is set in the Objective window in the task bar.
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5. Open the XY tab to set the XY parameters:

When you click New, the default microplate descriptor is for a 96-well plate. The 
XY tab allows you to describe the wells in this carrier. The XY tab has the 
following options:

❍ Dimensions—The length and width (X and Y dimensions) are standard and 
cannot be changed.

❍ Layout—Allows you to specify the number of wells, as follows:

✧ Number of Rows—The number of rows for this microplate.

✧ Number of Columns—The number of columns for this microplate.

❍ Well—Specify the size and shape of each well:

✧ Specify the well shape as either Square or Circle.

✧ Well Size—Specify the width of the well. For a circular well, specify the 
diameter.

❍ First well—If you know the distance between the edge of the carrier and the 
A1 (top left) well, enter that distance as follows:

✧ X Margin Left—The distance, in millimeters, from the left edge of the 
carrier to the center of the first well.

✧ Y Margin Top—The distance, in millimeters, from the top edge of the 
carrier to the center of the first well.
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If you do not know the distance, use one of the methods described in 
“Determining the A1 Parameters” on page C-13. When you have entered the 
measurements for the First well and for the Other wells (discussed below), 
return to Step 6.

Note: The Move To (or Move Stage To) and Set from XY buttons are 
discussed in the context of “Determining the A1 Parameters” on page C-
13.

❍ Other Wells—Specifies the distance between each well.

Interval—Specify the distance from the center of one well to the center of the 
next well. For microplate carriers, the wells are spaced so the interval is the 
same from left to right and from up to down.

If you do not know the distance, use one of the methods described in “Setting 
the Interval using iCys” on page C-14. When you have entered the 
measurements for the First well and for the Other wells, return to Step 6.

6. Open the Z tab to set the Z parameters:

X margin

Y margin
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The Z tab allows you to specify, or determine, the appropriate start AutoFocus 
positions for the carrier. The parameters are:

❍ Setup—Allows you to move the stage to a well to calibrate or to the Clear 
position (near Home).

✧ Well—Select which well you want to use to calibrate the Z parameter. 
Select the well in the Well pull-down and click Move To. The stage 
moves to the specified well.

✧ Move Objective to Clear—Click to move the objective to the Clear 
position.

❍ Configurable Positions—Specifies the required values for the plate height 
(the Z parameter):

✧ Base to Well Height—Specifies the distance from the base of the carrier 
to the bottom of the plate.

✧ Bottom Thickness—Specifies the thickness of the glass or plastic 
through which the microscope needs to focus. 
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For example:

If you do not know the measurements for Base to Well Height or Bottom 
Thickness, use the method described in “Determining the Microplate Z 
Parameters” on page C-14. When you have entered these measurements, 
return to Focus Methods, below.
✧ Retraction Offset—Only used with some Freeform Carriers. For more 

information, see “Defining a Freeform Carrier” on page C-16.

❍ Focus Methods—Specify the preferred (or required) focus method. 
✧ Bottom then Top—For thicker plastic-bottomed plates (greater than 

400µ) especially; iCys will focus first on the plate bottom, then translate 
up by the bottom thickness to the plate top and refocus.

✧ Bottom Only—For glass-bottomed or thinner plastic-bottomed (less than 
400µ) plates, iCys focuses directly on the bottom then moves up by the 
bottom thickness plus other offsets to bring the sample into focus.

✧ Default—To allow your users to select a focus method (as discussed in 
“Focus and Performance” on page 3-33), select both focus methods and 
then select the method that you want to use as a default setting.

Note: If the Bottom Thickness is less than 400µ, select Bottom Only as the only 
available focus method. iCys will set the default focus method to match.

❍ Test Autofocus—To test whether you have the values for your carrier set 
correctly, you can run Test Autofocus. To test under working conditions, 
CompuCyte suggests that you fill the test wells with water or another buffered 
solution (such as phosphate-buffered saline [PBS].)

Test Autofocus tries to focus the objective correctly on the carrier and 
produces a result number, as follows:
✧ If the Test Autofocus Result is greater than 800, the parameters are 

correctly set.
✧ If Autofocus did not work, an error message will display. Check the 

General tab of the Instrument Setup window (and the Focus parameter in 
the task bar) to ensure that Autofocus is selected. You may also need to 
check the values of the X,Y, and Z parameters for errors.

✧ If the Test Autofocus Result is between 0 and 800, try to refine the values 
for the carrier and retest. 

7. When you are happy with the results, click Save to save your changes. Close the 
Edit Carrier Type window.

{
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Determining the A1 Parameters

Finding the A1 Position by Measuring
➣ To determine the position of the top left (A1) well: 

1. Measure the distance between the right edge of the microplate (closest to A1) and 
the center of the A1 well. Enter this value as the X Margin Left. 

2. Measure the distance between the top edge of the plate (closest to A1) and the 
center of the A1 well. Enter this value as the Y Margin Top. 

3. Measure the distance from the center of well A1 well to the center of the well A2 
well. and Enter this value as the Interval in the Other Wells section.

4. If you cannot accurately measure the distance of the A1 well from the edges, see 
“Finding the A1 Position using iCys” on page C-13. 

Finding the A1 Position using iCys
➣ To use iCys to find the A1 position:

1. Load your custom microplate onto the microscope stage, as described in “Loading 
a Microtiter Plate” on page 2-18.

2. Open the Oscilloscope window by selecting Instrument ⇒ Oscilloscope. 

Tip: When determining measurements, the oscilloscope is only used to turn   
the galvanometer on and off. For more information about the 
oscilloscope, see “Using the Oscilloscope Feature” on page 3-90.

3. From the Oscilloscope window, turn on the oscilloscope by clicking the “Play or 
Stop” button ( ). 

4. Place a piece of thin white paper over the A1 well of the microplate. From the XY 
tab of the Edit Carrier Type window, click the Move To button in the First well 
section. 

5. Select the Argon Laser *488 from the task bar to open the shutter.

Warning: When using paper to find the well measurements, avoid direct eye 
exposure to the Class 3R radiation. 

6. If the beam is not centered in well A1, use the touchpad buttons or the Remote 
Control unit X and Y knobs to drive the stage such that the beam is centered in the 
A1 well. 

7. Drive the objective lens upwards until you see a line (or pair of lines) on the 
Autofocus (black and white) monitor. Adjust the focus until you are satisfied with 
the results. Recheck, and if needed, recenter the beam in A1.

8. When the beam is properly centered and focused, turn the oscilloscope trace off 
(by clicking on the “Play or Stop” arrow [ ]). Click Set from X,Y in the First 
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Well section of the XY tab to set the location. The X and Y margin parameters are 
automatically filled in by iCys.

Note: Always turn the oscilloscope off and wait for the Current X and Current Y 
values (at the bottom of the XY tab) to update before you click Set from 
X,Y. 

The update may take a few moments, but will ensure that the 
measurement is correct.

Setting the Interval using iCys
➣ To set the interval, as described in Step 5, above:

1. Turn on the oscilloscope trace, and open the Argon Laser Shutter, then select B2 
from the Well pull-down list in the Other Wells section of the XY tab. 

2. View the beam, using a piece of thin white paper placed over well B2, and adjust 
the stage so the beam is centered in the well. 

3. Turn off the oscilloscope and click the Set from X,Y button in the Other Wells 
section. The Interval parameter is automatically filled in by iCys.

4. To make sure that the interval is correct, select the last well H12 for a 96-well 
plate) in your microplate from the Other Wells Well pull-down list and click 
Move To to drive the stage to that well. Check that the beam is centered on the 
last well, again using thin white paper. If it is not centered, adjust the interval (but 
do not use the last well) and check again using the last well. 

Determining the Microplate Z Parameters 

Finding the Base to Well Height
➣ To determine the Base to Well Height:

1. Click on the Z tab in the Edit Carrier window.

2. With the stage at well A1, the same objective in place (as displayed in the task 
bar), and the Oscilloscope window open and on, and the Argon Laser Shutter 
open, use the rocker switch on the Remote Control unit to drive the objective 
upwards slowly until you observe a reasonably well focused line or lines on the 
autofocus monitor. Make sure that you are focusing on the first line or pair of lines 
to be imaged on the display.

3. Use the Fine Focus knob on the Remote Control unit to create a well focused 
image. 

4. Click Set from Z for the Base To Well Height field in the Z tab. Mark down this 
value, and then take the same measurement at a number of other points on the 
plate, such as:

❍ The other three corner wells

❍ A well near the center of the plate
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❍ A well at or near the center top row

❍ A well at or near the center bottom row

❍ A well at or near the center left column

❍ A well at or near the center right column

For example:

5. Determine which of these 9 positions yields the lowest value, and enter that value 
as the Base To Well Height.

Determining the Bottom Thickness
➣ To determine the bottom thickness:

1. Move the stage so that the objective focuses on the well with the lowest Base to 
Well Height (which you determined in “Finding the Base to Well Height” on 
page C-14), and click on Move To from the Base to Well Height field. 

2. Make sure the well you use for focusing is empty.

3. Slowly rotate the fine focus knob counter-clockwise until the second line or lines 
appear to be finely focused on the autofocus monitor. For thicker-bottomed plates, 
this may take 5 or more knob rotations.Click Set from Z for the Bottom 
Thickness field of the Z tab. 

x

xx
x

x x

x
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x
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Defining a Freeform Carrier
Rather than consisting of uniform wells, a freeform carrier can contain one or more 
carrier display areas, which do not have to be identical (but usually are). 

➣ To define a new freeform carrier:

1. From the Manage Carrier Types window, select New. The Edit Carrier Type 
window displays:

2. In the General tab, set the following:

❍ Type—Freeform Carrier. To define a microplate carrier, see “Defining a 
Microplate Carrier” on page C-7.

❍ Name—Enter a meaningful name for this carrier type. Keep in mind that your 
users will select this carrier type using the name specified here.

❍ Description—Optional, but useful. 

❍ Visibility—Select Hidden if you want to make this carrier type unavailable 
from the Instrument Setup window. The visibility can be overwritten by the 
Hide/UnHide button on the Carrier Types list. 

3. rTo view the carrier while you are defining it, click Carrier from the task bar. 
When you click Save on the Edit Carrier Type window, the Carrier window 
updates to reflect the changes.

4. Before you start describing the dimensions, make sure that the microscope 
objective selected in the current Workspace matches the objective you are using. 
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The objective is set in the General tab of the Instrument Setup window and listed 
in the task bar.

5. Open the XY tab to set the XY parameters.

6. In the Rooms section, select New. Room R1 will be created and the XY tab 
displays the parameters for that room:

7. In the XY tab, you can set the following general parameters:

❍ Dimension—The dimensions of the display area. In general, CompuCyte 
suggests that you do not make changes to the Dimension values, and display 
the entire carrier.

✧ X Width—The width of the display area, in millimeters.

✧ Y Length—The length of the display area, in millimeters.

Note: If you specify the carrier display area (or copy a carrier that specifies the 
display area), keep in mind that the display area must be smaller than the 
standard carrier size, which is 127.76mm x 85.48mm. Additionally, when 
specifying room locations, all rooms must reside within the display area.

❍ Top Right Carrier Corner—The distance between the outside edge of the 
carrier and the edge of the top right carrier display area. CompuCyte suggests 
that you set both the X and Y value to 0.
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❍ Rooms—Click New (or Delete, if necessary) in the Rooms section to add 
rooms until the number of rooms in the display equals the number of rooms 
on the carrier.

8. Define each room in the XY tab. You need to define the parameters separately for 
each room. Select a room from the Rooms pull-down.The Select Room section 
displays.

If you know the exact shape, location, and dimensions for the room, enter them as 
follows:

❍ Rectangle or Circle—Specify the shape of the room. 

❍ For a Rectangle:

✧ Top Right Room Corner (X and Y values)—The location of the top 
right corner of the room relative to the X and Y values of the Dimension 
field (described in Step 7).

✧ Bottom Left Room Corner (X and Y values)—The location of the 
bottom left corner of the room relative to the X and Y values of the 
Dimension field.

❍ For a Circle:

✧ Center (X and Y values)—The center of this room relative to the X and Y 
values of the Dimension field (described in Step 7).

✧ Diameter (in millimeters)—The diameter of the room.

If you do not know these values, determine them as described in “Defining a 
Room Using iCys” on page C-21.

9. Open the Z tab to set the Z parameters:
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The Z tab allows you to specify, or determine, the appropriate start AutoFocus 
positions for the carrier. The parameters are:

❍ Setup—Allows you to move the stage to a well to calibrate or to the Clear 
position.

✧ Room—Allows you to specify which room you want to use to calibrate 
the Z parameter. Select the room in the Room pull-down and click Move 
Stage To. The stage moves to the specified room.

✧ Move Objective to Clear—Click to move the objective to the Clear 
position.

❍ Configurable Positions—Specifies the required values for the carrier height 
(the Z parameter):

✧ Base to Well Height—Specifies the distance from the base of the carrier 
to the bottom of the room.

✧ Bottom Thickness—Specifies the thickness of the glass or plastic 
through which the microscope needs to focus. If you use #1 coverglass 
with this carrier, the value is 0.12. 

For example:
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If you do not know the measurements for Base to Well Height or Bottom 
Thickness, use the method described in “Determining the Freeform Z 
Parameters” on page C-22. When you have entered these measurements, 
return to Focus Methods, below.

✧ Retraction Offset—The Retraction Offset is only needed if you have a 
carrier that may be bumped by the microscope when moving from room 
to room (the only standard carrier for which this is an issue is the 3 Room 
Petri Dish). If a Retraction Offset is required, but you do not know it, you 
can find it as follows:

– Click on Instrument ⇒ Home Objective. Manually move the stage to a 
position between rooms using the touchpad or Remote Control unit 
knobs. 

– As described in “Finding the Base to Well Height” on page C-22, use 
the Remote Control unit knobs and the autofocus monitor to focus on the 
top of the carrier. 

– When you have a clear focus, click Set from Z for the Retraction Offset 
value.

❍ Focus Methods—Specify the preferred (or required) focus method. 

✧ Bottom then Top—For thicker plastic-bottomed plates (greater than 
400µ) especially; iCys will focus first on the plate bottom, then translate 
up by the bottom thickness to the plate top and refocus.

✧ Bottom Only—For glass-bottomed or thinner plastic-bottomed (less than 
400µ) plates, iCys focuses directly on the bottom then moves up by the 
bottom thickness plus other offsets to bring the sample into focus.

✧ Default—If you want to allow your users to select a focus method (as 
discussed in “Focus and Performance” on page 3-33), select both focus 
methods and then select the method that you want to use as a default 
setting.

Note: If the Bottom Thickness is less than 400µ, select Bottom Only as the only 
available focus method. iCys will set the default focus method to match.

❍ Test Autofocus—To test whether you have the values for your carrier set 
correctly, you can run Test Autofocus. To test under working conditions, 
CompuCyte suggests that you fill the test wells with water or another buffered 
solution (such as phosphate-buffered saline [PBS].)

{
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✧ If the Test Autofocus Result is greater than 800, the parameters are 
correctly set.

✧ If Autofocus did not work, an error message will display. Check the 
General tab of the Instrument Setup window (and the Focus parameter in 
the task bar) to ensure that Autofocus is selected. You may also need to 
check the values of the X,Y, and Z parameters for errors.

✧ If the Test Autofocus Result is between 0 and 800, try to refine the values 
for the carrier and retest. 

10. After you set the parameters, test the offset: Cycle through the rooms, clicking on 
Move To under the Selected Room section to ensure that the parameters are 
correct.

11. When you are happy with the results, click Save to save your changes. Close the 
Edit Carrier Type window.

Defining a Room Using iCys
➣ To determine the values for a room:

1. Load your custom carrier onto the microscope stage, as described in “Loading 
Other Carrier Types” on page 2-19. You may want to pick the type of carrier 
closest to your custom carrier.

2. Open the Oscilloscope window by selecting Instrument ⇒ Oscilloscope. 

Tip: When determining measurements, the oscilloscope is only used to turn 
the galvanometer on and off. For more information about the 
oscilloscope, see “Using the Oscilloscope Feature” on page 3-90.

3. From the Oscilloscope window, turn on the oscilloscope by clicking the “Play or 
Stop” button ( ). 

4. Place a piece of thin white paper over the selected room of your carrier. 

5. Select the Argon Laser *488 from the task bar to open the shutter.

Warning: When using paper to find the room measurements, avoid direct eye 
exposure to the Class 3R radiation. 

6. In the Selected Room section of the XY tab, specify Rectangle or Circle for the 
room shape. 

7. Use the touchpad buttons and Remote Control unit X and Y knobs to drive the 
stage until the room is over the microscope objective. 

If the room is a Rectangle:

a. Adjust the stage until the top (back) right corner of the room is over the 
objective (use the white paper to view the projection of the beam). 
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b. Turn the oscilloscope off by clicking the “Play or Stop” button ( ).

c. Press Set from X,Y for the Top Right Room Corner measurement. 

d. Turn the oscilloscope on again, open shutter, and adjust the stage until the 
bottom (front) left corner of the room is over the objective. 

e. Press Set from X,Y for the Bottom Left Room Corner.

If the room is a Circle:

a. Use the touchpad buttons and Remote Control unit X and Y knobs to drive the 
stage to a position such that the room is centered over the microscope beam.

b. Turn the oscilloscope off by clicking the “Play or Stop” button ( ).

c. Press Set from X,Y for the Center measurement. 

d. Turn the oscilloscope on again and open shutter.

e. For the Diameter measurement, you can measure the room diameter 
manually, look up the room size on the specification sheet for this carrier and 
enter it for the Diameter value, or use the Remote Control unit X and Y knobs 
to drive to the edge of the room and click on Set from X, Y for the Diameter 
field.

8. Repeat Step 8 for each room you need to define. 

Determining the Freeform Z Parameters 

Finding the Base to Well Height
➣ To determine the Base to Well Height:

1. With the stage at room R1, the same objective in place as displayed in the task bar, 
and the Oscilloscope window open and on, and the Argon Laser Shutter open, use 
the rocker switch on the Remote Control unit to drive the objective upwards 
slowly until you observe a reasonably well focused line or lines on the autofocus 
monitor. Make sure that you are focusing on the first line or pair of lines to be 
imaged on the display.

2. Use the Fine Focus knob on the Remote Control unit to create a well focused 
image. 

1. Click Set from Z for the Base To Well Height field in the Z tab. Mark down this 
value, and then take the same measurement at least once each room on the carrier 
(so that you have measurements for a number of positions on the carrier.) 

2. Enter the lowest value measured as the Base to Well Height.
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Determining the Bottom Thickness
➣ To determine the bottom thickness:

1. Move the stage so that the objective focuses on the room with the lowest Base to 
Well Height (which you determined in “Finding the Base to Well Height” on 
page C-14), and click on Move To from the Base to Well Height field. 

2. Make sure the room you use for focusing is empty.

3. Slowly rotate the fine focus knob counter-clockwise until the second line or lines 
appear to be finely focused on the autofocus monitor. For thicker-bottomed plates, 
this may take 5 or more knob rotations.Click Set from Z for the Bottom 
Thickness field of the Z tab. 
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Using the Light Meter Utility
The Light Meter utility allows you to measure the throughput of the system lasers, and 
determine if any action is needed to improve laser throughput.

➣ To use the Light Meter Utility, click on Light Meter. The following window displays:

1. Follow the directions in the Operator Actions window, that is, make sure that:

❍ The iCys and the lasers are warmed up.

❍ There is no carrier on the stage.

❍ For the primary Argon measurement, set the turret so no objective is selected. 
If necessary, unscrew the cap in the empty objective slot. 

Note: If your system does not have AutoFocus, you will need to manual move 
the objective to be level with the stage. A message will display reminding 
you to do so.

2. Once the instrument is correctly set up and warmed up, select Argon (488 nm.) 
and click the Measure or Measure Baseline button. (If no Baseline data is 
available, only the Measure Baseline button is available.) The measurement is 
recorded in the appropriate window.

3. iCys digitizes the scan line produced by the Argon laser. To save that 
measurement, click Save.

4. Ideally, you want the measurement value to be close to, but not at, the maximum 
signal intensity of 16383. To get good readings, you may need to adjust the Gain, 
Offset, and for the Argon measurements, the power. These settings are described 
in “Optimizing PMT settings” on page 3-39.



Revision B iCys Research Imaging Cytometer User Guide  C-25

May 6, 2005 Administrator Tasks

5. Measure and, if desired, save, measurements for any other objectives and lasers. 
Note that the objectives only need to measured once (with the Argon laser). If they 
are dirty, then it will affect the measurements for any laser.

6. Once the measurement has been saved as the baseline, you can remeasure it at any 
time. The new measurement is taken against the baseline, as shown:

7. To view the current measurements, click History to display the Measurement 
History file:

The History file can also help you track any change in measurement. If the 
objectives need to be cleaned, for example, their measurements will degrade. In 
this case, contact your CompuCyte service representative.
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Forward Scatter Pixel Correction

When images are collected using the forward scatter mechanism, variations in pixel 
intensity are produced because the laser beam strikes the sensor at various angles 
during its “sweep.” In order to produce the best quality images, these variations must 
be corrected.

The Administration menu offers a Forward Scatter Pixel Correction utility. The 
opening screen is shown below:

The textbox on the left contains instructions on how to proceed. List boxes allow 
selection of a laser and objective. Each combination of laser and objective must be 
corrected.

Once selections are made, press the Measure button. The utility will move the empty 
stage to the center and automatically adjust the gain and offset for the best exposure. 
The textbox on the left will display the steps of the measurement.

The minimum and maximum values of pixel brightness required to pass these 
adjustments are stored in the calibration file under “scatter-auto-exposure.” The 
factory settings should work in most circumstances.

As the adjustments progress, you can see the results in the image window. When the 
adjustments are complete, the textbox will display the message “Scan complete.” 
When the measurement is complete, a message box will display the message 
“Measurement complete.”

After clicking OK on the message box, you will note that the Save button has become 
available. You may elect to save the correction factors now or wait until you make 
another measurement. When the Measure button is pressed again, the current 
correction data will be replaced with new data.
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Before saving, it is wise to review the results of the correction. This can be done by 
pressing the Test button with the Correct Pixels checkbox checked. The utility will 
collect and display one scan field of data, either corrected or uncorrected, depending 
on whether the checkbox is checked.

Once you are satisfied, the data can be saved. If the utility is exited with data unsaved 
a message will be displayed asking if the data should be saved or not.
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Appendix D

Glossary

This chapter contains a glossary of terms used with iCys™ Research Imaging 
Cytometer, iCys™ Cytometric Analysis Software and iBrowser™ Data Integra-
tion Software.

To find a term quickly, click on one of the following letters:

A B C D E F G H I L M N 0 P Q R S T V W
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Glossary of Terms

A
access key The key that corresponds to an underlined letter on a menu, command, or dialog 

box option.

active window An area of the screen where the next action will be performed. The active window 
appears in the foreground and the title bar is highlighted.

acquisition Consists of a sequence of processes some of which are: detecting the signals of 
interest, performing suitable analog signal processing, converting the data to a 
digital representation and then storing the data in a computer memory for analysis. 

aggregate Particles or cells that have clustered or united in a mass.

algorithm A set of procedures by which a given result can be obtained. A computer can carry 
out the steps of many different types of algorithms.

amplifier An electronic device which increases the voltage or current of a signal to allow 
additional signal processing such as conversion to digital representation.

analog Representation of an electronic signal by a continuum of values.

Analog-to-Digital
Converter (ADC)

Converts an analog signal to a digital or “discreet value” representation to enable 
processing by a computer or other digital electronics systems.

analysis Analysis subsequent to data acquisition consists of any number of processes 
performed on the data including: segmenting and contouring the data to determine 
valid events, calculating a fixed set of features for each of the events, and 
producing correlated displays for selected features.

argon ion laser The principle light source in the iCys generating 5-20 mW of coherent blue light 
output at a single line wavelength of 488 mW.

B
background Measured signal content which is not generated by a cell or particle but by 

intrinsic properties of the reagent or substrate, by optical anomalies in the light 
path or by electronic noise of the signal detection system.

bar chart A graph consisting of parallel vertical bars or rectangles with lengths proportional 
to specific quantities.

bitmap An area in the computer’s memory organized so that each unit of memory in the 
bitmap represents the color of one pixel.

.BMP file A graphic file format which is the native bitmap format of Microsoft®Windows™ 

software.
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C
carrier The microtiter plate or other tray on which specimens are viewed. CompuCyte 

supports a number of different carrier types, including microplates, slide trays, 4-
room slide suites, and petri dish carriers.

carrier display 
area

The area within a carrier shown in iCys. For example, for a slide carrier, the 
carrier display area is generally 125mm by 75mm (the dimensions of the slide), 
while the carrier itself is much larger.

channel A channel refers to one of the six filter/detector data acquisition paths in the iCys. 
The six channels are four fluorescent, one scatter, and one for summed signals.

Channel is also used to refer to the assignment of ranges of light intensity that 
result from converting an electrical signal from a photodetector into a digital 
value. A histogram is the graphical representation of the channel assignment 
where the x axis represents increasing signal intensity.

check box A square box associated with an option in a dialog box. When there is a check in 
the box, that option is selected. More than one check box can be selected.

circularity The measurement of how close an event is to a perfect circle. The circularity is 
determined by:

perimeter2/area
Therefore, the circularity of a perfect circle is 4π (12.566). The larger the 
circularity number, the less circular it is.
Note that, due to normalization, the circularity of an event may be less than 
12.566.

click An action that is performed by quickly pressing and releasing a button on the 
mouse. The action selects a menu, a command, moves an insertion point, or 
selects a graphical object so that you can work with it. It also places the insertion 
point in a text box.

clipboard A portion of computer memory that is set aside for temporary storage of whatever 
was last cut or copied. Material moved to the clipboard can be pasted into another 
application.

coefficient of 
variation (CV)

A statistical quantity which describes the variation or spread of a probability 
distribution (or of a cell size distribution). Mathematically, it is calculated by 
dividing the mean of the distribution by the standard deviation of the distribution.

color depth A measure of how much color information is available for each pixel in an image. 
A pixel with a color depth of 1 has two possible values: black and white. A color 
depth of 8 has 28, or 256 colors and a color depth of 24 has 224, or roughly 16 
million colors.

component A group of events generated from single contouring process.

composite image An image generated during the first phase of a two-step scan. The image is 
comprised of multiple scan fields, each of which is 20 microns wide and runs the 
length of the scan area (which may be the width of a slide, a well, or a petri dish). 
The composite image is used by iCys to determine the meaningful events within 
the larger area. These events are then scanned using normal scanning techniques.
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CompuColor A method of assigning colors to scanned images of samples.

context-sensitive Information located on the computer to help a user while in a program. It provides 
information when and where the user wants it.

contouring The event detection process in the iCys which results in a two-dimensional outline 
of the cell. There are separate contours for threshold, integral, background, or 
peripheral.

contour 
histogram

Plots the values of two user-selected features such that the frequency of 
occurrence is displayed as a 3D bar graph with color defining frequency.

control A standard against which observations or conclusions of other samples may be 
checked for their validity.

CV See coefficient of variation

D
data file A file with an .EVT or .RAW extension that was saved to disk which has 

measured values from a sample.

desktop A window in which all the menus and tools to operate a specific application are 
located.

dichroic mirror An optical element which selectively reflects one bandpass in the optical spectrum 
while simultaneously transmitting a second bandpass. A dichroic mirror is usually 
positioned so that the incident beam is 45o to the mirror surface, the reflected light 
thus being 90o to the incident beam.

dimmed An unavailable menu item or option. It is unavailable to the user because it is 
inappropriate or not selected at that time.

diploid Cells in the initial cell cycle stage that have two sets of chromosomes.

directory A file containing the names and locations of all the files contained on a storage 
medium.

double-click A user action which quickly presses and releases the left mouse button twice to 
select an action based on the cursor location.

drag-and-drop A method of moving or copying text, graphics, or other items from one window to 
another.

drop-down arrow An arrow on a dialog box that points down indicating that when pressed more 
options will be displayed.

E
ellipsis points Ellipsis points appended to a menu item indicate that when selected a dialog box 

will be displayed with more options.

event A particle, cell, or aggregate that has features that can be measured by a 
cytometer.
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EVT file An iCys file type which contains features for all the events that have been 
scanned. 

F
features A set of physical and/or chemical characteristics of a event (particle, cell, etc.) as 

measured by the iCys. Such features include area, integral, max pixel, time, x 
position, y position, scan, distance, perimeter, perimeter^2, # of spots, perimeter 
integral, texture, and Fish integral.

filename A unique name used to identify a location where information is stored.

fluorescence A form of light emitted by atoms or molecules when electrons fall from excited 
energy levels to their lower less-energetic ground state.

fluorochrome A dye that absorbs light at a particular wavelength and then emits light at a higher 
wavelength.

folder A container for a group of files (usually related in some way). It is used to 
organize the files on your disk. 

font A collection of alphanumeric characters and symbols that are in a consistent and 
unique typeface.

forward scatter Light that has been deviated at relatively small angles to the incident beam as it 
passes through a particle.

four-room suite A slide tray that contains four slides. Each slide, or room, generally contains 2 
scan areas (“beds”). Within iCys and iBrowser, output from a slide is generally 
referred to by its Room/Bed location; the first scan area on the third slide has the 
WellID R3B1 (Room 3, Bed 1).

FWHM (Full Width Half Maximum) A width of a curve (generally assumed to be 
Gaussian) at half its maximum value. A method for calculating the CV of a 
histogram in which the histogram FWHM is divided by 2.345 times the standard 
deviation.

G
gain An electronic circuit which increases the current or voltage of the input signal to 

enable subsequent processing.

gallery A collection of cell images captured by iCys software.

galvanometer An electromechanical device which, in the iCys system, converts an electronic 
current to a rotational displacement. With a mirror attached, it enables a fixed 
laser beam incident on the mirror to be converted to a scanning laser beam.

gate A region defined on a histogram or scattergram which acts as a software filter for 
acquired events. Events within the window may be subsequently processed by 
looking at additional parameters.

grayscale An image type that contains more than just black and white, and includes actual 
shades of gray. In a grayscale image, each pixel has more bits of information 



Glossary Glossary of Terms

D-6  iCys Research Imaging Cytometer User Guide Revision B

encoded in it, allowing more shades to be recorded and shown. 8 bits can 
reproduce a photo-realistic 256 shades of gray.

group box A standard control used to group a set of options in a dialog box.

H
hard disk A permanent storage device either mounted inside a computer or as an external 

device in its own case. 

HeNe laser (Helium-neon) A light source emitting red light at 633 nm with a power output of 
approximately 5 mW. (This definition is specific for the iCys.)

histogram A two-dimensional graphical means of presenting data for measured features. The 
horizontal axis of the represents signal intensity of the feature while the vertical 
axis represents the number of events (counts).

I
icon A symbol on the screen that simplifies access to a program, command, or data file.

iCys Cytometric
Analysis 
Software

The software application that configures the iCys system, governs the scanning 
operations, and collects the scan data.

iCys Research  
Imaging
Cytometer

The laser scanning cytometer that includes the scanning mirrors, lenses, 
photomultipliers and all other components required to perform the laser scanning 
operations.

immunofluor-
escence

The use of fluorocarbon-labeled antibodies to detect or quantitate cell surface 
markers.

insertion point The position, indicated by a blinking vertical bar, at which text is entered into a 
report.

integration 
contour

An event contour that is a fixed number of pixels outside the threshold contour. 
The event’s total or integrated fluorescence is computed by adding all the pixel 
values within the contour.

isometric plot A plot mode in which two user-selected features are displayed with the frequency 
of occurrence being represented as a 3D surface.

L
laser (Light Amplification by Simulated Emission of Radiation) A device that converts 

various frequencies of light into one small and extremely intense beam of one 
wavelength radiation.

laser scan image A bit map image of the raw data that is detected by the iCys for a scanned area of 
the slide.

lens A transparent refracting device in a microscope, usually made of glass, that 
changes the shape of a beam of light.
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linear amplifier An electronic device which produces an output current or voltage directly 
proportional to the input current or voltage.

log scale A scale used to increase the dynamic range of the displayed data. 

M
Max Pixel One of the measured features of an event. It is the measurement of the pixel within 

the event contour having the largest value (highest intensity of fluorescence or 
scatter).

mean A value calculated by finding the sum of the channel numbers from all the cells in 
the sample and dividing it by the total number of cells in the sample.

median A value obtained by lining up the cells in order of increasing intensity and taking 
the channel number of the cell that is at the midpoint in that sequence.

mode See peak

multiplexing The process in computers and instrumentation of switching several different 
analog signals in succession to the input of a single analog-to-

digital converter and then storing the output data in sequence.

N
network A group of interconnected computers which are linked together for the purpose of 

sharing files, programs, or peripherals.

normalize A software process of automatically setting the scale and offset so that:

❑ An axis displaying Max Pixel makes a cell with the maximum possible Max 
Pixel appear in the last channel

❑ An axis displaying Scan makes a cell with the maximum possible scan 
number (767) appear in the last channel

0
objective A microscope lens which magnifies the specimen on the stage by a specified 

power (such as 10X, 20X, or 40X).

offset A shift in the position of the data in a histogram or scattergram relative to its 
original position. An offset results in a shift of the data along the selected axis.

operating 
system

(OS) The software that controls the execution of computer programs of a specific 
computer system.

optical filter An optical component which either transmits or attenuates incident light of 
specific wavelength.

optical 
sectioning

A series of scans of the same well or scan area at different focal points. The result 
is a series of scans that move through the sample from top to bottom by a specified 
distance. Optical sectioning is a form of repetitive scanning.



Glossary Glossary of Terms

D-8  iCys Research Imaging Cytometer User Guide Revision B

option button The round buttons in a dialog box that indicate a mutually exclusive choice (for 
example, a choice between Portrait or Landscape).

P
palette A grayscale palette containing color definitions for a laser scan image. The palette 

can be used to adjust the tonal range of the laser scan image.

parameter A channel that has been chosen for analysis in a protocol.

peak A value that is used to describe the most frequent fluorescence intensity of a 
population of cells. 

“Peak mode” is the channel number that is used to describe the largest number of 
cells in a sample.

peripheral 
contour

This contour, along with the integral contour, define a toroidal region of pixels 
used to calculate the peripheral value or the cytoplasmic fluorescence.

photobleaching The result of light altering fluorescent molecules so that they have decreased 
fluorescence or are no longer fluorescent.

photodetector A device that senses light and converts the energy from that light into an electrical 
signal.

photodiode A photodetector used for absorption, extinction, and forward scatter signals.

photomultiplier 
tube
(PMT)

A photodetector used to detect and measure and fluorescence signals.

pixel The smallest logical unit that can be used to build an image on the screen.

PMT See photomultiplier tube

protocol A description of settings saved from a successful run.

probe Any detectable marker that binds to a specific cellular component or molecular 
sequence.

properties Properties refer to the characteristics of a window in the iCys software 
application. The properties dialog box is used to change the information displayed 
in a window and how it is displayed. 

Q
quadrant A scattergram that has been divided into four rectangular areas to identify 

subpopulations for analysis.

R
RAM (Random Access Memory) Computer memory into which the user can both read 

and write information.
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region A user-defined bounded area on a scattergram or histogram. It is used to isolate a 
subpopulation of events.

relocation The process of the iCys software repositioning the microscope stage to the 
previously saved location of an event on a slide.

repetitive scan The process of scanning the same well or scan area multiple times. This allows 
you to see the change in a single sample over a period of time (which can be 
especially useful for live samples).

report A window which displays selected data windows with additional text and 
graphics. Acquired data can be displayed in the data windows and the report 
window can be printed. 

S
sampling rate The frequency at which the laser beam scan occurs.

saturation When the detector or display device no longer responds to increase levels of 
signal.

saving The process of placing information in the permanent memory of the computer.

scan area The entire area to be scanned. For a well, this is usually the entire well. For 
samples that reside in other kinds of carriers, the scan area can be defined by the 
user to encompass all or part of the sample.

scan field A single pass of the iCys laser. A scan area is made up of multiple scan fields.

Scan View 
window

The window in iCys in which scans are displayed. The source of the window’s 
data appears in the title bar. When data is coming directly from the iCys 
cytometer, the window title is Scan View.

scanning The process of recording an image on a visual display screen.

scattergram A two-dimensional display of data from a scan run or from a cell data file 
displayed as a plot of two user-selected measured features.

scroll A computer term for moving the contents inside a window up, down, right, or left 
so that more of the contents of the window can be viewed.

scroll bar A bar that appears at the side and/or bottom of a window that controls scrolling 
movement with a mouse action. A rectangular box inside the scroll bar shows the 
current position relative to the entire contents.

segmenting The process of setting boundaries to define events for storage in the computer 
memory.

sensor A device that detects and measures light and converts the energy from that light 
into an electrical signal.

status bar The horizontal bar at the very bottom of the iCys desktop. It contains an assist 
line, the names of the active files, the cell count, and the power of the objective 
being used.

statistics The calculations that the iCys software makes for cells within regions of the active 
window of a histogram or scattergram. The data (region number, count, 
percentage of cells in the region, the mean, full width at half maximum, CV, 
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interquartile range, standard deviation) can be printed out in the Region Statistics 
window.

stepper 
controller

A device that controls moving the microscope stage.

stochiometric Measurements that are proportional to the amount of substance present.

Stokes shift The wavelength difference between the light absorbed by a fluorochrome and the 
light emitted during fluorescence.

T
tab A tab is a way of moving within a dialog box. (Use the TAB key.) 

A group of tabs along the top of a dialog box provide you with subcategories of 
options.

taskbar In Windows XP, a taskbar is a horizontal bar located at the bottom of your screen. 
A button on the taskbar indicates a program that is open. 

In iCys, the Taskbar displays standard tasks, usually on the right-hand side of the 
iCys window. 

text box An area in a dialog box where the user can enter text.

texture The measure of the variability of fluorescent intensity of a cell. Cells that have 
increasing pixel values from the cell’s edge to the peak have a relatively low 
texture value. Cells that have undulating pixel values have relatively high texture 
measurements.

threshold An instrument setting that is used to determine a boundary based on the intensity 
of the photodetector signals. The threshold assists the user in making the optimum 
instrument settings. Once these settings are made, the measurements on those 
events can be saved for later analysis. 

.TIF file (Tagged-Image File Format) A bitmap graphics file of an image. 

tissue 
microarray

A slide that contains many small pieces, or cores, of sample tissue. Using the 
iNovator Application Development Toolkit, you can use iCys to label and scan 
tissue array samples. 

title bar The horizontal bar at the top of a iCys window that displays a label for the 
contents of the window.

toolbar An area on the desktop used to place icons. The icons placed in the toolbar can be 
customized by the user. 

torus An area bounded by two user-defined contours. It is used to determine the amount 
of fluorescence around the perimeter of a cell and also for calculating the amount 
of background fluorescence.

2-parameter 
histogram

A color plot of the values of two user-selected parameters with color representing 
either the density or an expression. 2-parameter histograms are set from the 
Scattergram menu in iCys. 
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 V
voltage The force that causes the movement of electrons through an electrical circuit. In a 

computer circuit, everything is reduced to bits (binary digit of 0 or 1). High 
voltage is represented by the number 1 and low voltage is represented by the 
number 0.

W
wavelength Describes the color of light. The color of the light is related to amount of energy in 

the photons of that light. Blue light has wavelengths of approximately 400-540 
nm and its photons have relatively large amounts of energy while red light has 
wavelengths of approximately 600-700 nm and photons with less energy than 
those in blue light.

Workspace The combined instrument and display settings for a given experiment.The 
Workspace can be saved as a file with the extension .ws.xml.
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